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Introduction

1 Introduction

The Texas Instruments® F28P65x Firmware development library is a group of example applications
and helper libraries that demonstrate the basics of getting started with a F28P65x device.

The following chapter (chapter 2) provides a step by step guide for from scratch project
creation for each core as well as debug. It is highly recommended that users new to the
F28P65x family of devices start by reading this section first.

Because the F28P65x devices have two cores the example applications have been broken up to
distinguish which examples run on each core.

m The driver library example applications which run exclusively on the C28x CPU core can
be found in the ~/driverlib/£f28p65x/examples/c28x directory.- The driver library
example applications which require both C28x CPU Cores to run can be found in the
~/driverlib/f28p65x/examples/c28x_dual directory. directory.

The examples provided are built for control CARD compatibility.

As users move past evaluation, and get started developing their own application, Tl recommends
they maintain a similar project directory structure to that used in the example projects. Example
projects have a heirarchy as follows:

m Main project directory
« C28x project folder (c28x)
= C28x project sources (x.c, *.h)
= CCS folder (ccs)
- CCS project specific files
» C28x Dual project folder (c28x_dual)
= CPU 2 project sources (x.c, *.h)
« CCS folder (ccs)
- CCS project specific files

1.1 Detailed Revision History

v5.00.00.00

m This version is the first release (packaged with development tools) of the F28P65x header
files, bitfield commons, drivers and examples.
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Getting Started and Troubleshooting

2.1

2.2

Getting Started and Troubleshooting

Project Creation 13 Project: Adding Bit-field or DriverLib Support 35 Debugging Dual Core Applications 32
TroUBIESNOOTING . ..ot e 36

Introduction

Because of the sheer complexity of the F28P65x devices, it is not uncommon for new users to
have trouble bringing up the device their first time. This guide aims to give you, the user, a step by
step guide for how to create and debug projects from scratch. This guide will focus on the user of a
F28P65x control CARD, but these same ideas should apply to other boards with minimal translation.

Project Creation

A typical F28P65x application consists of two separate CCS projects: one for CPU 1 and one for
CPU2. The two projects are completely independent and have no real linking between them as far
as CCS is concerned.
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CPU 1 Subsystem Project Creation

1. From the main CCS window select File -> New -> CCS Project. Select your Target as
"TMS320F28P650DK9" and use the "C28XX [C2000]" Tab. Name your project and choose
a location for it to reside. Click Finish and your project will be created.

&8 New CCS Project

New CCS Project

Create a new CCS Project.

Target: <select or type filter text> ~ | TMS320F28P650DK9

Connection:

4 C28XX [C2000]

Project name: £28p65x_test cpuf|
Use default location

C:\Users\a013208 1\workspace core GITHub\f28p65x test cf Browse.

Compiler version: Tl v22.6.0.LTS = More...

» Project type and tool-chain

~ Project templates and examples

type filter text

Creates an empty project initialized for the
© [ Empty Projects | selected device. The project will contain an

B Eonply Project empty ‘main.c’ source-file.
= Empty Project (with main.c)
= Empty Assembly-only Project
= Empty RTSC Project

= Basic Examples v

Open Resource Explorer to browse a wide selection of example projects...

Open Import Wizard to find local example projects for selected device...

[~
Iz
5

v

Figure 2.1: Creating a new C28 project

14
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2. Before we can successfully build a project we need to setup some build specific settings. Right
click on your project and select Properties. Look at the Processor Options and ensure they
match the below image:

& Properties for led_ex1_c28x dual_blinky_cpul O X
type filter text Processor Options RS
Resource
General S
v Build Configuration: |[CPUT_RAM [ Active ] ~ | Manage Configurations...

v (2000 Compiler
Processor Option
Optimization Processor version (--silicon_version, -v) 28 ~

Include Options Option deprecated, set by default (--large_memory model, -ml)

Performance Advi Unified memory (--unified_memory, -mt)

Predefined Symb¢ | Specify CLA support (--cla_support) a2 ~
Advanced Option; | e ol Sipho L (X oal 1 fpubd
PN pecify floating point support (-float_support) pu
2000 Hex Utility [D | Specify support for enhanced integer divison (--idiv_support) ~
Debug Specify VCU register save/restore for interrupts (--isr_save_vcu_regs) v
Klocwork i ]
Klstwoik CodeRadion Specify TMU support (-—-tmu_support) tmul |
Specify VCU support (--vcu_support) vere &~

< >
o)

Show advanced settings Apply and Close Cancel

Figure 2.2: Project configuration dialog box
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3. In the C2000 Compiler entry look for and select the Include Options. Click on the
add directory icon to add a directory to the search path. Click the File System but-
ton to browse to the common\include folder of your C2000Ware installation (typically
C:\ti\c2000\C2000Ware_X_ XX_XX_xx\device_support\f28p65x\common\include).
Replace the 'X’s with your current C2000Ware version installation. Click ok to add this path,
and repeat this same process to add the headers\include directory and the driverlib

directory

&9 Properties for led_ex1_c28x_dual_blinky_cpu1 O

type filter text Include Options

Resource
General
~ Build
¥ C2000 Compiler
Processor Option
Optimization
Include Options
Performance Advi
Predefined Symbc
Advanced Option
2000 Linker
C2000 Hex Utility [D
Debug
Klocwork
Klocwork Code Review

L

Configuration: (CPUT_RAM [Active] ~ | Manage Configu

Add dir to #include search path (—include path, -I) €4
${PROJECT_ROQT} &=
${C2000WARE_ROOT) &
${PROJECT_ROOT}/device =
${C2000WARE_DLIB_ROOT}
${CG_TOOL_ROQT/include =

Specify a preinclude file (--preinclude)

Figure 2.3: Project configuration dialog box

16

Tue Oct 29 00:46:52 IST 2024



Getting Started and Troubleshooting

4. Expand the Advanced Options and look for the Predefined Symbol entry. Add a Pre-define
NAME called "CPU1". This ensures that the header files build correct for this CPU.

@ Properties for led_ex1_c28x dual_blinky cpu1

| type filter text ‘ Predefined Symbols
Resource
General -
< Build Configuration: |[CPUT RAM [ Active ]

v (2000 Compiler

Processor Option
Pre-define NAME (--define, -D)

${COM T| C2000WARE SOFTWARE PACKAGE SYMBOLS} =

| [RAM
Performance Advi DEBUG

Optimization
Include Options

Predefined Symbe«  ¢pyjq
Advanced Option
C2000 Linker
C2000 Hex Utility [D
» Debug

» Klocwork

Klocwork Code Review Undefine NAME (--undefine, -U)

Figure 2.4: Project configuration dialog box
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5. Click on the Linker File Search Path. Add these directories to the search path: common\cmd
and headers\cmd. Then you'll also want to add the lib and linker command files

rrocessor upton
Include library file or command file as input (--library, -I)

${COM_TI_C2000WARE_SOFTWARE_PACKAGE_LIBRARIES} =
libc.a

Optimization
Include Options
Performance Advi
Predefined Symb:
> Advanced Option
v C2000 Linker
Basic Options

Add <dir> to library search path (--search_path, -i)
File Search Path

${COM_TI_C2000WARE_SOFTWARE_PACKAGE_LIBRARY_PATH} =
» Advanced Option | ${CG TOOL ROOTY/lib =
C2000 Hex Utility [D | ${CG_ TOOL ROOTY/include =
Debug

Klocwork
Klocwork Code Review

Figure 2.5: Project configuration dialog box
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6. While you have this window open select the Symbol Management options under C2000 Linker
Advanced Options. Specify the program entry point to be code_start. Select ok to close
out of the Build Properties.

& Properties for led_ex1_c28x_dual_blinky_cpu1 O X
type filter text Symbol M. Gvo v g
Resource A
General X . = 5 5
< il Configuration: |CPUT_RAM [ Active] v |Manage Configurations...

v C2000 Compiler
Processor Opt

Specify program entry point for the output module (—entry_point, -¢) | code_start

Optimization
Include Optior Do not localize symbols matching pattern (--globalize) £
Performance A — = e

& <
Predefined Syr Hide symbols matching pattern (—-hide) &
Advanced Opt Make the symbols matching pattern local (--localize) a

v (2000 Linker
Basic Options Don't make global symbol static if -h is specified (--make_global, -g) L=]
File Search Pat

v Advanced Opt [IMake all global symbols static (--make_static, -h)

[[INo type merging in symbolic debugging information (--no_sym_merge, -b)

Command
Diagnostics [Istrip symbol table and line number entries (--no_symtable, -s)
Linker Outy Specify symbols/sections to be retained by linker (--retain) £
Sl e e e e e R e e (e e =)
Runtime En = Bal 5 : T =
A £
Miscellanec Specify a symbol map, mapping refname to defname (—-symbol_map) 5
Post-link of Add <sym> to symbol table as an unresolved symbol (--undef_sym, -u) a
C2000 Hex Utility
> Gl % Exclude symbols matching pattern from hiding (—unhide) 5]

Show advanced settings Apply and Close Cancel

Figure 2.6: Symbol Management options
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7. In the project explorer, check that no linker command file got added during project setup. If so,
remove the linker command file that got added.

8. Next we need to link in a few files which are used by the header files. To do this right click on
your project in the workspace and select Add Files...

At this point your project workspace should look like the following:

4 Prpiact Evnlarar 30

6 0 &

O W 6 6 6

R

G: 0 0

iz 9 0

New b
Show In Alt+Shift+W >
Show in Local Terminal >
Add Files...

B Copy Ctrl+C
Paste Ctrl+V
Delete Delete
Refactor >
Source >
Maove...

Rename... F2
Import b
i Export...

Show Build Settings...
Build Project

Clean Project

Rebuild Project
Refresh

Close Project

Build Targets >
Index >
Build Configurations >
Klocworlk >
Debug As >
Restore from Local History...

Team >
Compare With bl

Figure 2.7: Linking files to project
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9. Create a new file by right clicking on the project and selecting New -> File. Name this file
main.c and copy the following code into it:

//

// Included Files

//

#include "driverlib.h"
#include "device.h"

//

// Main

//

void main (void)

{
//
// Initialize device clock and peripherals
//

Device_init ();

//

// Initialize GPIO and configure the GPIO pin as a push-pull output
//

Device_initGPIO();

GPIO_setPadConfig (DEVICE_GPIO_PIN_LED1, GPIO_PIN_TYPE_STD);
GPIO_setDirectionMode (DEVICE_GPIO_PIN_LED1, GPIO_DIR_MODE_OUT) ;

//

// Initialize PIE and clear PIE registers. Disables CPU interrupts.
//

Interrupt_initModule () ;

//

// Initialize the PIE vector table with pointers to the shell Interrupt
// Service Routines (ISR).

//

Interrupt_initVectorTable () ;

//
// Enable Global Interrupt (INTM) and realtime interrupt (DBGM)
//
EINT;
ERTM;
//
// Loop Forever
//
for(;;)
{
//
// Turn on LED
//

GPIO_writePin (DEVICE_GPIO_PIN_LED1, O0);
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//
// Delay for a bit.
//
DEVICE_DELAY_US (500000) ;
//
// Turn off LED
//
GPIO_writePin (DEVICE_GPIO_PIN_LED1, 1);
//
// Delay for a bit.
//
DEVICE_DELAY_US (500000) ;
}
}
//
// End of File
//

10. Save main.c, update it with the content needed and then attempt to build the project by right
click on it and selecting Build Project. Assuming the project builds try debugging this project
on a f28p65x device. When the code runs you should see LED1 toggle.

File Edit View Navigate Project Run Scripts Window Help

(=B KRB vih viRidv v v
[ Drmiast Funlarar X ESY £ 0 Riad avl »8v dual ki
New > 9 Project... |
r
Show In Alt+Shift+w > & CCS Project n
Show in Local Terminal > File
7 File from Template
Add Files... & Folder
B Copy Ctrl+C @ Class 4
Paste Ctrl+v

v Header File

% Delete Delete = 5
¢ Source File
Refactor >
St 5 % Target Conf ¢ o ato a new source file
[ C/C++ Project
Move...
i Other... Ctrl+N
Rename... 2 T il
Import >
% Export..
[RAM]

Show Build Settings...
Build Project
Clean Project

=] le %
Rebuild Project onsole

TMS320F28P65x. I
Refresh oo
Close Project RAM initializatior
Build Targets > C28xx_CPU2: GEL O
Index > Memory Map Initial
Build Confi i 3 C28xx_CPU2: If er:
e e— C28xx_CPU2: Only ¢
Klocwork > C28xx_CPULl: GEL Ot
C28xx_CPU1: GEL Ot
# Debug As > €28xx_CPUL: GEL Ot
Restore from Local History... CPU2 is out of r¢
Tt N (If you connecte(
Compare With > (
© Properties Alt+Enter ’

Figure 2.8: Create a new file
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CPU 2 Subsystem Project Creation

1. From the main CCS window select File -> New -> CCS Project. Select your Target as
"TMS320F28P650DK9" and use the "C28XX [C2000]" Tab. Name your project and choose
a location for it to reside. Click Finish and your project will be created.

&8 New CCS Project

New CCS Project

Create a new CCS Project.

Target: <select or type filter text> ~ | TMS320F28P650DK9

Connection:

4 C28XX [C2000]

Project name: £28p65x_test cpuf|
Use default location

C:\Users\a013208 1\workspace core GITHub\f28p65x test cf Browse.

Compiler version: Tl v22.6.0.LTS = More...

» Project type and tool-chain

~ Project templates and examples

type filter text

Creates an empty project initialized for the
© [ Empty Projects | selected device. The project will contain an

B Eonply Project empty ‘main.c’ source-file.
= Empty Project (with main.c)
= Empty Assembly-only Project
= Empty RTSC Project

= Basic Examples v

Open Resource Explorer to browse a wide selection of example projects...

Open Import Wizard to find local example projects for selected device...

[~
Iz
5

v

Figure 2.9: Creating a new C28 project

Tue Oct 29 00:46:52 IST 2024 23



Getting Started and Troubleshooting

2. Before we can successfully build a project we need to setup some build specific settings. Right
click on your project and select Properties. Look at the Processor Options and ensure they
match the below image:

type filter text Processor Options ST B

Resource
General ) . " 5 .
+ Build Configuration: |CPU2_RAM [ Active ] ~ | |Manage Configurations...
v C2000 Compiler
Processor Option
Processor version (--silicon_version, -v) 28 N7

Optimization
Include Options Option deprecated, set by default (—large_memory_model, -ml)
Performance Advi Unified memory (--unified_memory, -mt)

Predefined Symb¢ | gpecify CLA support (--cla_support) da2 v
Advanced Option

2000 Linker Specify floating point support (--float_suppert) fpubd v
2000 Hex Utility [D | Specify support for enhanced integer divison (--idiv_support) v
Debug Specify VCU register save/restore for interrupts (—isr_save_vcu_regs) v

Klocwork .
Kloanork Code Review | SPEcify TMU support (~tmu_support tmut =
Specify VCU support (--veu_support) vere v

< >

@

) Show advanced settings Apply and Close Cancel

Figure 2.10: Project configuration dialog box
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3. In the C2000 Compiler entry look for and select the Include Options. Click on the
add directory icon to add a directory to the search path. Click the File System but-
ton to browse to the common\include folder of your C2000Ware installation (typically
C:\ti\c2000\C2000Ware_X_ XX_XX_xx\device_support\f28p65x\common\include).
Replace the 'X’s with your current C2000Ware version installation. Click ok to add this path,
and repeat this same process to add the headers\include directory and the driverlib
directory

General
v Build
v 2000 Compiler
Processor Option

Configuration: |CPU2 RAM [ Active ]

Add dir to #include search path (--include_path, -I)
${PROJECT ROOT} =
Performance Advi ${C2000WARE_ROOT] =
Predefined Symb¢ | $1PROJECT ROOT}/device =
Advanced Option | ${C2000WARE_DLIB_ROOT} =
C2000 Linker ${CG_TOOL ROOT}include &=
C2000 Hex Utility [D
> Debug

Optimization
Include Options

Klocwork

7 VSRR 5 o S L - o e e e e e e

Figure 2.11: Project configuration dialog box
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4. Expand the Advanced Options and look for the Predefined Symbol entry. Add a Pre-define
NAME called "CPU2". This ensures that the header files build correct for this CPU.

o Confi i CPU2_RAM [ Acti
« Build onfiguration: = [ Active ]

v 2000 Compiler

Processor Option
Pre-define NAME (--define, -D)

Optimization

i ${COM_TI C2000WARE SOFTWARE PACKAGE SYMBOLS} =
Include Options RAM
Performance Advi  epuG

Predefined Symb¢ | cpy2
Advanced Option
» (2000 Linker
C2000 Hex Utility [D
» Debug
Klocwork

Klocwork Code Review Undefine NAME (--undefine, -U)

Figure 2.12: Project configuration dialog box

Tue Oct 29 00:46:52 IST 2024



Getting Started and Troubleshooting

5. Click on the Linker File Search Path. Add these directories to the search path: common\cmd
and headers\cmd. Then you'll also want to add the lib and linker command files

Processor Option

Giptivization Include library file or command file as input (--library, -I)

${COM _TI_C2000WARE_SOFTWARE_PACKAGE_LIBRARIES} =
libca

Include Options
Performance Advi
Predefined Symbc
» Advanced Option
v C2000 Linker

=t Add <dir> to library search path (--search_path, -i)

HlEhech it
> Advanced Option ${CG_TOOL_ROOT}/lib E=
C2000 Hex Utility [D | | ${CG_TOOL_ROOTY/include &=
Debug
» Klocwork

Klamwnrlk Cade Review

Figure 2.13: Project configuration dialog box
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6. While you have this window open select the Symbol Management options under C2000 Linker
Advanced Options. Specify the program entry point to be code_start. Select ok to close

out of the Build Properties.

&9 Properties for led_ex1_c28x_dual_blinky_cpu2 O X

type filter text Symbol M;

Resource ~
General
Vv Build
v €2000 Compiler
Processor Opt
Optimization
Include Optior
Performance A
Predefined Syr
Advanced Opt
~ €2000 Linker
Basic Options
File Search Pat
v Advanced Opt
Command
Diagnostice
Linker Outgp
Symbol Ma
Runtime En
Miscellanec
Post-link of
€2000 Hex Utility -

[x o

<

@ Sshow advanced settings

Configuration: CPU2_RAM [ Active] ~ | Manage Configurations...

Specify program entry point for the output module (--entry_point, -} | code_start
Do not localize symbols matching pattern (--globalize) a
Hide symbols matching pattern (--hide) 3l
Make the symbols matching pattern local (--localize) €
Don't make global symbol static if -h is specified (--make _global, -g) Ll

[IMake all global symbols static (--make_static, -h)
[[INo type merging in symbolic debugging information (--no_sym_merge, -b)
1 Strip symbol table and line number entries (--no_symtable, -s)

Specify symbols/sections to be retained by linker (--retain) €

[] Scan libraries for duplicate symbol definitions (--scan_libraries, -scanlibs)

Specify a symbol map, mapping refname to defname (--symbol map) &
Add <sym> to symbol table as an unresolved symbol (--undef_sym, -u) a
Exclude symbols matching pattern from hiding (--unhide) &

Apply and Close

Cancel

Figure 2.14: Symbol Management options
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7. In the project explorer, check that no linker command file got added during project setup. If so,
remove the linker command file that got added.

8. Next we need to link in a few files which are used by the header files. To do this right click on
your project in the workspace and select Add Files...

At this point your project workspace should look like the following:

4 Prpiact Evnlarar 30

6 0 ©

0 0

0 W 6

G: 0z 0 G0 0

iz T 0

New b
Show In Alt+Shift+W >
Show in Local Terminal >
Add Files...

& Copy Ctrl+C
Paste Ctrl+V
Delete Delete
Refactor >
Source b
Maove...

Rename... F2
Import >
i Export...

Show Build Settings...
Build Project

Clean Project

Rebuild Project
Refresh

Close Project

Build Targets >
Index >
Build Configurations >
Klocworlk >
# Debug As >
Restore from Local History...
Team >
Compare With >

Figure 2.15: Linking files to project

=
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9. Create a new file by right clicking on the project and selecting New -> File. Name this file

main.c and copy the following code into it:

//

// Included Files

//

#include "driverlib.h"
#include "device.h"

//
// Main
//
void main (void)
{
//
// Initialize device clock and peripherals
//
Device_init ();
//
// Initialize GPIO and configure the GPIO pin as a push-pull output
//
// This is configured by CPUl
//
// Initialize PIE and clear PIE registers. Disables CPU interrupts.
//

Interrupt_initModule () ;

//

// Initialize the PIE vector table with pointers to the shell Interrupt
// Service Routines (ISR).

//

Interrupt_initVectorTable();

//
// Enable Global Interrupt (INTM) and realtime interrupt (DBGM)
//
EINT;
ERTM;
//
// Loop Forever
//
for(;i)
{
//
// Turn on LED
//

GPIO_writePin (DEVICE_GPIO_PIN_LED2, O0);

//
// Delay for a bit.

30
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10.

DEVICE_DELAY_US (500000) ;

// Turn off LED

GPIO_writePin (DEVICE_GPIO_PIN_LEDZ2,

// Delay for a bit.

DEVICE_DELAY_US (500000) ;

//
//
//
//
//
}
}
//

// End of File

//

1);

Save main.c,update it with the content needed and then attempt to build the project by right
click on it and selecting Build Project. Assuming the project builds try debugging both these
projects simultaneously on a f28p65x device, otherwise carefully examine the error and the
above steps to determine what could have gone wrong. When the code runs you should see

LED2 toggle.

= -

RiDi#viR~i2if~

5 Proiact Beslarar >

BEBEGGED GG

[l

B
w

=

B

Flod

New

Show In

Shoay in Loca| Terminal

Add Files...

El Copy

¥

Paste
Delete
Refactar
Source
Move

Rename..

Impert

1 [xport.

Show 3uild Settings...
Build Project

Clean Projoct
Rebhuild Project
Refresh
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Build Targets

Index

Build Conligurativns
Kloowaork

Debug As

Restare from Local listory...
leam

Compare With

Pronerties

Figure 2.16:
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]
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TMS5320r 23755x.coml

RAM initialization do

> C2Bxx_CPU2:

GEL Qutpu

y Memory Map Initizliza

C28yx_CPU2:
C2Bxx_CPU2:
> C28xx_CPU1:

C2Bxx_CPUL:
B C28xx_CPUL:

If erase/
Only CPUL
GEL Outpu
GEL Qutpu
GEL Outpu

CPU2 is out of reset
3 (If you connected pr

<

Alt+Fnter [

Create a new file
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2.3

Debugging Dual Core Applications

. Ensure CCS version 12.4 or newer is installed and up to date. You should have C2000 Code
Generation Tools version 22.6.0.LTS and T| ARM Compiler 20.2.7.LTS.

. Connect a USB C cable from the computer to the USB port on the left hand side of the control-
CARD. Windows will enumerate and try to install drivers. As long as CCS is installed, Windows
should automatically find and install drivers for the emulator.

. Apply power either via USB or the 5V DC in jack on the docking station. While the emulator
on the board is powered from the host computer’s USB port, the rest of the board is not.
The reason for this is that the JTAG connection on the F28P65x controlCARDs is completely
electrically isolated. Because of the typical applications these devices will be used in, it is
neccessary to isolate the JTAG connection. However, for bench debug and evaluation (with
low voltages), both halves of the board can be powered from the same supply (i.e. USB). Each
power domain has an associated power LED which can be used to ensure that each domain
has power.

. Launch CCS and pick the workspace you would like to debug in.

. Create a new target configuration. Click File -> New -> Target Configuration File and name
the file appropriately (i.e. F28P65x_xds110.ccxml). Select the emulator you intend to use
(XDS110 USB Debug Probe) from the drop down list, and then select the device variant
present on your board (f28p65x controlCARDs have a f28p65x). Save the target configuration
and close the window.

Basic

General Setup

This section describes the general configuration about the target.

Connection Texas Instruments XDS110 USB Debug Probe e

Board or Device | type filter text

[ ] TMS320F28379D A
[ ] TMS320F283795

[ ] TMS320F2837HD

[ ] TMS320F28384D

[ ] TMS320F28384S

[ ] TMS320F28386D

[ ] TMS320F283865

[ ] TMS320F28388D

[ ] TMS320F283885

TMS320F28P650DK9

[ ] TMS320F28P650SH6 ha

Figure 2.17: F28P65x Card Target Configuration Setup

6. Import the desired example projects (or skip this step if you are using projects you created

in the Project Creation section). Click File -> Import, and in the CCS folder select Existing

32

Tue Oct 29 00:46:52 IST 2024



Getting Started and Troubleshooting

CCS/CCE Eclipse Projects before clicking Next. With the "Select search-directory" radio but-
ton checked, browse to the root of your C2000Ware installation. Device specific software as
well as examples are stored in the driverlib/device_variant folders. Navigate to the
F28P65x directory, and then to the examples/c28x directory. Click OK and CCS will parse
all of the projects in this directory. Import any projects you wish to run into the workspace.

&8 Import CCS Projects O X

Import CCS Projects [

Import existing CCS Projects or example CCS Projects.

@ Select search-directory: | C:\ti\c2000\C2000Ware_5 00_00_00\driverlib\f28p65x\examples\c28x\aes H Browse... |

(O Select archive file: Bre

Discovered projects:

[ ]2 aes_ex1_ecb_encrypt | Select All
[]% aes_ex2_ech_decrypt
[]= aes_ex3_gem_encrypt

[] & aes_ex4_gcm_decrypt [CCS/aes e

Deselect All

Refresh

[] Automatically import referenced projects found in same search-directory

] Copy projects into workspace

Open Resource Explorer to browse a wide selection of example projects...

o~
@) Finish Cancel

Figure 2.18: Importing f28p65x Projects

7. Build each of the example projects. Right click on each project title and select build project.

=
AltShiftsw >

Ctil+C
Ctrl+v
Delete

Figure 2.19: Building f28p65x Projects

8. Launch the previously created target configuration. Click View -> Target Configurations. In
the window that opens, find the target configuration you created previously, right click on it and
select "Launch Target Configuration".
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¥ Target Configurations X

type filter text

@ Projects
v & User Defined
% F2800137.comml
% F280013x.coml
% F280015x.coml
% F2838x.coml
% LaunchXL_f28069.coml
% TMS320F2800157.comml
< TMS320F28P65x.coxml
% New Target Configuration
Import Target Configuration

X Delete Delete

Rename F2
& Refresh Launch Selected Configuration

“ Launch Selected Configuration
Set as Default
Link File To Project >

Properties Alt+Enter

Figure 2.20: Launching a CCS Target Configuration

9. Connect to the device. Right click on each core in the debug window and select "Connect
Target. This will connect CCS to the device and will allow you to load code and debug appli-

cations.
4 Debug % = § = 8| w-varial
v ¥ TMS320F28P65x.caxml [Code Composer Studio - Device Debugging] Name

2 Texas Instruments XDS110 USB Debug Probe 0/C28xx_CPU1 (Disconnected : Suspended)
& Texas Instruments XDS110 USB Debug Probe_0/CPU1_CLA1 (Disconnected : Unknown)

& Texas Instruments XDS110 USB Debug Probe 0/C28xx CPU2 (Disconnected : Unknown)
% Connect Target Ctrl+Alt+C

|
Disconnect Target Ctrl+Al+D ‘
Enable Global Breakpoints ‘

|

Enable Halt On Reset

Fnahle OS Dehuanina

Figure 2.21: Connecting to a Target

4 Debug % =
v ¥4 TMS320F28P65x.coxml [Code Composer Studio - Device Debugging]
v i Texas Instruments XDS110 USB Debug Probe 0/C28xx_CPU1 (Suspended)
= 0x3FEAA2 (no symbols are defined)
2 Texas Instruments XDS110 USB Debug Probe_0/CPU1_CLA1 (Disconnected : Unknown)
v o Texas Instruments XDS5110 USB Debug Probe_0/C28xx_CPU2 (Suspended)
= 0x3FABCO (no symbols are defined)

Figure 2.22: After connection to both cores

10. Load code on each of the cores. Select one of the cores in the debug window and then click
Target -> Load Program. A dialog box is display which will allow you to select a program
to load. Be careful to ensure that you load the appropriate out file on the appropriate core.
Repeat this process for the other core by selecting it and following these same steps.

11. At this point both cores should have code loaded and be halted at main. From this point, users
should be able to debug code just as they are used to with CCS. Please keep in mind that any
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# Debug *

action you take in CCS only has an effect on the core you currently have selected in the debug
window. For instance if CPU 1 is selected, the memory window will display the memory map
of of the system as seen by CPU 1. The opposite would be true if CPU 2 were selected and

similarly for CM.

= E=1 == Vari;

v & TMS320F28P65x.coxml [Code Composer Studio - Device Debugging] MName

v o Texas Instruments XDS110 USB Debug Probe_0/C28xx_CPU1 (Suspended - SW Breakpoint)
= main() at led_ex1_c28x_dual_blinky_cpui.c71 0x00C594
= _args_main() at args_main.c:137 OxO0CAF7
= ¢ int00() at boot28.asm:264 0x00C975 (_c_int00 does not contain frame information)

Figure 2.23: Projects loaded on each core

START2000W AREoNLY

Project: Adding Bit-field or DriverLib Support

F28P65x devices support two types of development software, driver library APIs and bit-field structures. Each
have their advantages and are implemented to be compatible together within the same user application. This
section details how to add driverlib support to a bit-field project as well as how to add bit-field support to a

driverlib project.

When combining bit-field and driverlib support, add a pre-defined symbol within the project properties called
" DUAL_HEADERS". This is required to avoid having conflicting definitions (in enums/structs/macros) which
share the exact same names in both bit-field and driverlib headers.

Adding DriverLib Support

1.

2.

Add the following include directory path to the project:
driverlib\f28p65x\driverlib

Include the following header file in the project main source file:
device_support\£28p65x\common\include\driverlib.h

3. Add or link the driverlib. 1ib library to the project. Location of file:

driverlib\f28p65x\driverlib\ccs\Debug

Adding Bit-field Support

1.

2. Include the following header file in the project main source file:
device_support\f28p65x\headers\include\f28p65x_device.h
3. Add or link the f28p65x_globalvariabledefs.c file to the project. Location of file:
device_support\£f28p65x\headers\source
4. Add or link the £28p65x_Headers_nonBIOS. cmd file to the project. Location of file:
device_support\f28p65x\headers)\cmd
ENDc2000W AREoNLY

Add the following include directory path to the project:
device_support\f28p65x\headers\include
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Troubleshooting

There are a number of things that can cause the user trouble while bringing up a debug session the first time.
This section will try to provide solutions to the most common problems encountered with the Delfino devices.

"l get a managed make error when | import the example projects"

This occurs when one imports a project for which he or she doesn’t have the code generation tools for.
Please ensure that you have at least C2000 Code Generation Tools version 22.6.0.LTS and TI ARM Compiler
20.2.7.LTS or later.

"l cannot build the example projects”

This is caused by linked resources not being where the project expects them to be. For instance, if you imported
the projects and selected "Copy projects to workspace", the projects would no longer build because the files
they reference aren’t a part of your workspace. Always build and run the examples directly in the C2000Ware
directory tree.

"My F28P65x device isn’t in the target configuration selection list"

The list of available device for debug is determined based on a number of factors, including drivers and tools
chains available on the host system. If you system has previously been used only for development on previous
C2000 devices, you may not have the required CCS device files. In CCS click on "Help, Check for updates" and
follow the dialog boxes to update your CCS installation.

"l cannot connect to the target"

This is most often times caused by either a bad target configuration, or simply the emulator being physically
disconnected. If you are unable to connect to a target check the following things:

1. Ensure the target configuration is correct for the device you have.
2. Ensure the emulator is plugged in to both the computer and the device to be debugged.
3. Ensure that the target device is powered.

"l cannot load code"

This is typically caused by an error in the GEL script or improperly linked code. If you are having trouble loading
code, check the linker command files and maps to ensure that they match the device memory map. If these
appear correct, there is a chance there is something wrong in one of your GEL scripts.

"When a core gets an interrupt, it faults"

Ensure that the interrupt vector table is where the interrupt controller thinks it is. On both cores the interrupt
vector table may be mapped to either RAM or flash. Please ensure that your vector table is where the interrupt
controller thinks it is.

"When the CPU1 comes up, it is not fresh out of reset”

F28P65x devices support several boot modes, several of which allow program code to be loaded into and
executed out of RAM via one of the device many serial peripherals. If the boot mode pins are in the wrong
state at power up, one of these peripheral boot modes may be entered accidentally before the debugger is
connected. This leaves the chip in an unclean state with potentially several of the peripherals configured as well
as the interrupt vector table setup. If you are seeing strange behavior check to ensure that the "Boot to Flash"
or "Boot to RAM" boot mode is selected.

"\"Fapi_Error_InvalidHclkValue\" is returned afte execution of Fapi_setActiveFlashBank(Fapi_FlashBankO0)

function." Occurs when using the Flash APIs in the code.

Please ensure that the correct frequency is passed as an input to the Fapi_initializeAPI function and the wait
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states are correctly configured.
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Interrupt Service Routine Priorities

Interrupt Hardware Priority OVEIVIEW ... ... .ttt et ettt e et e e
f28PB5X PIE INterrupt Priorities . ... e e e e e

Software Prioritization of Interrupts - The Example

Interrupt Hardware Priority Overview

With the PIE block enabled, the interrupts are prioritized in hardware by default as follows:

Global Priority (CPU Interrupt level):

CPU Interrupt

Reset
INTH
INT2
INT3
INT4
INT5
INT6
INT7
INT12
INT13
INT14
DLOGINT
RTOSINT
reserved
NMI
ILLEGAL
USER1
USER2

Hardware Priority
1(Highest)

- 2 O oOo~NO O,

0
1

16

17

18
19(Lowest)
20

2

3

-(Software Interrupts)

CPU Interrupts INT1 - INT14, DLOGINT and RTOSINT are maskable interrupts. These interrupts can be
enabled or disabled by the CPU Interrupt enable register (IER).

Group Priority (PIE Level):

If the Peripheral Interrupt Expansion (PIE) block is enabled, then CPU interrupts INT1 to INT12 are connected
to the PIE. This peripheral expands each of these 12 CPU interrupt into 8 interrupts. Thus the total possible

number of available interrupts in the PIE is 96. Note, not all of the 96 are used on a 2803x device.

Each of the PIE groups has its own interrupt enable register (PIEIERx) to control which of the 8 interrupts
(INTx.1 - INTx.8) are enabled and permitted to issue an interrupt.
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CPU PIE
Interrupt | Group PIE Interrupts
Highest——Hardware Priority Within the Group——— - Lowest
INTH 1 INT1.1 INT1.2 | INT1.3 | INT1.4 | INT1.5 | INT1.6 | INT1.7 | INT1.8
INT2 2 INT2.1 INT2.2 | INT2.3 | INT2.4 | INT2.5 | INT2.6 | INT2.7 | INT2.8
INT3 3 INT3.1 INT3.2 | INT3.3 | INT3.4 | INT3.5 | INT3.6 | INT3.7 | INT3.8
... etc ...
... etc ...
INT12 | 12 [ INT12.1 [ INT12.2 [ INT12.3 | INT12.4 [ INT12.5 | INT12.6 [ INT12.7 | INT4.8

Table 3.1: PIE Group Hardware Priority

PIE Interrupt Priorities

The PIE block is organized such that the interrupts are in a logical order. Interrupts that typically require higher
priority, are organized higher up in the table and will thus be serviced with a higher priority by default.

The interrupts in a control subsystem can be categorized as follows (ordered highest to lowest priority):

. Non-Periodic, Fast Response

These are interrupts that can happen at any time and when they occur, they must be serviced
as quickly as possible. Typically these interrupts monitor an external event.

On the f28p65x devices, such interrupts are allocated to the first few interrupts within PIE
Group 1 and PIE Group 2. This position gives them the highest priority within the PIE group.
In addition, Group 1 is multiplexed into the CPU interrupt INT1. CPU INT1 has the highest
hardware priority. PIE Group 2 is multiplexed into the CPU INT2 which is the 2nd highest
hardware priority.

. Periodic, Fast Response

These interrupts occur at a known period, and when they do occur, they must be serviced as
quickly as possible to minimize latency. The A/D converter is one good example of this. The
A/D sample must be processed with minimum latency.

On the f28p65x devices, such interrupts are allocated to the group 1 in the PIE table. Group 1
is multiplexed into the CPU INT1. CPU INT1 has the highest hardware priority

. Periodic

These interrupts occur at a known period and must be serviced before the next interrupt.
Some of the PWM interrupts are an example of this. Many of the registers are shadowed, so
the user has the full period to update the register values.

In the f28p65x device’s PIE modules, such interrupts are mapped to group 2 - group 5. These
groups are multiplexed into CPU INT3 to INT5 (the ePWM and eCAP), which are the next
lowest hardware priority.

. Periodic, Buffered

These interrupts occur at periodic events, but are buffered and hence the processor need
only service such interrupts when the buffers are ready to filled/emptied. All of the serial ports
(SCI/SPI1/12C / CAN) either have FIFOs or multiple mailboxes such that the CPU has plenty

40
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of time to respond to the events without fear of losing data.

In the f28p65x device, such interrupts are mapped to INT6, INT8, and INT9, which are the
next lowest hardware priority.

3.3  Software Prioritization of Interrupts

The user will probably find that the PIE interrupts are organized where they should be for most applications.
However, some software prioritization may still be required for some applications.

Recall that the basic software priority scheme on the C28x works as follows:

m Global Priority
This priority can be managed by manipulating the CPU IER register. This register controls the
16 maskable CPU interrupts (INT1 - INT16).

m Group Priority
This can be managed by manipulating the PIE block interrupt enable registers (PIEIERX).
There is one PIEIERX per group and each control the 8-interrupts multiplexed within that group.

The F28 software prioritization of interrupt example demonstrates how to configure the Global priority (via IER)
and group priority (via PIEIERx) within an ISR in order to change the interrupt service priority based on user
assigned levels. The steps required to do this are:

1. Set the global priority
Modify the IER register to allow CPU interrupts with a higher user priority to be serviced.

2. Set the Group priority
Modify the appropriate PIEIERX register to allow group interrupts with a higher user set priority
to be serviced.

3. Enable interrupts

The software prioritized interrupts example provides a method using mask values that are configured during
compile time to allow you to manage this easily.

To setup software prioritization for the example, the user must first assign the desired global priority levels and
group priority levels.

This can be done as follows:

1. User assigns global priority levels
INT1PL - INT16PL
These values are used to assign a priority level to each of the 16 interrupts controlled by the
CPU IER register. A value of 1 is the highest priority while a value of 16 is the lowest. More
then one interrupt can be assigned the same priority level. In this case the default hardware
priority would determine which would be serviced first. A priority of 0 is used to indicate that
the interrupt is not used.
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2. User assigns PIE group priority levels
GxyPL (where x = PIE group number 1 - 12 and y = interrupt number 1 - 8)

These values are used to assign a priority level to each of the 8 interrupts within a PIE group.
A value of 1 is the highest priority while a value of 8 is the lowest. More then one interrupt can
be assigned the same priority level. In this case the default hardware priority would determine
which would be serviced first. A priority of 0 is used to indicate that the interrupt is not used.

Once the user has defined the global and group priority levels, the compiler will generate mask values that
can be used to change the IER and PIEIERXx registers within each ISR. In this manner the interrupt software
prioritization will be changed. The masks that are generated at compile time are:

= |ER mask values
MINT1 - MINT16

The user assigned INT1PL - INT16PL values are used at compile time to calculate an IER
mask for each CPU interrupt. This mask value will be used within an ISR to allow CPU inter-
rupts with a higher priority to interrupt the current ISR and thus be serviced at a higher priority
level.

= PIEIERxy mask values
MGxy (where x = PIE group number 1 - 12 and y = interrupt number 1 - 8)

The assigned group priority levels (GxyPL) are used at compile time to calculate PIEIERx
masks for each PIE group. This mask value will be used within an ISR to allow interrupts
within the same group that have a higher assigned priority to interrupt the current ISR and
thus be serviced at a higher priority level.

3.3.1  Using the IER/PIEIER Mask Values

Within an interrupt service routine, the global and group priority can be changed by software to allow other
interrupts to be serviced. The procedure for setting an interrupt priority using the mask values created in the
F28_SWHPrioritizedlsrLevels.h is the following:

1. Set the global priority

= Modify IER to allow CPU interrupts from the same PIE group as the current ISR.
= Modify IER to allow CPU interrupts with a higher user defined priority to be serviced.

2. Set the group priority

m Save the current PIEIERX value to a temporary register.

m The PIEIER register is then set to allow interrupts with a higher priority within a PIE group
to be serviced.

3. Enable interrupts

m Enable all PIE interrupt groups by writing all 1’s to the PIEACK register
m Enable global interrupts by clearing INTM

4. Execute ISR. Interrupts that were enabled in steps 1-3 (those with a higher software priority)
will be allowed to interrupt the current ISR and thus be serviced first.

5. Restore the PIEIERX register
6. Exit
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3.3.2 Example Code

The sample C code below shows an EV-A Comparator 1 Interrupt service routine software prioritization written
in C. This interrupt is connected to PIE group 2 interrupt 1.

// Connected to PIEIER2_1 (use MINT2 and MG21 masks):

#if

(G21PL != 0)

interrupt void EPWM1_TZINT_ISR(void) // EPWM1 Trip Zone

{

// Set interrupt priority:

volatile Uintl6 TempPIEIER = PieCtrlRegs.PIEIER2.all;

IER |= M_INT2;

IER &= MINT2; // Set "global" priority
PieCtrlRegs.PIEIER2.all &= MG21; // Set "group" priority
PieCtrlRegs.PIEACK.all = OxFFFF; // Enable PIE interrupts
asm(" NOP");

EINT;

// Insert ISR Code here.......
// for now just insert a delay
for(i = 1; 1 <= 10; 1i++) {}

// Restore registers saved:
DINT;
PieCtrlRegs.PIEIER2.all = TempPIEIER;

// Add ISR to Trace

ISRTrace[ISRTracelIndex] = 0x0021;
ISRTraceIndex++;
}
#endif
CMP1INT_ISR:
ASP
ADDB SP, #1
CLRC OVM, PAGEQ
MOVW DP, #0x0033
MOV AL, @36
MOV *—=SP[1],AL
OR IER, #0x0002
AND IER, #0x0002
AND @36, #0x000E
MOV @33, #0XFFFF
CLRC INTM

User code goes here...

SETC INTM
MOV AL, *—SP[1]
MOV @36,AL
SUBB SP, #1
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NASP
IRET

The interrupt latency is approx 22 cycles.

/%]
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CPU 1 Bit-field Example Applications

These example applications show how to make use of various peripherals of a F28P65x device. These appli-
cations are intended for demonstration and as a starting point for new applications.

All these examples contain two build configurations which allow you to build each project to run from either RAM
or Flash. To change how the project is built simply right click on the project and select "Build Configurations”.
Then, move over to set the active build configuration, either RAM or Flash.

The examples provided are built for control CARD compatibility.

Because CPU 1 is ultimately in control of the entire F28P65x device and these applications contain no CPU 2
dependencies, these examples may be run completely on their own without any associated CPU2 program.

All of these examples reside in the device_support/f28p65x/examples/cpul subdirectory of the
C2000Ware package.

ADC SOC Software Force (adc_soc_software)

This example converts some voltages on ADCA and ADCB based on a software trigger.

After the program runs, the memory will contain:

m AdcaResult0 : a digital representation of the voltage on pin A2
m AdcaResult1 : a digital representation of the voltage on pin A3
m AdcbResult0 : a digital representation of the voltage on pin B2
m AdcbResult1 : a digital representation of the voltage on pin B3

Note: The software triggers for the two ADCs happen sequentially, so the two ADCs will run asynchronously.

ADC ePWM Triggering (adc_soc_epwm)

This example sets up the ePWM to periodically trigger the ADC.

After the program runs, the memory will contain:

m AdcaResults : A sequence of analog-to-digital conversion samples from pin A0. The time
between samples is determined based on the period of the ePWM timer.

ADC temperature sensor conversion (adc_soc_epwm_tempsensor)

This example sets up the ePWM to periodically trigger the ADC. The ADC converts the internal connection to
the temperature sensor, which is then interpreted as a temperature by calling the GetTemperatureC function.

After the program runs, the memory will contain:

m sensorSample : The raw reading from the temperature sensor.
m sensorTemp : The interpretation of the sensor sample as a temperature in degrees Celsius.

Tue Oct 29 00:46:52 IST 2024 45



4.4

4.5

4.6

4.7

CPU 1 Bit-field Example Applications

ADC Synchronous SOC Software Force
(adc_soc_software_sync)

This example converts some voltages on ADCA and ADCB using input 5 of the input X-BAR as a software force.
Input 5 is triggered by toggling GPIOO0, but any spare GPIO could be used. This method will ensure that both
ADCs start converting at exactly the same time.

After the program runs, the memory will contain:

m AdcaResult0 : a digital representation of the voltage on pin A2
m AdcaResult1 : a digital representation of the voltage on pin A3
m AdcbResult0 : a digital representation of the voltage on pin B2
m AdcbResult1 : a digital representation of the voltage on pin B3

ADC Continuous Triggering (adc_soc_continuous)

This example sets up the ADC to convert continuously, achieving maximum sampling rate.

After the program runs, the memory will contain:

m AdcaResults : A sequence of analog-to-digital conversion samples from pin A0. The time
between samples is the minimum possible based on the ADC speed.

ADC Continuous Conversions Read by DMA
(adc_soc_continuous_dma)

This example sets up two ADC channels to convert simultaneously. The results will be transferred by the DMA
into a buffer in RAM.

After the program runs, the memory will contain:

m adcDataO0 : a digital representation of the voltage on pin A3
m adcData1 : a digital representation of the voltage on pin B3

ADC PPB Offset (adc_ppb_offset)

This example software triggers the ADC. Some SOCs have automatic offset adjustment applied by the post-
processing block.

After the program runs, the memory will contain:

m AdcaResult : a digital representation of the voltage on pin A0

m AdcaResult_offsetAdjusted : a digital representation of the voltage on pin A0, minus 100
LSBs of automatically added offset
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m AdcbResult : a digital representation of the voltage on pin BO

m AdcbResult_offsetAdjusted : a digital representation of the voltage on pin B0 plus 100 LSBs
of automatically added offset

ADC PPB Limits (adc_ppb_limits)

This example sets up the ePWM to periodically trigger the ADC. If the results are outside of the defined range,
the post-processing block will generate an interrupt.

The default limits are 1000LSBs and 3000LSBs. With VREFHI set to 3.3V, the PPB will generate an interrupt if
the input voltage goes above about 2.4V or below about 0.8V.

ADC PPB Delay Capture (adc_ppb_delay)

This example demonstrates delay capture using the post-processing block.
Two asynchronous ADC triggers are setup:

m ePWM1, with period 2048, triggering SOCO to convert on pin A0
m ePWM1, with period 9999, triggering SOC1 to convert on pin A1

Each conversion generates an ISR at the end of the conversion. In the ISR for SOCO, a conversion counter is
incremented and the PPB is checked to determine if the sample was delayed.

After the program runs, the memory will contain:

m conversion : the sequence of conversions using SOCO0 that were delayed
m delay : the corresponding delay of each of the delayed conversions

CLA arcsine(z) using a lookup table (cla_asin_cpu01)

In this example, Task 1 of the CLA will calculate the arcsine of an input argument in the range (-1.0 to 1.0) using
a lookup table.

Memory Allocation

m CLA1 Math Tables (RAMLSO0)
» CLAasinTable - Lookup table
m CLA1 to CPU Message RAM
 fResult - Result of the lookup algorithm
m CPU to CLA1 Message RAM
« fVal - Sample input to the lookup algorithm

Watch Variables

m fVal - Argument to task 1
m fResult - Result of arcsin(fVal)
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CLA arctangent(z) using a lookup table (cla_atan_cpu01)

In this example, Task 1 of the CLA will calculate the arctangent of an input argument using a lookup table.

Memory Allocation

m CLA1 Math Tables (RAMLSO)

» CLAatan2Table - Lookup table
m CLA1 to CPU Message RAM

 fResult - Result of the lookup algorithm
m CPU to CLA1 Message RAM

» fNum - Numerator of sample input
» fDen - Denominator of sample input

Watch Variables

m fVal - Argument to task 1
m fResult - Result of arctan(fVal)

Buffered DAC Enable (buffdac_enable)

This example generates a voltage on the buffered DAC output, DACOUTA/ADCINAO (HSEC Pin 9) and uses
the default DAC reference setting of VDAC.

Buffered DAC Sine DMA (buffdac_sine_dma)

This example generates a sine wave on the buffered DAC output using the DMA to transfer sine values stored
in a sine table in GSRAM to DACVALS, DACOUTA/ADCINAO (HSEC Pin 9) and uses the default DAC reference
setting of VDAC.

When the DAC reference is set to VDAC, an external reference voltage must be applied to the VDAC pin. This
can accomplished by connecting a jumper wire from 3.3V to ADCINBO (HSEC pin 12).

Run the included .js file to add the watch variables.
outputFreq_hz = (samplingFreq_hz/SINE_TBL_SIZE)«tableStep

The generated waveform can be adjusted with the following variables/macros but require recompile:

m waveformGain : Adjust the magnitude of the waveform. Range is from 0.0 to 1.0. The default
value of 0.8003 centers the waveform within the linear range of the DAC.

m waveformOffset : Adjust the offset of the waveform. Range is from -1.0 to 1.0. The default
value of 0 centers the waveform.

m samplingFreq_hz : Adjust the rate at which the DAC is updated. Range - Bounded by cpu
timer maximum interrupt rate.

m tableStep : The sine table step size. Range - Bounded by sine table size, should be much
less than sine table size to have good resolution.
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m REFERENCE : The reference for the DAC. Range - REFERENCE_VDAC, REFER-
ENCE_VREF

m CPUFREQ_MHZ : The cpu frequency. This does not set the cpu frequency. Range - See
device data manual

m DAC_NUM : The DAC to use. Range - DACA, DACC

DMA GSRAM Transfer (dma_gsram_transfer)

This example uses one DMA channel to transfer data from a buffer in RAMGSO0 to a buffer in RAMGS1. The
example sets the DMA channel PERINTFRC bit repeatedly until the transfer of 16 bursts (where each burst is 8
16-bit words) has been completed. When the whole transfer is complete, it will trigger the DMA interrupt.

Watch Variables

m sdata - Data to send
m rdata - Received data

EPWM Trip Zone Module (epwm_trip_zone)

This example configures ePWM1 and ePWM2 as follows

m ePWM1 has TZ1 as one shot trip source
m ePWM2 has TZ1 as cycle by cycle trip source

Initially tie TZ1 high. During the test, monitor ePWM1 or ePWM2 outputs on a scope. Pull TZ1 low to see the
effect.

External Connections

s EPWM1A is on GPIO0
m EPWM2A is on GPIO2
m TZ1is on GPIO12

This example also makes use of the Input X-BAR. GPIO12 (the external trigger) is routed to the input X_BAR,
from which it is routed to TZ1.

The TZ-Event is defined such that EPWM1A will undergo a One-Shot Trip and EPWM2A will undergo a Cycle-
By-Cycle Trip.

EPWM Action Qualifier (epwm_updown_aq)

This example configures ePWM1, ePWM2, ePWM3 to produce an waveform with independent modulation on
EPWMxA and EPWMxB.

The compare values CMPA and CMPB are modified within the ePWM'’s ISR.

The TB counter is in up/down count mode for this example.
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View the EPWM1A/B(PAO_GPIO0 & PA1_GPIO1), EPWM2A/B(PA2_GPIO2 & PA3 _GPIO3) and
EPWMBSBA/B(PA4_GPIO4 & PA5_GPIO5) waveforms via an oscilloscope.

EPWM Action Qualifier (epwm_up_aq)

This example configures ePWM1, ePWM2, ePWM3 to produce an waveform with independent modulation on
EPWMxA and EPWMxB.

The compare values CMPA and CMPB are modified within the ePWM'’s ISR.
The TB counter is in up count mode for this example.

View the EPWM1A/B(PAO_GPIOO0 & PA1_GPIO1), EPWM2A/B(PA2_GPIO2 & PA3_GPIO3) and
EPWM3A/B(PA4_GPI0O4 & PA5_GPIO5) waveforms via an oscilloscope.

EPWM dead band control (epwm_deadband)

During the test, monitor ePWM1, ePWM2, and/or ePWMS3 outputs on a scope.

m ePWM1A is on GPIO0
ePWM1B is on GPIO1
ePWM2A is on GPIO2
m ePWM2B is on GPIO3
m ePWMB3A is on GPIO4
m ePWMB3B is on GPIO5

This example configures ePWM1, ePWM2 and ePWMS3 for:

m Count up/down
m Deadband

3 Examples are included:

m ePWM1: Active low PWMs
m ePWM2: Active low complementary PWMs
m ePWMB: Active high complementary PWMs

Each ePWM is configured to interrupt on the 3rd zero event. When this happens the deadband is modified such
that 0 <= DB <= DB_MAX. That is, the deadband will move up and down between 0 and the maximum value.

View the EPWM1A/B, EPWM2A/B and EPWM3A/B waveforms via an oscilloscope

HRPWM Duty SFO (hrpwm_duty sfo v8)

This program requires the header files, which include the following files required for this example: sfo_v8.h and
SFO_v8_fpu_lib_build_c28 eabi.lib
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Monitor ePWM1-ePWM7 A/B pins on an oscilloscope. DESCRIPTION:

This example modifies the MEP control registers to show edge displacement for high-resolution period with
ePWM in Up-Down count mode due to the HRPWM control extension of the respective ePWM module.

This example calls the following TI's MEP Scale Factor Optimizer (SFO) software library V8 functions:
int SFO();

m updates MEP_ScaleFactor dynamically when HRPWM is in use

m updates HRMSTEP register (exists only in EPwm1Regs register space) with
MEP_ScaleFactor value

m returns 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion
may not function properly under this condition)

m returns 1 when complete for the specified channel
m returns 0 if not complete for the specified channel

This example is intended to explain the HRPWM capabilities. The code can be optimized for code efficiency.
Refer to TI's Digital power application examples and TI Digital Power Supply software libraries for details.

NOTE: For more information on using the SFO software library, see
the High-Resolution Pulse Width Modulator (HRPWM) Reference Guide

To load and run this example:

1. xxlIMPORTANT !l

2. Run this example at maximum SYSCLKOUT

3. Activate Real time mode

4. Run the code

5. Watch ePWM A / B channel waveforms on a Oscilloscope
6

. Inthe watch window: Set the variable UpdateFine = 1 to observe the ePWMxA & ePWMxB out-
put with HRPWM capabilities (default) Observe the period/frequency of the waveform changes
in fine MEP steps

7. In the watch window: Change the variable UpdateFine to 0, to observe the ePWMxA & eP-
WMxB output without HRPWM capabilities Observe the period/frequency of the waveform
changes in coarse SYSCLKOUT cycle steps.

HRPWM SFO Test (hrpwm_prdupdown_sfo_v8)

This program requires the header files, which include the following files required for this example: sfo_v8.h and
SFO_v8_fpu_lib_build_c28_eabi.lib

Monitor ePWM1-ePWM7 A/B pins on an oscilloscope. DESCRIPTION:

This example modifies the MEP control registers to show edge displacement for high-resolution period with
ePWM in Up-Down count mode due to the HRPWM control extension of the respective ePWM module.

This example calls the following TI's MEP Scale Factor Optimizer (SFO) software library V8 functions:
int SFO();
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m updates MEP_ScaleFactor dynamically when HRPWM is in use

m updates HRMSTEP register (exists only in EPwm1Regs register space) with
MEP_ScaleFactor value

m returns 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion
may not function properly under this condition)

m returns 1 when complete for the specified channel
m returns 0 if not complete for the specified channel

This example is intended to explain the HRPWM capabilities. The code can be optimized for code efficiency.
Refer to TI's Digital power application examples and Tl Digital Power Supply software libraries for details.

NOTE: For more information on using the SFO software library, see
the High-Resolution Pulse Width Modulator (HRPWM) Reference Guide

To load and run this example:

1. xxIMPORTANT !

2. Run this example at maximum SYSCLKOUT

3. Activate Real time mode

4. Run the code

5. Watch ePWM A / B channel waveforms on an Oscilloscope
6

. Inthe watch window: Set the variable UpdateFine = 1 to observe the ePWMxA & ePWMxB out-
put with HRPWM capabilities (default) Observe the period/frequency of the waveform changes
in fine MEP steps

7. In the watch window: Change the variable UpdateFine to 0, to observe the ePWMxA & eP-
WMxB output without HRPWM capabilities Observe the period/frequency of the waveform
changes in coarse SYSCLKOUT cycle steps.

External Interrupts (Externalinterrupt)

This program sets up GPIO0 as XINT1 and GPIO1 as XINT2. Two other GPIO signals are used to trigger the
interrupt (GP10O30 triggers XINT1 and GPIO31 triggers XINT2). The user is required to externally connect these
signals for the program to work properly.

XINT1 input is synced to SYSCLKOUT.
XINT2 has a long qualification - 6 samples at 510«SYSCLKOUT each.

GPI10O34 will go high outside of the interrupts and low within the interrupts. This signal can be monitored on a
scope.

Each interrupt is fired in sequence - XINT1 first and then XINT2

External Connections

m Connect GPIO30 to GPIO0. GPIOO0 will be assigned to XINT1
m Connect GPIO31 to GPIO1. GPIO1 will be assigned to XINT2
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Monitor GP1034 with an oscilloscope. GPIO34 will be high outside of the ISRs and low within each ISR.
Watch Variables

m Xint1Count for the number of times through XINT1 interrupt
m Xint2Count for the number of times through XINT2 interrupt
m LoopCount for the number of times through the idle loop

4.22 SDFM Filter Sync CPU

In this example, SDFM filter data is read by CPU in SDFM ISR routine. The SDFM configuration is shown
below:

m SDFM1 is used in this example. For using SDFM2, few modifications would be needed in the
example.

Input control mode selected - MODEO

m Comparator settings
* Sinc3 filter selected
+ OSR =32
* HLT = 0x7FFF (Higher threshold setting)
e LLT = 0x0000(Lower threshold setting)
m Data filter settings
+ All the 4 filter modules enabled
Sinc3 filter selected
OSR =256
All the 4 filters are synchronized by using MFE (Main Filter enable bit)
Filter output represented in 16 bit format
* In order to convert 25 bit Data filter into 16 bit format user needs to right shift by 10 bits
for Sinc3 filter with OSR = 256

m Interrupt module settings for SDFM filter

« All the 4 higher threshold comparator interrupts disabled

 All the 4 lower threshold comparator interrupts disabled

« All the 4 modulator failure interrupts disabled

« All the 4 filter will generate interrupt when a new filter data is available.

External Connections

m SDFM_PIN_MUX_OPTION1 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPIO16-GPIO31

m SDFM_PIN_MUX_OPTION2 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GP1048-GPI063

m SDFM_PIN_MUX_OPTION3 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPI0122-GPI10137

Watch Variables
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m Filter1_Result - Output of filter 1
m Filter2_Result - Output of filter 2
m Filter3_Result - Output of filter 3
m Filter4_Result - Output of filter 4

4.23 SDFM Filter Sync CLA

In this example, SDFM filter data is read by CLA in Cla1Task1. The SDFM configuration is shown below:

m SDFM1 used in this example.For using SDFM2, few modifications would be needed in the
example.

m MODEO Input control mode selected
m Comparator settings
« Sinc3 filter selected
« OSR =32
« HLT = 0x7FFF (Higher threshold setting)
» LLT = 0x0000(Lower threshold setting)
m Data filter settings
« All the 4 filter modules enabled
Sincs filter selected
OSR =256
All the 4 filters are synchronized by using MFE (Main Filter enable bit)
Filter output represented in 16 bit format

In order to convert 25 bit Data filter into 16 bit format user needs to right shift by 10 bits
for Sinc3 filter with OSR = 256

m Interrupt module settings for SDFM filter
« All the 4 higher threshold comparator interrupts disabled
+ All the 4 lower threshold comparator interrupts disabled
« All the 4 modulator failure interrupts disabled
« All the 4 filter will generate interrupt when a new filter data is available

External Connections

m SDFM_PIN_MUX_OPTION1 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPIO16-GPIO31

m SDFM_PIN_MUX_OPTION2 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GP1048-GP1063

m SDFM_PIN_MUX_OPTION3 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPI0122-GPI0137

Watch Variables

m Filter1_Result - Output of filter 1
m Filter2_Result - Output of filter 2
m Filter3_Result - Output of filter 3
m Filter4_Result - Output of filter 4
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4.24 SDFM Filter Sync DMA

In this example, SDFM filter data is read by DMA. The SDFM configuration is shown below:

m SDFM1 used in this example. For using SDFM2, few modifications would be needed in the
example.

= MODEQO Input control mode selected
m Comparator settings
» Sinc3 filter selected
+ OSR =32
* HLT = 0x7FFF (Higher threshold setting)
» LLT = 0x0000(Lower threshold setting)
m Data filter settings
« All the 4 filter modules enabled
« Sinc3 filter selected
* OSR =256
All the 4 filters are synchronized by using MFE (Main Filter enable bit)
Filter output represented in 16 bit format

In order to convert 25 bit Data filter into 16 bit format user needs to right shift by 10 bits
for Sinc3 filter with OSR = 256

m Interrupt module settings for SDFM filter
« All the 4 higher threshold comparator interrupts disabled
 All the 4 lower threshold comparator interrupts disabled
« All the 4 modulator failure interrupts disabled
« All the 4 filter will generate interrupt when a new filter data is available

External Connections

m SDFM_PIN_MUX_OPTION1 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPIO16-GPIO31

m SDFM_PIN_MUX_OPTION2 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GP1048-GPI063

m SDFM_PIN_MUX_OPTION3 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPI0122-GPI0137

Watch Variables

Filter1_Result - Output of filter 1
Filter2_Result - Output of filter 2
Filter3_Result - Output of filter 3
Filter4_Result - Output of filter 4
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4.25 SDFM PWM Sync

In this example, SDFM filter data is read by CPU in SDFM ISR routine. The SDFM configuration is shown
below:

m SDFM1 is used in this example. For using SDFM2, few modifications would be needed in the
example.

m MODEQO Input control mode selected
m Comparator settings

* Sinc3 filter selected

+ OSR =32

* HLT = 0x7FFF (Higher threshold setting)
* LLT = 0x0000(Lower threshold setting)

Data filter settings

m All the 4 filter modules enabled
m Sinc3 filter selected
m OSR = 256
m All the 4 filters are synchronized by using PWM (Main Filter enable bit)
m Filter output represented in 16 bit format
m In order to convert 25 bit Data filter into 16 bit format user needs to right shift by 10 bits for
Sinc3 filter with OSR = 256
Interrupt module settings for SDFM filter

m All the 4 higher threshold comparator interrupts disabled

m All the 4 lower threshold comparator interrupts disabled

m All the 4 modulator failure interrupts disabled

m All the 4 filter will generate interrupt when a new filter data is available External Connections

SDFM_PIN_MUX_OPTION1 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-D4,SDx-C4) on
GPIO16-GPIO31

m SDFM_PIN_MUX_OPTION2 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GP1048-GPI063

m SDFM_PIN_MUX_OPTION3 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPI0122-GP10137

Watch Variables

m Filter1_Result - Output of filter 1
m Filter2_Result - Output of filter 2
m Filter3_Result - Output of filter 3
m Filter4_Result - Output of filter 4
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These example applications show how to make use of f28p65x device functions which span both the CPU 1
and CPU 2. All of these examples contain two example projects: one for CPU 1 and one for CPU 2.

Like the CPU1 only projects, these projects also contain different build configurations for RAM and Flash builds.
All of the projects contain RAM and Flash build configurations with debugger support.

The examples provided are built for controlCARD compatibility.

To run one of these examples after compiling it, load the appropriate programs on each of the two cores. Then,
for more example specific instructions please refer to the documentation regarding the example you wish to run
on the following pages or in the comments of the example sources.

All of these examples can be found in the

device_support/f28p65x/examples/dual subdirectory of the C2000Ware package.

DMA Transfer Shared Peripheral

This example shows how to initiate a DMA transfer on CPU1 from a shared peripheral which is owned by CPU2.
In this specific example, a timer ISR is used on CPU2 to initiate a SPI transfer which will trigger the CPU1 DMA.
CPU1’s DMA will then in turn update the EPWM1 CMPA value for the PWM which it owns. The PWM output
can be observed on the GPIO pins configured in the InitEPwm1Gpio() function.

Watch Pins

m GPIO0 and GPIO1 - ePWM output can be viewed with oscilloscope

Shared RAM management (CPU1)

This example shows how to assign shared RAM for use by both the CPU02 and CPUO1 core. Shared RAM
regions are defined in both the CPU02 and CPUO01 linker files. In this example GSO and GS4 are assigned
to/owned by CPU02. The remaining shared RAM regions are owned by CPUO1. In this example:

A pattern is written to c1_r_w_array and then IPC flag is sent to notify CPUO2 that data is ready to be read.
CPUO02 then reads the data from c2_r_array and writes a modified pattern to c2_r_w_array. Once CPU02
acknowledges the IPC flag to , CPUO1 reads the data from ¢1_r_array and compares with expected result.

A Timed ISR is also serviced in both CPUs. The ISRs are copied into the shared RAM region owned by the
respective CPUs. Each ISR toggles a GPIO. Watch GPIO31 and GPIO34 on oscilloscope. If using the control
card watch LED1 and LED2 blink at different rates.

Following are the memory allocation details of CPU Timer interrupt ISRs & read(R)/read write(RW) arrays in
CPU1 & CPU2 as configured in the example.

m c1_r_w_array[] is mapped to shared RAM GS1

m c1_r_array[] is mapped to shared RAM GS0

m c2_r_array[] is mapped to shared RAM GS1

m c2_r_w_array[] is mapped to shared RAM GS0

m cpu_timer0_isrin CPUO2 is copied to shared RAM GS4 , toggles GPIO31

Tue Oct 29 00:46:52 IST 2024 57



2.3

Dual Core Bit-field Example Applications

m cpu_timerQ_isr in CPUO1 is copied to shared RAM GS3 , toggles GP1034

Note:
In the default CPU2 linker cmd file, GS4, FLASH BANKS3 and FLASH BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2. Please note that CPU2 .out file can be loaded only after CPU1 completes
this configuration

Watch Variables

m error Indicates that the data written is not correctly received by the other CPU.

Shared RAM management (CPU2)

This example shows how to assign shared RAM for use by both the CPU02 and CPUO1 core. Shared RAM
regions are defined in both the CPU02 and CPUO01 linker files. In this example GS0O and GS4 are assigned
to/owned by CPU02. The remaining shared RAM regions are owned by CPUO1. In this example:

A pattern is written to c1_r_w_array and then IPC flag is sent to notify CPU02 that data is ready to be read.
CPUO2 then reads the data from c2_r_array and writes a modified pattern to c2_r w_array. Once CPU02
acknowledges the IPC flag to , CPUO1 reads the data from c¢1_r_array and compares with expected result.

A Timed ISR is also serviced in both CPUs. The ISRs are copied into the shared RAM region owned by the
respective CPUs. Each ISR toggles a GPIO. Watch GPIO31 and GPIO34 on oscilloscope. If using the control
card watch LED1 and LED2 blink at different rates.

Following are the memory allocation details of CPU Timer interrupt ISRs & read(R)/read write(RW) arrays in
CPU1 & CPU2 as configured in the example.

m c1_r w_array[] is mapped to shared RAM GS1

m c1_r_array[] is mapped to shared RAM GS0

m c2_r_array[] is mapped to shared RAM GS1

m c2_r_w_array[] is mapped to shared RAM GS0

m cpu_timer0_isr in CPUO2 is copied to shared RAM GS4 , toggles GPIO31
m cpu_timerQ_isr in CPUO1 is copied to shared RAM GS3 , toggles GPIO34

Watch Variables

m error Indicates that the data written is not correctly received by the other CPU.
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C28x Driver Library Example Applications

These example applications show how to make use of various peripherals of a F28P65x device. These appli-
cations are intended for demonstration and as a starting point for new applications.

All these examples are setup using the Code Composer Studio (CCS) "projectspec” format. Upon importing
the "projectspec”, the example project will be generated in the CCS workspace with copies of the source and
header files included.

All these examples contain two build configurations which allow you to build each project to run from either RAM
or Flash. To change how the project is built simply right click on the project and select "Build Configurations".
Then, move over to set the active build configuration, either RAM or Flash.

The examples provided are built for controlCARD compatibility.
There may be a few examples which need either an external hardware or device not present on the control CARD
like:

m [2C communication with eeprom
m SPI communication with eeprom
m EMIF accessing external memory
m DCC clock failure detection

Because CPU 1 is ultimately in control of the entire F28P65x device and these applications contain no CPU 2,
these examples may be run completely on their own without any associated CPU2 .

All of these examples reside in the driverlib/f28p65x/examples/c28x subdirectory of the C2000Ware
package.

Note that in all the examples, Device_init function assumes that the XTAL frequency is 25MHz. If a 20MHz
XTAL is used, please add a predefined symbol "USE_20MHZ_XTAL" in your CCS project. If a different XTAL is
used, you need to update the macro DEVICE_SETCLOCK_CFG in device.h file accordingly.

Detailed Description

ADC ePWM Triggering Multiple SOC

This example sets up ePWM1 to periodically trigger a set of conversions on ADCA and ADCC. This example
demonstrates multiple ADCs working together to process of a batch of conversions using the available paral-
lelism across multiple ADCs.

ADCA Interrupt ISRs are used to read results of both ADCA and ADCC.

External Connections
m AQ, A1, A2 and C2, C3, C4 pins should be connected to signals to be converted.
Watch Variables

m adcAResult0 - Digital representation of the voltage on pin A0
m adcAResult1 - Digital representation of the voltage on pin A1
m adcAResult2 - Digital representation of the voltage on pin A2
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m adcCResult0 - Digital representation of the voltage on pin C2
m adcCResult1 - Digital representation of the voltage on pin C3
m adcCResult2 - Digital representation of the voltage on pin C4

ADC Burst Mode

This example sets up ePWM1 to periodically trigger ADCA using burst mode. This allows for different channels
to be sampled with each burst.

Each burst triggers 3 conversions. A0 and A1 are part of every burst while the third conversion rotates between
A2, A3, and A4. This allows high importance signals to be sampled at high speed while lower priority signals
can be sampled at a lower rate.

ADCA Interrupt ISRs are used to read results for ADCA.

External Connections
m AO, A1, A2, A3, A4
Watch Variables

m adcAResult0 - Digital representation of the voltage on pin A0
m adcAResult1 - Digital representation of the voltage on pin A1
m adcAResult2 - Digital representation of the voltage on pin A2
m adcAResult3 - Digital representation of the voltage on pin A3
m adcAResult4 - Digital representation of the voltage on pin A4

ADC Burst Mode Oversampling

This example is an ADC oversampling example implemented with software. The ADC SOCs are configured in
burst mode, triggered by the ePWM SOC A event trigger.

External Connection
m A2
Watch Variables

m |v_results - Array of digital values measured on pin A2 (oversampling is configured by Over-
sampling_Amount)

ADC SOC Oversampling

This example sets up ePWM1 to periodically trigger a set of conversions on ADCA including multiple SOCs that
all convert A2 to achieve oversampling on A2.
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ADCA Interrupt ISRs are used to read results of ADCA.

External Connections
m A0, A1, A2 should be connected to signals to be converted.
Watch Variables

m adcAResult0 - Digital representation of the voltage on pin A0
m adcAResult1 - Digital representation of the voltage on pin A1
m adcAResult2 - Digital representation of the voltage on pin A2

ADC PPB PWM trip (adc_ppb_pwm_trip)

This example demonstrates EPWM tripping through ADC limit detection PPB block. ADCAINT1 is configured to
periodically trigger the ADCA channel 2 post initial software forced trigger. The limit detection post-processing
block(PPB) is configured and if the ADC results are outside of the defined range, the post-processing block will
generate an ADCxEVTy event. This event is configured as EPWM trip source through configuring EPWM XBAR
and corresponding EPWM’s trip zone and digital compare sub-modules. The example showcases

m one-shot

m cycle-by-cycle

m and direct tripping of PWMs through ADCAEVT1 source via Digital compare submodule.
The default limits are OLSBs and 3600LSBs. With VREFHI set to 3.3V, the PPB will generate a trip event if the
input voltage goes above about 2.9V.

External Connections

m A2 should be connected to a signal to convert
m Observe the following signals on an oscilloscope

- ePWM1(GPIOO - GPIO1)
- ePWM2(GPIO2 - GPIO3)
- ePWM3(GPIO4 - GPIO5)

| |
Watch Variables

m adcA2Results - digital representation of the voltage on pin A2

ADC Trigger Repeater Oversampling

This example configures ADC for oversampling using trigger repeater block. The ePWM1 is configured to pe-
riodically trigger the ADC SOC and the trigger repeater module is configured to generate 4 repeated pulses.
Post-processing block will take the repeated pulses, accumulates them and stores the results in ppb sum regis-
ter.

External Connections
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m AQ should be connected to signals to convert.
Watch Variables

= myADCOResult - Digital representation of the voltage on pin A0
= myPPBOResult - Digital representation of the voltage of the 4 repeated pulses on pin A0

ADC Trigger Repeater Undersampling

This example configures ADC for undersampling using trigger repeater block. The ePWM1 is configured to
periodically trigger the ADC SOC and the trigger repeater module is configured to generate 1 pulse out of three
pulses. Post-processing block will take the undersampled pulse, accumulates them and stores the results in
ppb sum register.

External Connections
m AQ should be connected to signals to convert.
Watch Variables

= myADCOResult - Digital representation of the voltage on pin A0
= myPPBOResult - Digital representation of the voltage of the undersample pulse on pin A0

ADC Safety Checker

This example compares the absolute value of the two ADC conversion results with the set tolerance value.

The ADCA is used with A0 and A1 to compare the two ADC conversions. If the difference between two con-
version results exceeds the value configured as tolerance then the ADC result safety checker tile generates an
interrupt signal from out-of-tolerance.

External Connections
m A0 and A1 should be connected to signals to convert.
Watch Variables

= myADCOResult0 - Digital representation of the voltage on pin A0
= myADCOResult1 - Digital representation of the voltage on pin A1
m tolerance - Set digital tolerance limit for ADC safety checker

m count - number of times the OOT flag is generated

ADC Fast Oversampling (with Trigger Repeater)

This example configures the ADC to perform oversampling using the trigger repeater block. It uses a "fast over-
sampling" technique that takes advantage of the fact that the sample-and-hold capacitor is already at or close to
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the input signal voltage after the first conversion. This technique uses two SOCs to perform oversampling: the
first SOC is configured for a single conversion with the regular ACQPS value, and the second SOC is configured
to use the trigger repeater and has a reduced ACQPS value, enabling faster oversampling.

The ePWM1 is configured to periodically trigger the first ADC SOC, and the trigger repeater is configured
to trigger the second SOC. The trigger source of repeater module itself is also ePWM1. Because of round-
robin priority, the two SOCs convert back-to-back in order. The post-processing block takes accumulates the
oversampled conversions and stores them in the PPBSUM register.

External Connections
m AO should be connected to the signal to convert.
Watch Variables

m myADCOResults - A sequence of analog-to-digital conversion samples from pin A0. The time
between samples is determined based on the period of the ePWM timer.

ADC Software Triggering

This example converts some voltages on ADCA and ADCC based on a software trigger.

The ADCC will not convert until ADCA is complete, so the ADCs will not run asynchronously. However, this is
much less efficient than allowing the ADCs to convert synchronously in parallel (for example, by using an ePWM

trigger).
External Connections

m A0, A1, C2, and C3 should be connected to signals to convert

Watch Variables

myADCOResult0 - Digital representation of the voltage on pin A0
myADCOResult1 - Digital representation of the voltage on pin A1

myADC1Result0 - Digital representation of the voltage on pin C2

myADC1Result1 - Digital representation of the voltage on pin C3

ADC ePWM Triggering

This example sets up ePWM1 to periodically trigger a conversion on ADCA.

External Connections
m AOQ should be connected to a signal to convert
Watch Variables

= myADCOResults - A sequence of analog-to-digital conversion samples from pin A0. The time
between samples is determined based on the period of the ePWM timer.
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ADC Temperature Sensor Conversion

This example sets up the ePWM to periodically trigger the ADC. The ADC converts the internal connection
to the temperature sensor, which is then interpreted as a temperature by calling the ADC_getTemperatureC()
function.

Watch Variables

m sensorSample - The raw reading from the temperature sensor
m sensorTemp - The interpretation of the sensor sample as a temperature in degrees Celsius.

ADC Synchronous SOC Software Force
(adc_soc_software_sync)

This example converts some voltages on ADCA and ADCC using input 5 of the input X-BAR as a software
force. Input 5 is triggered by toggling GPIOO0, but any spare GPIO could be used. This method will ensure that
both ADCs start converting at exactly the same time.

External Connections
m A2, A3, C2, C3 pins should be connected to signals to convert
Watch Variables

= myADCOResult0 : a digital representation of the voltage on pin A2
= myADCOResult1 : a digital representation of the voltage on pin A3
= myADC1Result0 : a digital representation of the voltage on pin C2
m myADC1Result1 : a digital representation of the voltage on pin C3

ADC Continuous Triggering (adc_soc_continuous)
This example sets up the ADC to convert continuously, achieving maximum sampling rate.
External Connections

m A0 pin should be connected to signal to convert
Watch Variables

m adcAResults - A sequence of analog-to-digital conversion samples from pin A0. The time
between samples is the minimum possible based on the ADC speed.
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ADC Continuous Conversions Read by DMA
(adc_soc_continuous_dma)

This example sets up two ADC channels to convert simultaneously. The results will be transferred by the DMA
into a buffer in RAM.

External Connections
m A3 & C3 pins should be connected to signals to convert
Watch Variables

= myADCODataBuffer : a digital representation of the voltage on pin A3
= myADC1DataBuffer : a digital representation of the voltage on pin C3

ADC PPB Offset (adc_ppb_offset)

This example software triggers the ADC. Some SOCs have automatic offset adjustment applied by the post-
processing block. After the program runs, the memory will contain ADC & post-processing block(PPB) results.

External Connections
m A2, C2 pins should be connected to signals to convert
Watch Variables

= myADCOResult : a digital representation of the voltage on pin A2

= myADCOPPBResult : a digital representation of the voltage on pin A2, minus 100 LSBs of
automatically added offset

m myADC1Result : a digital representation of the voltage on pin C2

= myADC1PPBResult : a digital representation of the voltage on pin C2 plus 100 LSBs of
automatically added offset

ADC PPB Limits (adc_ppb_limits)

This example sets up the ePWM to periodically trigger the ADC. If the results are outside of the defined range,
the post-processing block will generate an interrupt.

The default limits are 1000LSBs and 3000LSBs. With VREFHI set to 3.3V, the PPB will generate an interrupt if
the input voltage goes above about 2.4V or below about 0.8V.

External Connections
m A0 should be connected to a signal to convert
Watch Variables

m None
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ADC PPB Delay Capture (adc_ppb_delay)

This example demonstrates delay capture using the post-processing block.

Two asynchronous ADC triggers are setup:

m ePWM1, with period 2048, triggering SOCO to convert on pin A0
m ePWM2, with period 9999, triggering SOC1 to convert on pin A2

Each conversion generates an ISR at the end of the conversion. In the ISR for SOCO, a conversion counter is
incremented and the PPB is checked to determine if the sample was delayed.

After the program runs, the memory will contain:

m conversion : the sequence of conversions using SOCO that were delayed
m delay : the corresponding delay of each of the delayed conversions

AES ECB Encryption Example

This example encrypts block cipher-text using AES128 in ECB mode. It does the encryption first without uDMA
and then with uDMA. The results are checked after each operation.

External Connections
m None
Watch Variables

m errCountGlobal - Error Counter. It should be zero.
m testStatusGlobal - Test status. It should be equal to PASS.

AES ECB De-cryption Example

This example de-crypts block cipher-text using AES128 in ECB mode. It does the de-cryption first without uDMA
and then with uDMA. The results are checked after each operation.

External Connections
= None
Watch Variables

m errCountGlobal - Error Counter. It should be zero.
m testStatusGlobal - Test status. It should be equal to PASS.
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AES GCM Encryption Example

This example encrypts block cipher-text using AES128 in GCM mode. It does the encryption first without uDMA
and then with uDMA. The results are checked after each operation.

External Connections
m None
Watch Variables

m errorCountGlobal - Error Counter. It should be zero.
m testStatusGlobal - Test status. It should be equal to PASS.

AES GCM Decryption Example

This example decrypts block cipher-text using AES128 in GCM mode. It does the decryption first without uDMA
and then with uDMA. The results are checked after each operation.

External Connections
m None
Watch Variables

m errorCountGlobal - Error Counter. It should be zero.
m testStatusGlobal - Test status. It should be equal to PASS.

AES CBC Encryption Example

This example encrypts block cipher-text using AES128 in CBC mode. It does the encryption first without uDMA
and then with uDMA. The results are checked after each operation.

External Connections
® None
Watch Variables

m errCountGlobal - Error Counter. It should be zero.
m testStatusGlobal - Test status. It should be equal to PASS.

AES CBC De-cryption Example

This example de-crypts block cipher-text using AES128 in CBC mode. It does the de-cryption first without uDMA
and then with uDMA. The results are checked after each operation.
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External Connections
® None
Watch Variables

m errCountGlobal - Error Counter. It should be zero.
m testStatusGlobal - Test status. It should be equal to PASS.

AES CMAC Authentication Example

This example encrypts block cipher-text using AES128 and AES256 in CMAC mode and authenticates the
result. It does the encryption first without uDMA and then with uDMA. The results are checked after each
operation.

External Connections
= None
Watch Variables

m errCountGlobal - Error Counter. It should be zero.
m testStatusGlobal - Test status. It should be equal to PASS.

BGCRC CPU Interrupt Example

This example demonstrates how to configure and trigger BGCRC from the CPU. BGCRC module is configured
for 1 KB of GS0 RAM which is programmed with a known data. The pre-computed CRC value is used as the
golden CRC value. Interrupt is generated once the computation is done and checks if no error flags are raised
Calculation uses the 32-bit polynomial 0x04C11DB7 and seed value 0x00000000.

External Connections
= None.
Watch Variables

m pass - This should be 1.

m runStatus - BGCRC running status. This will be BGCRC_ACTIVE if the module is running,
BGCRC_IDLE if the module is idle

BGCRC Example with Watchdog and Lock

This example demonstrates how to configure and trigger BGCRC from the CPU. It also showcases how to
configure the CRC watchdog and lock the registers after configuring the module. The watchdog is used as a
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diagnostic to check memory test completion within the expected time window. An error signal is generated if
the test does not complete in the specified time window.

The module is configured for 1kB of GSO RAM which is programmed with random data. The golden CRC value
for comparison is computed using software method. Interrupt is generated once the computation is done and
checks if no error flags are raised. The NMI is enabled and is triggered if an error is detected.

External Connections
= None.
Watch Variables

m pass
m bgcrcDone

CLA-BGCRC Example in CRC mode

This example demonstrates how to configure and trigger CLABGCRC from the CPU. It also showcases how to
configure the CRC watchdog and lock the registers after configuring the module. The watchdog is used as a
diagnostic to check memory test completion within the expected time window. An error signal is generated if
the test does not complete in the specified time window.

The module is configured for 1kB of CLA ROM memory. The golden CRC value for comparison is computed
using software method. Interrupt is generated once the computation is done and checks if no error flags are
raised. The NMl is enabled and is triggered if an error is detected.

External Connections
= None.
Watch Variables

m pass
m bgcrcDone

CLA-BGCRC Example in Scrub Mode

This example demonstrates how to configure and trigger CLA-BGCRC in Scrub mode. In Scrub mode, CRC of
data is not compared with the golden CRC. Error check is done using the ECC/Parity logic. It also showcases
how to configure the CRC watchdog and lock the registers after configuring the module. The watchdog is used
as a diagnostic to check memory test completion within the expected time window. An error signal is generated
if the test does not complete in the specified time window.

The module is configured for 256 bytes of CLA ROM memory. Interrupt is generated once the computation is
done and checks if no error flags are raised. The NMI is enabled and is triggered if an error is detected.

External Connections

= None.
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Watch Variables

m pass
m bgcrcDone

CPU1 Secure Flash Boot

This example demonstrates how to use the secure flash boot mode for CPU1

Secure flash boot performs a CMAC authentication on the entry sector of flash upon device boot up. If authen-
tication passes, the application will begin execution. Learn more on the secure flash boot mode in the device
technical reference manual.

This project shows how to use the C2000 HEX Utility to generate a CMAC Tag based on a user CMAC key and
embed the value into the flash application. Additionally, the example details the method to call the CMAC API
from the user application to calculate CMAC on other flash sectors beyond the the application entry flash sector.

Steps to run the example - 1. Update the small linker file (boot_ex1_flash_hex_Ink_cpu1.cmd) to include the
entire flash (starting at address 0x80000) 2. Make sure cmac_all uses all Os to allow the hex utility to populate
these addresses with the generated cmac_tag 3. Make sure the cmac_sb1 struct is un-commented to allow hex
utility to generate tag at 0x80002 4. Build and load the .hex file into flash, load the symbols from the generated
.out 5. In the memory browser, change the value at 0xd00 to OxX5AFFFFFF and 0xd04 to 0x0000000A(This sets
emulation boot to secure flash boot) 6. Reset the CPU1 via CCS and click resume 7. Observe the LEDs, LED
should blink if successful, turn on if secure boot passes but full flash range authentication failed, and be turned
off if secure boot failed

CAN External Loopback

This example shows the basic setup of CAN in order to transmit and receive messages on the CAN bus. The
CAN peripheral is configured to transmit messages with a specific CAN ID. A message is then transmitted once
per second, using a simple delay loop for timing. The message that is sent is a 2 byte message that contains
an incrementing pattern.

This example sets up the CAN controller in External Loopback test mode. Data transmitted is visible on the
CANTXA pin and is received internally back to the CAN Core. Please refer to details of the External Loopback
Test Mode in the CAN Chapter in the Technical Reference Manual. Refer to [Programming Examples and Debug
Strategies for the DCAN Module](www.ti.com/lit/'SPRACES) for useful information about this example

External Connections
= None.
Watch Variables

m msgCount - A counter for the number of successful messages received
m txMsgData - An array with the data being sent
m rxMsgData - An array with the data that was received
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CAN External Loopback with Interrupts

This example shows the basic setup of CAN in order to transmit and receive messages on the CAN bus. The
CAN peripheral is configured to transmit messages with a specific CAN ID. A message is then transmitted once
per second, using a simple delay loop for timing. The message that is sent is a 4 byte message that contains an
incrementing pattern. A CAN interrupt handler is used to confirm message transmission and count the number
of messages that have been sent.

This example sets up the CAN controller in External Loopback test mode. Data transmitted is visible on the
CANTXA pin and is received internally back to the CAN Core. Please refer to details of the External Loopback
Test Mode in the CAN Chapter in the Technical Reference Manual. Refer to [Programming Examples and Debug
Strategies for the DCAN Module](www.ti.com/lit/'SPRACEDS) for useful information about this example

External Connections
= None.
Watch Variables

m txMsgCount - A counter for the number of messages sent

m rxMsgCount - A counter for the number of messages received
m txMsgData - An array with the data being sent

m rxMsgData - An array with the data that was received

m errorFlag - A flag that indicates an error has occurred

CAN External Loopback with DMA

This example sets up the CAN module to transmit and receive messages on the CAN bus. The CAN module
is set to transmit a 4 byte message internally. An interrupt is used to assert the DMA request line which then
triggers the DMA to transfer the received data from the CAN interface register to the receive buffer array. A data
check is performed once the transfer is complete.

This example sets up the CAN controller in External Loopback test mode. Data transmitted is visible on the
CANTXA pin and is received internally back to the CAN Core. Please refer to details of the External Loopback
Test Mode in the CAN Chapter in the Technical Reference Manual. Please refer to the appnote Programming
Examples and Debug Strategies for the DCAN Module (www.ti.com/lit/SPRACES) for useful information about
this example

External Connections
= None.
Watch Variables

m txMsgCount - A counter for the number of messages sent

m rxMsgCount - A counter for the number of messages received
m txMsgData - An array with the data being sent

m rxMsgData - An array with the data that was received
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CAN Transmit and Receive Configurations

This example shows the basic setup of CAN in order to transmit or receive messages on the CAN bus with a
specific Message ID. The CAN Controller is configured according to the selection of the define.

When the TRANSMIT define is selected, the CAN Controller acts as a Transmitter and sends data to the second
CAN Controller connected externally.If TRANMSIT is not defined the CAN Controller acts as a Receiver and
waits for message to be transmitted by the External CAN Controller. Refer to [Programming Examples and
Debug Strategies for the DCAN Module](www.ti.com/lit/'SPRACES) for useful information about this example

Note:
CAN modules on the device need to be connected to via CAN transceivers.

Hardware Required
m A C2000 board with CAN transceiver.
External Connections

m ControlCARD CANA is on DEVICE_GPIO_PIN_CANTXA (CANTXA)
m and DEVICE_GPIO_PIN_CANRXA (CANRXA)

Watch Variables Transmit

m MSGCOUNT - Adjust to set the number of messages

m txMsgCount - A counter for the number of messages sent
m txMsgData - An array with the data being sent

m errorFlag - A flag that indicates an error has occurred

m rxMsgCount - Has the initial value as No. of Messages to be received and decrements with
each message.

CAN Error Generation Example

This example demonstrates the ways of handling CAN Error conditions It generates the CAN Packets and sends
them over GPIO It is looped back externally to be received in CAN module The CAN Interrupt service routine
reads the Error status and demonstrates how different Error conditions can be detected

Change ERR_CFG define to the different Error Scenarios and run the example. The corresponding Error Flag
will be set in status variable of canalSR() routine. Uses a CPU Timer(Timer 0) for periodic timer interrupt
of CANBITRATE uSec On the Timer interrupt it sends the required CAN Frame type with the specified error
conditions

Note:
CAN modules on the device need to be connected to via CAN transceivers.

Please refer to the application note titled "Configurable Error Generator for Controller Area Network" at
[Configurable Error Generator for Controller Area Network](https://www.ti.com/lit/pdf/spracq3) for further details
on this example

External Connections
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m ControlCARD GPIOTX_PIN should be connected to
m DEVICE_GPIO_PIN_CANRXA(CANRXA)

Watch Variables Transmit

m status - variable in canalSR for checking error Status

CAN Remote Request Loopback

This example shows the basic setup of CAN in order to transmit a remote frame and get a response for the
remote frame and store it in a receive Object. The CAN peripheral is configured to transmit remote request
frame and a remote answer frame messages with a specific CAN ID. Message object 3 is configured to transmit
a remote request. Message object 2 is configured as a remote answer object with filter mask such that it
accepts remote frame with any message ID and transmit’s remote answer with message ID 7 and data length 8.
Message object 1 is configured as a received object with filter message ID 7 so as to store the remote answer
data transmitted by message object 2.

This example sets up the CAN controller in External Loopback test mode. Data transmitted is visible on the
CANTXA pin and is received internally back to the CAN Core. Please refer to details of the External Loopback
Test Mode in the CAN Chapter in the Technical Reference Manual.

External Connections
= None.
Watch Variables

m txMsgData - An array with the data being sent
m rxMsgData - An array with the data that was received

CAN example that illustrates the usage of Mask registers

This example initializes CAN module A for Reception. When a frame with a matching filter criterion is received,
the data will be copied in mailbox 1 and LED will be toggled a few times and the code gets ready for the next
frame. If a message of any other MSGID is received, an ACK will be provided Completion of reception is
determined by polling CAN_NDAT_21 register. No interrupts are used. Refer to [Programming Examples and
Debug Strategies for the DCAN Module](www.ti.com/lit/'SPRACEDS) for useful information about this example

Hardware Required
m An external CAN node that transmits to CAN-A on the C2000 MCU
Watch Variables

m rxMsgCount - A counter for the number of messages received
m rxMsgData - An array with the data that was received
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CLA arcsine(z) using a lookup table (cla_asin_cpu01)

In this example, Task 1 of the CLA will calculate the arcsine of an input argument in the range (-1.0 to 1.0) using
a lookup table.

Note that since this example does not use background CLA task, the compile flag cla_background_task is
turned off for this project. Set this flag as on to enable background CLA task. The option is available in Project
Properties -> C2000 Build -> C2000 Compiler -> Advanced Options -> Runtime Model Options.

Memory Allocation

m CLA1 Math Tables (RAMLSO0)
» CLAasinTable - Lookup table
m CLA1 to CPU Message RAM
» fResult - Result of the lookup algorithm
m CPU to CLA1 Message RAM
« fVal - Sample input to the lookup algorithm

Watch Variables

m fVal - Argument to task 1
m fResult - Result of arcsin(fVal)

CLA arcsine(z) using a lookup table (cla_asin_cpu01)

In this example, Task 1 of the CLA will calculate the arcsine of an input argument in the range (-1.0 to 1.0) using
a lookup table.

Note that since this example does not use background CLA task, the compile flag cla_background_task is
turned off for this project. Set this flag as on to enable background CLA task. The option is available in Project
Properties -> C2000 Build -> C2000 Compiler -> Advanced Options -> Runtime Model Options.

Memory Allocation

m CLA1 Math Tables (RAMLS1)
» CLAasinTable - Lookup table
m CLA1 to CPU Message RAM
» fResult - Result of the lookup algorithm
m CPU to CLA1 Message RAM
« fVal - Sample input to the lookup algorithm

Watch Variables

m fVal - Argument to task 1
m fResult - Result of arcsin(fVal)
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CLA arctangent(z) using a lookup table (cla_atan_cpu01)

In this example, Task 1 of the CLA will calculate the arctangent of an input argument using a lookup table.

Note that since this example does not use background CLA task, the compile flag cla_background_task is
turned off for this project. Set this flag as on to enable background CLA task. The option is available in Project
Properties -> C2000 Build -> C2000 Compiler -> Advanced Options -> Runtime Model Options.

Memory Allocation

m CLA1 Math Tables (RAMLS1)

» CLAatan2Table - Lookup table
m CLA1 to CPU Message RAM

» fResult - Result of the lookup algorithm
m CPU to CLA1 Message RAM

» fNum - Numerator of sample input
» fDen - Denominator of sample input

Watch Variables

m fVal - Argument to task 1
m fResult - Result of arctan(fVal)

CLA background nesting task

This example configures CLA task 1 to be triggered by EPWM1 running at 2 Hz (period = 0.5s). A background
task is configured to be triggered by CPU timer running at .5 Hz (period = 2s). CLA task 1 toggles LED1 at the
start and end of the task and the background task toggles LED2 at the start and end of the task. Background
task will be preempted by Task1 and hence LED1 will be toggling even while LED2 is ON.

Note that the compile flag cla_background_task is turned on in this project. Enabling background task adds
additional context save/restore cycles during task switching thus increasing the overall trigger-to-task latency.
If the application does not use the background CLA task, it is recommended to turn this flag off for better
performance. The option is available in Project Properties -> C2000 Build -> C2000 Compiler -> Advanced
Options -> Runtime Model Options.

External Connections
= None
Watch Variables
= None

HHHHH A R
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Controlling PWM output using CLA

This example showcases how to update PWM signal output using CLA. EPWM1 is configured to generate
complementary signals on both of its channels of fixed frequency 100 KHz. EPWM4 is configured to trigger a
periodic CLA control task of frequency 10 KHz. The CLA task implements a very simple logic to vary the duty
of the EPWM1 outputs by increasing it by 0.1 in every iteration and maintaining it in the range of 0.1-0.9. For
actual use-cases, the control logic could be modified to much more complex depending upon the application.
The other CLA task (CLA task 8) is triggered by software at beginning to initialize the CLA global variables

External Connections

m Observe GPIO0 (EPWM1A) on oscilloscope
m Observe GPIO1 (EPWM1B) on oscilloscope

Watch Variables

m duty

Just-in-time ADC sampling with CLA

This example showcases how to utilize early-interrupt feature of ADC in combination with the low interrupt
response of CLA to enable faster system response and achieve high frequency control loops. EPWM1 is
configured to generate a PWM output signal of frequency 1 MHz and this is also used to trigger the ADC
sampling at each cycle. ADCA is configured to sample the input on Channel 0 and to generate the early
interrupt at the end of S/H + offset cycles. This interrupt is used to trigger the CLA control task. The CLA task
implements the control logic to update the duty of the PWM output based on reading the ADC sample data
just-in-time i.e. as soon as the ADC results gets latched.The early interrupt feature and low interrupt latency of
CLA allows to do some pre-processing as well before reading the ADC data and still completes updating the
PWM output before the next interrupts comes in i.e. data read and PWM update is done within a 1 MHz cycle.
For illustration purposes, 3-point moving average filter is used to simulate some processing and few steps of
the filtering code are done before reading the ADC result which we consider as pre-processing code. The ADC
interrupt offset is programmed based on the cycles consumed by the pre-processing code.

The calculation for interrupt offset value is as follows :- -ADC acquisition cycles programmed = 10 SYSCLKS
-Conversion time for 12-bit data = 10.5 ADCCLKS = N = 42 SYSCLKS -CLA task trigger to first instruction in
Fetch delay = 4 -Let the interrupt offset value be 'x’ -The code inside CLA control task before ADC read takes
below cycles : Setting up profiling gpio : 3 cycles Pre-processing : 13 cycles Total = 3 + 13 = 16 cycles

As described in device TRM, in order to read just-in-time the total delay before reading ADC should be (N-2)
cycles=40ie. : x+4+16=40:x=20

NOTE :- The optimization is off for this project and the cycles quoted above corresponds to that case.

GPIO2 is used for profiling purposes. GPIO2 is set at the beginning of CLA task 1 and is reset at the end of the
task. Thus ON time of GPIO2 indicates the CLA activity. In order to validate the example functionality , observe
the GPIO0 (PWM output) and GPIO2 (profiling GPIO) on CRO. The cycles difference between the rising edge

of the GPIO0 and GPIO2 indicate the total delay from the time of ADC trigger to setting up of profiling GPIO
inside CLA task which should be around 44 cycles (220 ns) based on the above calculation.

External Connections

m Provide constant DC input on ADCAO for quick validation. GND -> Should observe PWM
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output duty = 0.1 3.3V -> Should observe PWM output duty = 0.9 Can also provide analog
input in range 0 - 3.3V upto fs / 10 = 100 KHz for observing continuous duty variations

m Observe GPIOO0 on oscilloscope
m Observe GPIO2 on oscilloscope

Watch Variables

® None

Optimal offloading of control algorithms to CLA

This example showcases how to optimally offload the control algorithms from CPU to CLA in order to meet the
system requirements. In this example, two control loops are simulated, the faster one (loop1) running at 200
KHz and the slower one (loop2) running at 20 KHz. Loop1 senses the first parameter at ADCA Channel 0,
runs the Pl controller to achieve the target and contributes to the duty of EPWM1A output with 80% weightage.
Loop2 senses the second parameter at ADCB Channel 2, runs the Pl controller and contributes to the duty of
EPWM1A output with 20% weightage. It is important to note that since these are just software simulated control
loops but there is no actual physical process involved and hence updating the duty is not going to have any affect
on sampled inputs. ADCA is configured to oversample the first parameter using SOCs 0-3 to suppress the noise
and similarly ADCB is used to oversample the second parameter. EPWM4 and EPWMS5 are configured to trigger
the ADCA and ADCB sampling at loop1 and loop2 frequencies respectively. Once the conversion of all 4 SOCs
complete, a CPU ISR or a CLA task is triggered based on the user-configuration. There is also a background
task running in the main loop which disables the entire system including PWM output and the control loops
when "system_OFF" is set to 1. The system gets enabled again once "system_OFF" is restored back to 0. By
default system_OFF is set to 0 but it's value can be updated dynamically by adding it to expression window and
writing to it. DCL library is included in the project to make use of optimal PI controllers used in both the loops.
User-configurable pre-defined symbol "run_loop1_cla" has been added to the project options in order to specify
whether to run the loop1 on C28x or CLA. GPIO2 and GPIO3 are used to profile the execution of loop1 and
loop2.

For run_loop1_cla == 0 i.e. both loops running on CPU

-> Loop1 Utilization = ~77.5% (measured using profiling GPIO2) -> Loop2 Utilization = ~6% (measured using
profiling GPIO3) -> Background task in a while loop -> Total CPU utilization is greater than Utilization bound
(UB) Hence the system is hon-schedulable, lower priority task (Loop2) execution never completes (no toggling
observed on GPIO3) and also background task never gets chance to execute

For run_loop1_cla == 1 i.e. high frequency control loop (loop1) is offloaded to CLA while loop2 runs on CPU

-> Loop1 Utilization (CLA) = ~73% -> Loop2 Utilization (CPU)= ~6% -> Total CPU utilization has come down
to just ~6% Hence the system is perfectly schedulable, no miss happens for any of the loops and offloading of
loop1 to CLA saves CPU bandwidth to execute background tasks as well

For quick inspection of the example functionality, constant DC HIGH/LOW inputs can be provided to the analog
channels instead of varying analog voltages. The target value for both the loops are set as some intermediate
value i.e. 3500 corresponds to ~2.8V. Now since the sensed inputs are constant and not same as target so the
controller outputs will get saturated soon to either 1 or 0. Thus the "duty" variable can take only fixed values
based on the equations used in the loops. Infact the duty output would be very intutive, for instance if both inputs
are LOW(GND), the controller will try to produce the maximum duty as the target is higher than sensed value
hence the duty should be 1.0(0.2 + 0.8) but will get saturated to 0.9(the maximum value defined). Similarly if
both inputs are made HIGH, the duty will be 0.1 (the minimum saturation value defined). The final duty table is
shown below :
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External Connections

m Observe GPIO2 (Loop1 Profiling) on oscilloscope
m Observe GPIO3 (Loop2 Profiling) on oscilloscope
m Observe GPIO0 (EPWM1A Output) on oscilloscope

m Provide constant HIGH(3.3V)/LOW(0V) on both ADCA Ch0O and ADCB Ch2 for quick valida-
tion, the following duty value should be observable at EPWM1A for various combinations if the
system is perfectly schedulable i.e. both loops gets chance to execute properly :-

A0 B2 duty GND GND 0.9 3.3V GND 0.2 GND 3.3V 0.8 3.3V 3.3V 0.1

Note :- The optimization is OFF for this project and all the profiling data quoted above corresponds to this case.

Handling shared resources across C28x and CLA

This example showcases how to handle shared resource challenges across C28x and CLA. As the peripherals
are shared between CLA and the CPU, overlapping read-modify-write to the registers by them can lead to data
race conditions ultimately leading to data violation or incorrect functionality. In this example, CPU ISR and CLA
tasks runs independently. CPU ISR gets triggered by EPWM4 and toggles the EPWM1B output via software by
controlling CSFB bits of AQCSFRC. CLA task gets triggered by EPWM5 and toggles the EPWM1A output via
software by controlling CSFA bits of AQCSFRC. Thus in this process both CPU and CLA do read-modify -write
to AQCSFRC register independently at different frequencies so there is chance of race condition and updates
due to one of them can get lost/. overwritten. This can be clearly observed by updating "phase_shift ON" to 0U
and probing the EPWM1A and 1B outputs on a scope.

This is a standard critical section problem and can be handled by software handshaking mechanism like mu-
tex etc. But most of the real-time control applications are time-sensitive and cannot afford addition software
overhead hence this example suggests an alternative hardware based technique to avoid shared resource con-
flicts between CPU and CLA. The phase shifting mechanism of the EPWM modules is utilized to schedule the
CLA task and CPU ISR as desired. EPWM4 generates a synchronous pulse every ZERO event and provides
a phase shift of 20 cycles to EPWM5. This way both CLA task and C28x ISR runs at original frequencies
i.e. T00KHz and 10KHz but CLA task leads with a phase offset of 20 cycles wrt CPU ISR. Hence concurrent
read-modify-writes to AQCSFRC never happens and the EPWM1A and EPWM1B outputs behave as desired
i.e. consistent 50 KHz PWM output on EPWM1A and 5 KHz PWM output on EPWM1B with a duty ~50% on
both should be generated. In order to utilize this phase shifting mechanism in this example, please make sure
"phase_shift_ ON" is set to 1.

External Connections

m Observe GPIO0 (EPWM1A Output) on oscilloscope
m Observe GPIO1 (EPWM1B Output) on oscilloscope
m Observe GPIO2 (CLA Task Profiling) on oscilloscope
m Observe GPIO3 (CPU ISR Profiling) on oscilloscope

Note :- The phase offset value can easily be configured by updating TBPHS register to schedule the CLA task
and C28x ISR as desired depending upon the application need so as to avoid overlapping register writes by
CPU and CLA

Note :- The optimization is on and set to O2 for the project and all the results quoted correspond to this case.
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CLB Timer Two States

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example, the timer is setup the same as the previous example. The difference is the use of the FSM
submodule to toggle the output of the CLB which is then exported to a GPIO. The FSM module acts as a single
bit memory block. Interrupts are setup in the same format as the previous example. The interrupt delay of the
CLB can be seen by comparing the output of the CLB and the GPIO toggled in the ISR.

CLB Interrupt Tag

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example, a timer is setup with two different match values. These two events are used by the HLC
submodule to generate interrupts. The interrupt TAG is used to differentiate between the interrupt generated
due to the match1 event of the CLB counter and the match2 event of the CLB counter.

CLB Output Intersect

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example, the CLB module is set up the same as the external_AND_gate example. However, instead of
the output being exported to the GPIO using Output X-BAR, the output is exported to the GPIO by replacing
the output of ePWM1. This is done by configuring the GPIO for EPWM1A output, followed by enabling output
intersection.

CLB PUSH PULL

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example, the use of the PUSH-PULL interface is shown. Multiple COUNTER submodules, HLC submod-
ule, FSM submodules, and OUTLUT submodules are used. The PUSH-PULL interface is used alongside the

CLB Multi Tile

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the output of a CLB TILE is passed to the input of another CLB TILE. The output of the second
CLB TILE is then exported to a GPIO, showcasing how two CLB TILEs can be used in series.
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CLB Tile to Tile Delay

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the output of a GPIO is taken into the CLB TILE through INPUT XBAR and the CLB XBAR. The
signal is forwarded by the TILE to the next TILE. This time the signal only goes through the CLB XBAR and NOT
the Input XBAR. This is done to show that delays are added when the signals are passed from TILE to TILE
and the delay is NOT characterized. The user should always avoid passing signals with timing requirements
between tiles. The COUNTER modules inside the CLBs will count the amount of delay in cycles.

CLB Glue Logic

For the detailed description of this example, please refer to : ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the user is walked through how to migrate custom logic from an FPGA/CPLD to C2000A¢ADAG
microcontrollers.

CLB based One-shot PWM

For the detailed description of this example, please refer to : ‘C2000Ware_PATH Tool Users Guide.pdf’

CLB AOC Control

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the Asynchronous Output Conditioning block is used to asynchronously AND gate the input
signals to the CLB. This module is only available for CLB types 2 and up.

CLB AOC Release Control

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the Asynchronous Output Conditioning block is used to asynchronously set/release the input
signals to the CLB. This module is only available for CLB types 2 and up.

CLB Combinational Logic

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

The objective of this example is to prevent simultaneous high or low outputs on a PWM pair. PWM modules 1
and 2 are configured to generate identical waveforms based on a fixed frequency up-count mode.
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CLB XBARs

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the CLB INPUTXBAR and CLB OUTPUTXBAR are used to take input signals from GPIOs into
the CLB TILEs and take output signal from the TILE to GPIOs. The availability of these XBARs are device
dependent.

CLB AOC Control

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the clock prescalar of the CLB module is used to divide down the CLB clock and use it as an
input to the TILE logic. Also the HLC module is used to generate NMI interrupts. This module is only available
for CLB types 2 and up.

CLB Serializer

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the CLB COUNTER is used in serializer mode to act as a shift register. This module is only
available for CLB types 2 and up.

CLB LFSR

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the CLB COUNTER module is used in Linear Feedback Shift Register (LFSR) mode. This
module is only available for CLB types 2 and up.

CLB Lock Output Mask

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the lock outpt mask feature of the CLB is used to lock the selected output signal override
settings. This module is only available for CLB types 3 and up.

CLB INPUT Pipeline Mode

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the CLB Input Pipeline mode is enable to delay the input signal by a clock cycle. This module is
only available for CLB types 3 and up.
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CLB Clocking and PIPELINE Mode

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the CLB pipeline mode is enable and affects the behavior of the CLB COUNTERs and HLC.
This module is only available for CLB types 3 and up.

CLB SPI Data Export

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the high speed data export feature of the CLB is used and one of the HLC registers is exported
out of the CLB module using the SPI RX buffer. This module is only available for CLB types 3 and up.

CLB SPI Data Export DMA

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example the high speed data export feature of the CLB is used and one of the HLC registers is exported
out of the CLB module using the SPI RX buffer. The data received in the SPI RX buffer is transferred to memory
using DMA. This module is only available for CLB types 3 and up.

CLB Trip Zone Timestamp

This example displays how to timestamp interrupts generated by the CLB. An interrupt is generated when
ePWMT1 is tripped.

ePWMT1 is configured to be interrupted by TZ1 and TZ2, both one shot trip sources.

The CLB is configured as follows:

m COUNTERO and COUNTERT1 continually count when the program begins.

m COUNTERQO timestamps TZ1 and COUNTERT1 timestamps TZ2.

m COUNTER2 increments once when COUNTERO/COUNTER1 overflows using LUT2.

FSMO0/1 are configured to sync counters and stop COUNTERO/1 when an interrupt is received.
TZ1 (GP1O12) and TZ2 (GPIO13) are routed as inputs through CLBXBAR.

BOUNDARY.boundarylnputO denotes TZ1. On rising edge, HLC issues an interrupt with tag
12.

BOUDNARY.in1 denotes TZ2. On rising edge, HLC issues an interrupt with tag 13.

BOUNDARY.boundarylnput7 serves as a simultaneous enable for COUNTERO/1 to begin
counting.

TZ1 is tripped when GPIO12 is connected to GND. TZ2 is tripped when GPIO13 is connected to GND. When
an interrupt occurs, the interrupt handler determines the initial trip source and stores this value in a variable
initialTripZone’.
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View these variables in Debug Expressions tab:

initial TripZone: stores the first TZ to have been tripped tz1Counter64bit: stores the counter value at the instant
that TZ1 is tripped. tz2Counter64bit: stores the counter value at the instant that TZ2 is tripped.

CLB GPIO Input Filter

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

This example demonstrates use of finite state machines (FSMs) and counters to implement a simple

A Az

wanted short duration pulses.

CLB CRC

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example, the CLB module is used to perform the cyclic redundancy check (C.R.C.) with twelve messages
in bits checked with ten different CRC polynomials.

First element passed in is message length, second is the message stored in input_data
This example is only available for CLB types 2 and up.

The known values in the output_data are compared with expected values from the CLB-based CRC calculation.
A total of 120 messages are verified, and the number of matching messages are displayed in passCount

Variables to add to Watch Expressions in debug view: passCount - number of messages that match between
generated and known CRC values failCount - number of messages that fail the CRC value verification

HHBHA R

CLB TDM Serial Port

For the detailed description of this example, please refer to: How to Implement Custom Serial Interfaces Using
the Configurable Logic Block (CLB) Application Note (SPRADG2).

In this example a single CLB tile is used to input a TDM stream and generate a TDM output stream. The CLB
generates a CPU interrupt when four 32-bit words are received. The CPU can load four 32-bit values to the
CLB FIFO for transmission. The CLB and CPU are configured to run at their maximum speed.

This example is only available on C2000 MCU devices with CLB types 2 and up.

External Connections

TDM Input Signal GPIO pin FSYNC_IN GPIO00 BCLK_IN GPIO01 DATA1_IN GPIO02

TDM Output Signal GPIO pin FSYNC_OUT GPI0O04 BCLK_OUT GPIO05 DATA1_OUT GPIO06
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CLB LED Drivert

For the detailed description of this example, please refer to: How to Implement Custom Serial Interfaces Using
the Configurable Logic Block (CLB) Application Note (SPRAD62).

In this example two CLB tiles are used to communicate with an LP5891-Q1 LED driver. One CCSI bus is used
to transmit data using the CCSI bus protocol, while a second tile is used to receive data from the CCSI bus. The
C28x CPU communicates with the CLB logic through a hardware-abstraction layer (HAL). This example also
utilizes a PWM to generate the required CCSI clocks, and a timer to generate periodic sync events to the LED
driver.

This example is only available on C2000 MCU devices with CLB types 2 and up.

External Connections

CLB Auxilary PWM

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

This example configures a CLB tile as an auxiliary PWM generator. The example uses combinatorial logic
(LUTs), state machines (FSMs), counters, and the high level controller (HLC) to demonstrate the PWM output
generation capabilities using CLB.

CLB PWM Protection

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

This example extends the features of example 1 to ensure an active high complementary pair PWM configu-
ration always operates with a minimum value of dead-band irrespective of how the generating PWM module is
configured. The example illustrates the configuration of four separate PWM tiles to implement PWM protection
on four PWM modules. The outputs of PWM modules 1 to 4 are operated on by CLB tiles 1 to 4, respectively.

CLB Event Window

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

This example uses the counter, FSM, and HLC sub-modules of the CLB to implement an event timing feature
which detects whether an interrupt service routine takes too long to respond to an interrupt. The example
configures four PWM modules to operate in up-count mode and generate a low-to-high edge on a timer zero
match event. The zero match event also triggers a PWM ISR which, for the purposes of this example, contains
a dummy payload of variable length. At the end of the ISR, a write operation takes place to a CLB GP register
to indicate the ISR has ended.

CLB Signal Generator

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’
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This example uses CLB1 to generate a rectangular wave and CLB2 to check the rectangular wave generated

A oAz

CLB State Machine

For the detailed description of this example, please refer to: C2000Ware_PATH With the C2000 CLB.pdf This
application report describes the process of creating this CLB example and can be used as guidance on desiging
custom logic with the CLB. This example uses all submodules inside a CLB TILE in order to implement a
complete system.

CLB External Signal AND Gate

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example, two external signals from two GPIOs are passed through the Input X-BAR and the CLB X-BAR
to the CLB TILE. Inside the CLB module these two signals are ANDED. The output of the AND gate is then
exported to a GPIO, using Output X-BAR.

CLB Timer

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

In this example, a COUNTER module is used to create timed events. The use of the GP Register is shown.
Through setting/clearing the bits in the GP register, the timer is started, stopped or changes direction. The
output of the timer event (1-clock cycle) is exported to a GPIO. Interrupts are generated from the timer event
using the HLC module. A GPIO is also toggled inside the CLB ISR. The indirect CLB register access is used

timer.

CLB Empty Project

For the detailed description of this example, please refer to: ‘C2000Ware_PATH Tool Users Guide.pdf’

CMPSS Asynchronous Trip

This example enables the CMPSS1 COMPH comparator and feeds the asynchronous CTRIPOUTH signal to
the GP1IO14/OUTPUTXBARS pin and CTRIPH to GPIO15/EPWMS8B.

CMPSS is configured to generate trip signals to trip the EPWM signals. CMPIN1P is used to give positive input
and internal DAC is configured to provide the negative input. Internal DAC is configured to provide a signal at
VDD/2. An EPWM signal is generated at GPIO15 and is configured to be tripped by CTRIPOUTH.

When a low input(VSS) is provided to CMPIN1P,
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m Trip signal(GP1014) output is low
m PWMB8B(GPIO15) gives a PWM signal

When a high input(higher than VDD/2) is provided to CMPIN1P,

m Trip signal(GP1014) output turns high
m PWMB8B(GPIO15) gets tripped and outputs as high

External Connections

m Give input on CMPIN1P (HSEC Pin 15)
m Qutputs can be observed on GPIO14 and GPIO15 using an oscilloscope

Watch Variables

m None

CMPSS Digital Filter Configuration

This example enables the CMPSS1 COMPH comparator and feeds the output through the digital filter to the
GPIO14/OUTPUTXBARS pin.

CMPIN1P is used to give positive input and internal DAC is configured to provide the negative input. Internal
DAC is configured to provide a signal at VDD/2.

When a low input(VSS) is provided to CMPIN1P,
m GPIO14 output is low
When a high input(higher than VDD/2) is provided to CMPIN1P,

m GPIO14 output turns high

CPU Register Access

This example demonstrates functions which can be used to access CPU register contents using C-Callable
assembly APIs .

Buffered DAC Enable

This example generates a voltage on the buffered DAC output, DACOUTA/ADCINAO and uses the default DAC
reference setting of VDAC.

External Connections

m When the DAC reference is set to VDAC, an external reference voltage must be applied to the
VDAC pin. This can be accomplished by connecting a jumper wire from 3.3V to ADCINBO.

86 Tue Oct 29 00:46:52 IST 2024



6.83

6.84

C28x Driver Library Example Applications

Watch Variables

= None.

Buffered DAC Random

This example generates random voltages on the buffered DAC output, DACOUTA/ADCINAO and uses the de-
fault DAC reference setting of VDAC.

External Connections

m When the DAC reference is set to VDAC, an external reference voltage must be applied to the
VDAC pin. This can accomplished by connecting a jumper wire from 3.3V to ADCINBO.

Watch Variables

= None.

Buffered DAC Sine (buffdac_sine)

This example generates a sine wave on the buffered DAC output, DACOUTA/ADCINAO (HSEC Pin 9) and uses
the default DAC reference setting of VDAC.

When the DAC reference is set to VDAC, an external reference voltage must be applied to the VDAC pin. This
can accomplished by connecting a jumper wire from 3.3V to ADCINBO.

Run the included .js file to add the watch variables. This example uses the SGEN module. Documentation for
the SGEN module can be found in the SGEN library directory.

The generated waveform can be adjusted with the following variables while running:

m waveformGain : Adjust the magnitude of the waveform. Range is from 0.0 to 1.0. The default
value of 0.8003 centers the waveform within the linear range of the DAC

m waveformOffset : Adjust the offset of the waveform. Range is from -1.0 to 1.0. The default
value of 0 centers the waveform

m outputFreq_hz : Adjust the output frequency of the waveform. Range is from 0 to maxOut-
putFreq_hz

= maxOutputFreq_hz : Adjust the max output frequency of the waveform. Range - See SGEN
module documentation for how this affects other parameters

The generated waveform can be adjusted with the following variables/macros but require recompile:

m samplingFreq_hz : Adjust the rate at which the DAC is updated. Range - See SGEN module
documentation for how this affects other parameters

m SINEWAVE_TYPE : The type of sine generated. Range - LOW_THD_SINE,
HIGH_PRECISION_SINE

The following variables give additional information about the generated waveform: See SGEN module docu-
mentation for details
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m freqResolution_hz

maxOutput_Isb : Maximum value written to the DAC.
minOutput_Isb : Minimum value written to the DAC.
pk_to_pk_lIsb : Magnitude of generated waveform.
cpuPeriod_us : Period of cpu.

samplingPeriod_us : The rate at which the DAC is updated. Note that samplingPeriod_us
has to be greater than the DAC settling time.

interruptCycles : Interrupt duration in cycles.
interruptDuration_us : Interrupt duration in uS.
sgen : The SGEN module instance.

DatalLog : Circular log of writes to the DAC.

DCC Single shot Clock verification

This program uses the XTAL clock as a reference clock to verify the frequency of the PLLRAW clock.

The Dual-Clock Comparator Module 0 is used for the clock verification. The clocksource0 is the reference clock
(Fclk0 = 20Mhz) and the clocksource1 is the clock that needs to be verified (Fclk1 = 200Mhz). Seed is the value
that gets loaded into the Counter.

Please refer to the TRM for details on counter seed values to be set.

External Connections
m None
Watch Variables

m status/result - Status of the PLLRAW clock verification

DCC Single shot Clock measurement

This program demonstrates Single Shot measurement of the INTOSC2 clock post trim using XTAL as the
reference clock.

The Dual-Clock Comparator Module 0 is used for the clock measurement. The clocksourceO is the reference
clock (FclkO = 20Mhz) and the clocksource1 is the clock that needs to be measured (Fclk1 = 10Mhz). Since the
frequency of the clock1 needs to be measured an initial seed is set to the max value of the counter.

Please refer to the TRM for details on counter seed values to be set.

External Connections
m None
Watch Variables

m result - Status if the INTOSC2 clock measurement completed successfully.
m meas_freq1 - measured clock frequency, in this case for INTOSC2.
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DCC Continuous clock monitoring

This program demonstrates continuous monitoring of PLL Clock in the system using INTOSC2 as the reference
clock. This would trigger an interrupt on any error, causing the decrement/ reload of counters to stop.

The Dual-Clock Comparator Module 0 is used for the clock monitoring. The clocksourceO is the reference clock
(FclkO = 10Mhz) and the clocksource1 is the clock that needs to be monitored (Fclk1 = 200Mhz). The clock0
and clock1 seed are set to achieve a window of 500us. Seed is the value that gets loaded into the Counter. For
the sake of demo a slight variance is given to clock1 seed value to generate an error on continuous monitoring.

Please refer to the TRM for details on counter seed values to be set. Note : When running in flash configuration
it is good to do a reset & restart after loading the example to remove any stale flags/states.

External Connections
= None
Watch Variables

m status/result - Status of the PLLRAW clock monitoring
m cnt0 - Counter0 Value measure when error is generated
m cnt1 - Counter1 Value measure when error is generated
m valid - Valid0 Value measure when error is generated

DCC Continuous clock monitoring

This program demonstrates continuous monitoring of PLL Clock in the system using INTOSC2 as the reference
clock. This would trigger an interrupt on any error, causing the decrement/ reload of counters to stop. The
Dual-Clock Comparator Module 0 is used for the clock monitoring. The clocksourceO is the reference clock
(FclkO = 10Mhz) and the clocksource1 is the clock that needs to be monitored (Fclk1 = 200Mhz). The clock0
and clock1 seed are set automatically by the error tolerances defined in the sysconfig file included this project.
For the sake of demo an un-realistic tolerance is assumed to generate an error on continuous monitoring.

Please refer to the TRM for details on counter seed values to be set. Note : When running in flash configuration
it is good to do a reset & restart after loading the example to remove any stale flags/states.

External Connections
® None
Watch Variables

m status/result - Status of the PLLRAW clock monitoring
m cnt0 - Counter0 Value measure when error is generated
m cnt1 - Counter1 Value measure when error is generated
m valid - Valid0 Value measure when error is generated
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DCC Detection of clock failure

This program demonstrates clock failure detection on continuous monitoring of the PLL Clock in the system
using XTAL as the osc clock source. Once the oscillator clock fails, it would trigger a DCC error interrupt,
causing the decrement/ reload of counters to stop. In this examples, the clock failure is simulated by turning off
the XTAL oscillator. Once the ISR is serviced, the osc source is changed to INTOSC1 and the PLL is turned off.

The Dual-Clock Comparator Module 0 is used for the clock monitoring. The clocksource0 is the reference clock
(FclkO = 20Mhz) and the clocksource1 is the clock that needs to be monitored (Fclk1 = 200Mhz). Seed is the
value that gets loaded into the Counter.

Note:
In the current example, the XTAL is expected to be a Resonator running in Crystal mode which
is later switched off to simulate the clock failure. If an SE Crystal is used, you will need to
physically disconnect the clock on the board.

Please refer to the TRM for details on counter seed values to be set. Note : When running in flash configuration
it is good to do a reset & restart after loading the example to remove any stale flags/states.

External Connections
m None
Watch Variables

m status/result - Status of the clock failure detection

DCSM Memory partitioning Example

This example demonstrates how to configure and use DCSM. It configures the 1st Zone Select Block in the
OTP to change the zone passwords and allocates LS0-LS3 to zone 1 & LS4-LS7 to zone 2.

Zone1 | Zone2 | LSO-LS3 | LS4-LS7 |

In this example, zoning of memories is done by the OTP programming whose values are configured in
dcsm_ex1_f28p65x_dcsm_zxotp.asm while the securing functionalities are done through this file. It writes
some data in the zones and checks before locking and after locking and matches with the data set . Ideally after
locking zone1, the data set stored in zone1 should not be readable( or reads a 0 value) and zone2 that is not
secured matches the written data set. It demonstrates how to lock and and unlock zones by showing where to
put the password and how to check if it is secured or unsecured.

External Connections
= None.
Watch Variables

m result - Status of Secure memory partitioning done through OTP programming.

m set_error, error_not_locked ,error_not_unlocked ,error1 - Count of errors occurring during the
execution of the example.

m Zone1_Locked_Array - Array demonstrating secured memory
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m Unsecure_mem_Array - Array demonstrating Unsecured memory

Note:
Before running the example, the below configuration is expected to be done through the
desm_ex1_f28p65x_dcsm_zxotp.asm :

m Allocate LSO-LS3 to zone 1 , LS4-LS7 to zone 2 ZSBx_Z1_GRABRAM1R 0x000AAA55
ZSBx_Z2_GRABRAM1R 0x000A55AA

= Password of zone 1 is OxFFFFFFFF4D7FFFFFFFFFFFFFFFFFFFFF
= Password of zone 2 is 0xFFFFFFFF1F7FFFFFFFFFFFFFFFFFFFFF

Note:
DCSM_unlockZone«CSM function should not be called in an actual application, should only be
used for once to program the OTP memory. Ensure flash data cache is disabled before calling
this function.

6.91 Empty DCSM Tool Example

This example is an empty project setup for DCSM Tool and Driverlib development. For guidance refer to: [C2000
DCSM Security Tool](http://www.ti.com/lit/pdf/spracp8)

6.92 DMA GSRAM Transfer (dma_ex1_gsram_transfer)

This example uses one DMA channel to transfer data from a buffer in RAMGSO to a buffer in RAMGS1. The
example sets the DMA channel PERINTFRC bit repeatedly until the transfer of 16 bursts (where each burst is 8
16-bit words) has been completed. When the whole transfer is complete, it will trigger the DMA interrupt.

Note:
: This example project has support for migration across our C2000 device families. If you are
wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you're using. At any time you can select another device to migrate this example.

Watch Variables

m sData - Data to send
m rData - Received data

6.93 DMA GSRAM Transfer (dma_ex2_ gsram_transfer)

This example uses one DMA channel to transfer data from a buffer in RAMGSO0 to a buffer in RAMGS1. The
example sets the DMA channel PERINTFRC bit repeatedly until the transfer of 16 bursts (where each burst is 8
16-bit words) has been completed. When the whole transfer is complete, it will trigger the DMA interrupt.

Watch Variables

m sData - Data to send
m rData - Received data
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eCAP APWM Example

This program sets up the eCAP module in APWM mode. The PWM waveform will come out on GPIO5. The
frequency of PWM is configured to vary between 10Hz and 20Hz using the shadow registers to load the next
period/compare values.

eCAP Capture PWM Example

This example configures ePWMB3A for:

= Up count mode
m Period starts at 500 and goes up to 8000
m Toggle output on PRD

eCAP1 is configured to capture the time between rising and falling edge of the ePWM3A output.

External Connections

m eCAP1 is on GPIO16
m ePWMS3A is on GPIO4
m Connect GP1O4 to GPIO16.

Watch Variables

m ecap1PassCount - Successful captures.
m ecapiintCount - Interrupt counts.

eCAP APWM Phase-shift Example

This program sets up the eCAP1 and eCAP2 modules in APWM mode to generate the two phase-shifted PWM
outputs of same duty and frequency value The frequency, duty and phase values can be programmed of choice
by updating the defined macros. By default 10 Khz frequency, 50% duty and 30% phase shift values are used.
eCAP2 output leads the eCAP1 output by 30% GPIO5 and GPIO6 are used as eCAP1/2 outputs and can be
probed using analyzer/CRO to observe the waveforms.

eCAP Software Sync Example

This example configures ePWMB3A for:

m Up count mode
m Period starts at 500 and goes up to 8000
m Toggle output on PRD
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eCAP1, eCAP2 and eCAP3 are configured to capture the time between rising and falling edge of the ePWM3A
output.

External Connections

m eCAP1, eCAP2, eCAP3 are on GPIO16
m ePWMB3A is on GPIO4
m Connect GPIO4 to GPIO16.

Watch Variables

m ecapPassCount - Successful captures.
m ecap3intCount - Interrupt counts.

eCAP Signal Monitor Example

This example configures ePWM1A for:

m Up-down count mode

m Period value : 4000 (16000 sysclk)

m CMPA value : 2000 (8000 sysclk)

m The low-pulse width will be ~16000 sysclk

eCAP1 configuration:

m Absolute mode

m Continous mode (one-shot mode can be used but limited duration)
m 4 captures are enabled

m Low Pulse width monitoring : Rising to falling edge

This example generates an error event ERROR_EVT1 as the actual low-pulse width does not occur during the
expected window and trip the PWM signal. The monitor window can be changed by changing the monitor min
and max value.

Note: When ecapMonitorMin < 16000 and ecapMonitorMax > 16000, this example will not generate Error_Evt
When ecapMonitorMin, ecapMonitorMax > 16000 , Error_Evt1 will be generated When ecapMonitorMin, ecap-
MonitorMax < 16000 , Error_Evt2 will be generated

External Connections

m eCAP1 is on GPIO16
= ePWM1A is on GPIO0
m Connect GPIOO0 to GPIO16.

Watch Variables

m ecapMonitorMin - Min value for the signal monitoring window (ecapMonitorMin < 16000
sysclk)

m ecapMonitorMax - Max value for the signal monitoring window (ecapMonitorMax > 16000
sysclk)
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Pin setup for EMIF module accessing ASRAM.

This example configures pins for EMIF in ASYNC mode.
A

EMIF1 ASYNC module accessing 16bit ASRAM.

This example configures EMIF1 in 16bit ASYNC mode and uses CS2 as chip enable.

External Connections
m External ASRAM memory (CY7C1041CV33 -10ZSXA) daughter card
Watch Variables

m testStatusGlobal - Equivalent to TEST_PASS if test finished correctly, else the value is set to
TEST_FAIL

m errCountGlobal - Error counter

EMIF1 module accessing 16bit ASRAM as code memory.

This example configures EMIF1 in 16bit ASYNC mode and uses CS2 as chip enable. This example enables
use of ASRAM as code memory.

External Connections
m External ASRAM memory (CY7C1041CV33 -10ZSXA) daughter card
Watch Variables

m testStatusGlobal - Equivalent to TEST_PASS if test finished correctly, else the value is set to
TEST_FAIL

m errCountGlobal - Error counter

EMIF1 module accessing 16bit SDRAM using mem-
cpy_fast_far().

This example configures EMIF1 in 16bit SYNC mode and uses CS0 as chip enable.lt will first write to an array
in the SDRAM and then read it back using the FPU function, memcpy_fast_far(), for both operations.

The buffer in SDRAM will be placed in the .farbss memory on account of the fact that its assigned the attribute
"far" indicating it lies beyond the 22-bit program address space. The compiler will take care to avoid using
instructions such as PREAD, which uses the Program Read Bus, or addressing modes restricted to the lower
22-bit space when accessing data with the attribute "far".
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Note:
The memory space beyond 22-bits must be treated as data space for load/store operations
only. The user is cautioned against using this space for either instructions or working memory.

External Connections
m External SDR-SDRAM memory (MT48LC32M16A2 -75) daughter card
Watch Variables

m testStatusGlobal - Equivalent to TEST_PASS if test finished correctly, else the value is set to
TEST_FAIL

m errCountGlobal - Error counter

EMIF1 module accessing 16bit SDRAM then puts into Self
Refresh mode before entering Low Power Mode.

This example configures EMIF1 in 16bit SYNC mode and uses CSO0 as chip enable. This example puts SDRAM
into self refresh before entering standby mode. Watchdog timer is configured to trigger WAKEINT interrupt.

As soon as the watchdog timer expires, the device should wake up, SDRAM should come out of self refresh
mode and GPIO11 can be observed to toggle.

External Connections
m External SDR-SDRAM memory (MT48LC32M16A2 -75) daughter card
Watch Variables

m testStatusGlobal - Equivalent to TEST_PASS if test finished correctly, else the value is set to
TEST_FAIL

m errCountGlobal - Error counter

EMIF1 module accessing 32bit SDRAM using DMA.

This example configures EMIF1 in 16bit SYNC(SDRAM) mode and uses CSO0 as chip enable. It will first write
to an array in the SDRAM and then read it back, using the DMA for both operations.

The buffer in SDRAM will be placed in the .farbss memory on account of the fact that its assigned the attribute
"far" indicating it lies beyond the 22-bit program address space. The compiler will take care to avoid using
instructions such as PREAD, which uses the Program Read Bus, or addressing modes restricted to the lower
22-bit space when accessing data with the attribute "far".

Note:
The memory space beyond 22-bits must be treated as data space for load/store operations
only. The user is cautioned against using this space for either instructions or working memory.

External Connections
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m External SDR-SDRAM (Micron MT48LC32M16A2 "P -75 C") daughter card.
Watch Variables

m testStatusGlobal - Equivalent to TEST_PASS if test finished correctly, else the value is set to
TEST_FAIL

m errCountGlobal - Error counter

EMIF1 module accessing 16bit SDRAM using alternate ad-
dress mapping.

This example configures EMIF1 in 16bit SYNC mode and uses CS0 as chip enable.lt will first write to an array
in the SDRAM and then read it back.

The buffer in SDRAM will be placed in the emif_cs0_nonfar memory section which is dual mapped with CS2
memory range. This has been done to keep the SDRAM memory range within 22-bit address range in order to
generate optimal code. EMIF1 Async RAM accesses will not be issued at the same time and program space
reads & fetches will be allowed to SDRAM in non-far range.

External Connections
m External SDR-SDRAM memory (MT48LC32M16A2 -75) daughter card
Watch Variables

m testStatusGlobal - Equivalent to TEST_PASS if test finished correctly, else the value is set to
TEST_FAIL

m errCountGlobal - Error counter

Empty Project Example

This example is an empty project setup for Driverlib development.

EPG Generate Serial Data Shift Mode

This example generates SPICLK and SPI DATA signals using the SIGGEN module in SHIFT mode.
For more information on this example, visit: [Designing With the C2000 Embedded Pattern Generator
(EPG)](https://www.ti.com/lit/spracy7)

External Connections

m None. Signal is generated on GPIO 24, 3. Can be visualized through oscilloscope.
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EPG Generating Synchronous Clocks

This example shows how to generate 2 synchronous clocks with edges being offset by 2 clock cycles. It
configures Signal Generator to shift a periodic data. Generated Clock has period EPG CLOCK/6.

External Connections
m None. Signal is generated on GPIO 24, 3. Can be visualized through oscilloscope.
Watch Variables

m sigGenActiveData - Active Data of signal generator transform output

EPG Generating Two Offset Clocks

This example generates two offset clocks using the CLKGEN (CLKDIV) modules. For more information on this
example, visit: [Designing With the C2000 Embedded Pattern Generator (EPG)](https://www.ti.com/lit/spracy7)

External Connections

m None. Signal is generated on GPIO 24, 3. Can be visualized through oscilloscope.

EPG Generating Two Offset Clocks With SIGGEN

This example generates two offset clocks using the SIGGEN module. For more information on this example,
visit: [Designing With the C2000 Embedded Pattern Generator (EPG)](https://www.ti.com/lit/spracy7)

External Connections

m None. Signal is generated on GPIO 24, 3. Can be visualized through oscilloscope.

EPG Generate Serial Data

This example generates SPICLK and SPI DATA signals using the SIGGEN module. For more information on this
example, visit: [Designing With the C2000 Embedded Pattern Generator (EPG)](https://www.ti.com/lit/spracy7)

External Connections

m None. Signal is generated on GPIO 24, 3. Can be visualized through oscilloscope.

ePWM Chopper

This example configures ePWM1, ePWM2, ePWM3 and ePWM4 as follows

m ePWM1 with Chopper disabled (Reference)
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m ePWM2 with chopper enabled at 1/8 duty cycle
m ePWMB with chopper enabled at 6/8 duty cycle
m ePWM4 with chopper enabled at 1/2 duty cycle with One-Shot Pulse enabled

External Connections

m GPIO0 EPWM1A
= GPIO1 EPWM1B
m GPIO2 EPWM2A
= GPIO3 EPWM2B
m GPIO4 EPWM3A
m GPIO5 EPWM3B
m GPIO6 EPWM4A
m GPIO7 EPWM4B

Watch Variables

= None.

EPWM Configure Signal

This example configures ePWM1, ePWM2, ePWMS to produce signal of desired frequency and duty. It also
configures phase between the configured modules.

Signal of 10kHz with duty of 0.5 is configured on ePWMxA & ePWMxB with ePWMxB inverted. Also, phase of
120 degree is configured between ePWM1 to ePWMS3 signals.

During the test, monitor ePWM1, ePWM2, and/or ePWM3 outputs on an oscilloscope.

m ePWM1A is on GPIO0
m ePWM1B is on GPIO1
ePWM2A is on GPIO2
ePWMZ2B is on GPIO3
ePWMB3A is on GPIO4
ePWMB3B is on GPIO5

Realization of Monoshot mode

This example showcases how to generate monoshot PWM output based on external trigger i.e. generating just
a single pulse output on receipt of an external trigger. And the next pulse will be generated only when the next
trigger comes. The example utilizes external synchronization and T1 action qualifier event features to achieve
the desired output.

ePWM1 is used to generate the monoshot output and ePWM2 is used an external trigger for that. No external
connections are required as ePWMZ2A is fed as the trigger using Input X-BAR automatically.
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ePWMT1 is configured to generated a single pulse of 0.5us when received an external trigger. This is achieved
by enabling the phase synchronization feature and configuring EPWMxSYNCI as EXTSYNCIN1. And this
EPWMxSYNCI is also configured as T1 event of action qualifier to set output HIGH while "CTR = PRD" action
is used to set output LOW.

ePWMz2 is configured to generate a 100 KHz signal with a duty of 1% (to simulate a rising edge trigger) which
is routed to EXTSYNCIN1 using Input XBAR.

Observe GPIO0 (EPWM1A : Monoshot Output) and GPIO2(EPWM2 : External Trigger) on oscilloscope.

NOTE : In the following example, the ePWM timer is still running in a continuous mode rather than a one-shot
mode thus for more reliable implementation, refer to CLB based one shot PWM implementation demonstrated
in "clb_ex17_one_shot_pwm" example

EPWM Action Qualifier (epwm_up_aq)

This example configures ePWM1, ePWM2, ePWM3 to produce an waveform with independent modulation on
EPWMxA and EPWMxB.

The compare values CMPA and CMPB are modified within the ePWM'’s ISR.
The TB counter is in up count mode for this example.

View the EPWM1A/B(GPIO0 & GPIO1), EPWM2A/B(GPIO2 & GPIO3) and EPWMS3A/B(GPIO4 & GPIO5)
waveforms via an oscilloscope.

ePWM XCMP Mode

(Note - base frequency and duty cycle of all ePWM’s are 50 KHz and 50% respectively. Value of TBPRD =
1999) This example configures ePWM1, ePWM2, ePWM4, ePWM6 and ePWM8 as follows

m ePWM1A is allocated all XCMP1-8 registers. ePWM1B has no output.
* New duty cycle = 50%, new frequency = 200 KHz
» No Shadow registers used
m ePWM2A is allocated XCMP1-4 and ePWMZ2B is allocated XCMP5-8 registers.
» A and B waveforms are complimentary
* New duty cycle = 50%, new frequency = 100 KHz
* No Shadow registers used
m ePWM4 is configured same as ePWM2 with Minimum Deadband.
* Minimum Deadband of 200 SYSCLK cycles provided (200 x (1/200 MHz) = 1 micro sec-
ond)
* This implies dead band of 1 us is visible on output of ePWM4A and ePWM4B after their
falling edge
» New duty cycle = 40%, new frequency = 100 KHz
m ePWMBG6A is allocated XCMP1-4 registers.
» 3 Shadow register sets used with LOADMULTIPLE mode
» Shadow set 2 repeated 2 times, Shadow set 3 repeated 4 times
* ISR to update all Shadow registers with new values after they repeat
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+ This means Shadow3 is active for 5 periods, Shadow?2 is active for 3 periods and Shadow1
is active for 1 period before their new values are visible in output

m ePWMB8A is allocated XCMP1-4 registers.

» 3 Shadow register sets used with LOADONCE mode
* Only Shadow set 3 is loaded from every period
* ISR updates Shadow 3 register with new values every 5 periods

External Connections

m ePWM1A is on GPIO0

ePWM2A is on GP102 and ePWM2B is on GPIO3

ePWMA4A is on GPIO6 and ePWM4B is on GPIO7

ePWMB6A is on GPIO10

ePWMB8A is on GPIO14

Monitor GP1024 for ePWMB6A new Shadow register value loading
m Monitor GP1025 for ePWMB8A new Shadow register value loading

Shadow register updations for ePWM6 and ePWMS8:

m Only XCMP1 and XCMP4 are updated
m Update values are +/- 20 TBCTR steps depending on direction of updation

m GPIO24 is toggled every 9 cycles for ePWM6 after cycling through all Shadow buffers and
loading new values Similarly GP1025 is toggled every 5 cycles for ePWM8

6.117 ePWM Event Detection

(Note - base frequency and duty cycle of all ePWM’s are 50 KHz and 50% respectively. Value of TBPRD =
1999) This example configures ePWM1 and ePWM2 in identical fashion with XCMP1-8 allocated to channel A.
No shadow registers are used.
m XCMP1 = 250, XMP2 = 500, XCMP3 = 750 ..... XCMP 8 = 1750.
m [n ePWM1, XMIN = 300 and XMAX = 400.
 This window has no edge and generates a CAPEVT pulse every period.
m [n ePWM2, XMIN = 300 and XMAX = 600.
» This window has an edge and doesn’t generate CAPEVT pulse signal.

External Connections

m ePWM1A is on GPIO0

m ePWM2A is on GPIO2

ePWM1 Tripout is on GP1024
ePWM2 Tripout is on GP1025

LED1 is on GPIO31 (For control card)
LED2 is on GPIO34 (For control card)
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CAPIN and CAPGATE signals are both sourced as Trip4 for ePWM1 and Trip5 for ePWM2. Trip4 and Trip5
are routed from the INPUT X-BAR through EPWM-XBAR which feeds into the Digital Compare submodule.
CAPEVT signal is used as Tripout and Trip-Zone interrupt source.

For ePWM1, Trip-Zone ISR configured to make LED1 blink 1 second on/off. For ePWM2, Trip-Zone ISR config-
ured to make LED2 turn on if an interrupt ever occurs.

ePWM Diode Emulation

This example configures ePWM1, ePWM2 and ePWM4 as follows
m All ePWM’s are 50 KHz, 50% duty cycle Type 4 generated signals
Buffered DAC1 configuration used as positive input to CMPSS1 High and Low:

m Reference voltage source = internal ADC VREFHI = 2.5V
m Gain =1

CMPSS1 configuration for TRIPH/TRIPL signal inputs to enter DE mode:

m Positive input = DACA_OUT (from DAC1) for both CMPSS1 High, Low

m Negative input = 825 mV from internal DAC for CMPSS1 High 3.3V from internal DAC for
CMPSS1 Low

m This means only CMPSSTRIPH1 is triggered when DACA_OUT > 825 mV CMPSSTRIPL1 is
always low

Diode Emulation configuration:

m For all ePWMs, TripH = CMPSSTRIPH1 and TRIPL = CMPSSTRIPL1 Since a
TRIPH_OR_TRIPL triggers DE entry, only TripH is used for demo

m ePWM1A is set to active high and 1B set to low during DE

m ePWM2 is configured same as ePWM1 with a re-entry delay
* Re-entry delay = 250 EPWMSYNCPER cycles = 5 ms

m ePWM4 is configured same as ePWM1 with DE monitor

* Increment/ Decrement on EPWMSYNCPER = +1 when TRIPH_OR_TRIPL high -1 when
TRIPH_OR_TRIPL low
» Threshold value = 250 In this case, 5 ms after entering DE, DEMONTRIP is generated

External Connections

ePWM1A is on GPIO0 and ePWM1B is on GPIO1

ePWM2A is on GPIO2 and ePWM2B is on GPIO3

ePWM4A is on GPIO6 and ePWM4B is on GPIO7
CMPSS1_TRIPH is on GPIO25 and CMPSS1_TRIPL is on GPIO26
ePWM1_DEACTIVE is on GP1024

ePWM4_DEMONTRIP is on GPIO15

DAC1 output can be seen on P1 (ADC-AQ) pin

For DAC1, DACVALS -> DACVALA shadow to active load happening on SYSCLK and a 2 us delay is provided
after loading. Shadow to active load can be configured to load on EPWMSYNCPER for better control.
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ePWM Minimum Deadband and ICL

This example configures ePWM2, ePWM3, ePWM4 and ePWMS5 as follows (Note: ePWM2 and ePWM3 are
configured for demonstration purpose - i.e they are original ePWM4 and ePWMS5 signals respectively)

Minimum Deadband:

m ePWM2 is 50 KHz signal Type-4 signal with 55% duty cycle. TBPRD = 2000

+ There is an overlap of active high states in A and B between TBCNT = 900 and 1100
m ePWM4 applies a minimum deadband with 200 SYSCLK cycles delay (1 us).

» The new duty cycle changes to 40%.

lllegal Combo Logic:

m ePWM3 is 100 KHz signal Type-4 signal with 50% duty cycle. TBPRD = 1000.

m ePWMS5 applies ICL look up table (LUT) logic to perform AND operation between 5A & 4A and
5B & 4B.

External Connections

m ePWM2A is on GPIO2 and ePWM2B is on GPIO3
m ePWMB3A is on GPIO4 and ePWMS3B is on GPIO5
m ePWM4A is on GPIO6 and ePWM4B is on GPIO7
m ePWM5A is on GPIO8 and ePWMS5B is on GPIO9

For LUT1, ePWM4A is input from ICL X-BAR For LUT2, ePWM4B is input from ICL X-BAR ICL LUT and
associated decision qualifiers can be visualized in the following truth table:

LUT1: | ePWM4A | ePWMS5A | ePWM5B | ePWMSA | <— 5A
|0UtpUt\‘| I‘ IO IO IXTOT oI X O[T olx o]t tix|t]
LUT2: | ePWM4B | ePWM5B | ePWMS5A | ePWMS5B | <— 5B
output |———————— [0 [ O [ X [0 [ [ O[T |X[O[[1[0|X|O|[1]1]X]|T1]|
| \ \ |
ePWM Trip Zone

This example configures ePWM1 and ePWM2 as follows

m ePWM1 has TZ1 as one shot trip source
m ePWM2 has TZ1 as cycle by cycle trip source

Initially tie TZ1 high. During the test, monitor ePWM1 or ePWM2 outputs on a scope. Pull TZ1 low to see the
effect.

External Connections

= ePWM1A is on GPIOO
m ePWM2A is on GPIO2
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m TZ1is on GPIO12

This example also makes use of the Input X-BAR. GPIO12 (the external trigger) is routed to the input X-BAR,
from which it is routed to TZ1.

The TZ-Event is defined such that ePWM1A will undergo a One-Shot Trip and ePWM2A will undergo a Cycle-
By-Cycle Trip.

ePWM Up Down Count Action Qualifier

This example configures ePWM1, ePWM2, ePWMS3 to produce a waveform with independent modulation on
ePWMxA and ePWMxB.

The compare values CMPA and CMPB are modified within the ePWM'’s ISR.
The TB counter is in up/down count mode for this example.

View the ePWM1A/B(GPIO0 & GPIO1), ePWM2A/B(GPIO2 & GPIO3) and ePWMBA/B(GPIO4 & GPIO5) wave-
forms on oscilloscope.

ePWM Synchronization

This example configures ePWM1, ePWM2, ePWM3 and ePWM4 as follows

m ePWM1 without phase shift as sync source
m ePWM2 with phase shift of 300 TBCLKs
m ePWMBS with phase shift of 600 TBCLKs
m ePWM4 with phase shift of 900 TBCLKs

External Connections

m GPIO0 EPWM1A
= GPIO1 EPWM1B
m GPIO2 EPWM2A
= GPIO3 EPWM2B
m GPIO4 EPWM3A
m GPIO5 EPWM3B
m GPIO6 EPWM4A
m GPIO7 EPWM4B

Watch Variables

= None.
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ePWM Digital Compare

This example configures ePWM1 as follows

m ePWM1 with DCAEVT1 forcing the ePWM output LOW

m GPIO25 is used as the input to the INPUT XBAR INPUT1

m INPUT1 (from INPUT XBAR) is used as the source for DCAEVT1

m GPI025’s PULL-UP resistor is enabled, in order to test the trip, PULL this pin to GND

External Connections

m GPIO0 EPWM1A
= GPIO1 EPWM1B
m GPIO25 TZ1, pull this pin low to trip the ePWM

Watch Variables

= None.

ePWM Digital Compare Event Filter Blanking Window

This example configures ePWM1 as follows

m ePWM1 with DCAEVT1 forcing the ePWM output LOW

m GPIO25 is used as the input to the INPUT XBAR INPUT1

m INPUT1 (from INPUT XBAR) is used as the source for DCAEVT1

m GPIO25’s PULL-UP resistor is enabled, in order to test the trip, PULL this pin to GND

m ePWM1 with DCBEVT1 forcing the ePWM output LOW

m GPIO25 is used as the input to the INPUT XBAR INPUT1

m INPUT1 (from INPUT XBAR) is used as the source for DCAEVT1

m GPIO25’s PULL-UP resistor is enabled, in order to test the trip, PULL this pin to GND
m DCBEVT1 uses the filtered version of DCBEVT1

m The DCFILT signal uses the blanking window to ignore the DCBEVT1 for the duration of DC
Blanking window

External Connections

= GPIO0 EPWM1A
m GPIO1 EPWM1B
m GPI1025 TRIPIN1, pull this pin low to trip the ePWM

Watch Variables

= None.
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6.125 ePWM Valley Switching

This example configures ePWM1 as follows

m ePWM1 with DCAEVT1 forcing the ePWM output LOW

m GPIO25 is used as the input to the INPUT XBAR INPUT1

m INPUT1 (from INPUT XBAR) is used as the source for DCAEVT1

m GPIO25 is set to output and toggled in the main loop to trip the PWM

m ePWM1 with DCBEVT1 forcing the ePWM output LOW

m GPIO25 is used as the input to the INPUT XBAR INPUT1

m INPUT1 (from INPUT XBAR) is used as the source for DCAEVT1

m GPIO25 is set to output and toggled in the main loop to trip the PWM
m DCBEVT1 uses the filtered version of DCBEVT1

m The DCFILT signal uses the valley switching module to delay the

m DCFILT signal by a software defined DELAY value.

External Connections

m GPIO0O EPWM1A
m GPIO1 EPWM1B
m GPIO25 TRIPIN1 (Output Pin, toggled through software)

Watch Variables

= None.

6.126 ePWM Digital Compare Edge Filter

This example configures ePWM1 as follows

m ePWM1 with DCBEVT2 forcing the ePWM output LOW as a CBC source
m GPIO25 is used as the input to the INPUT XBAR INPUT1

m INPUT1 (from INPUT XBAR) is used as the source for DCBEVT2

m GPIO25 is set to output and toggled in the main loop to trip the PWM

m The DCBEVT2 is the source for DCFILT

m The DCFILT will count edges of the DCBEVT2 and generate a signal to to trip the ePWM on
the 4th edge of DCBEVT2

External Connections

m GPIO0O EPWM1A
= GPIO1 EPWM1B
m GPI025 TRIPIN1 (Output Pin, toggled through software)

Watch Variables

= None.
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ePWM Deadband

This example configures ePWM1 through ePWM®6 as follows

m ePWM1 with Deadband disabled (Reference)

m ePWM2 with Deadband Active High

m ePWMS3 with Deadband Active Low

m ePWM4 with Deadband Active High Complimentary

m ePWMS with Deadband Active Low Complimentary

m ePWM6 with Deadband Output Swap (switch A and B outputs)

External Connections

= GPIO0 EPWM1A
= GPIO1 EPWM1B
m GPIO2 EPWM2A
m GPIO3 EPWM2B
m GPIO4 EPWM3A
m GPIO5 EPWM3B
m GPIO6 EPWM4A
m GPIO7 EPWM4B
m GPIO8 EPWM5A
= GPIO9 EPWM5B
m GPIO10 EPWM6A
= GPIO11 EPWM6B

Watch Variables

= None.

ePWM DMA

This example configures ePWM1 and DMA as follows:

m ePWMT1 is set up to generate PWM waveforms

m DMAS is set up to update the CMPAHR, CMPA, CMPBHR and CMPB every period with the
next value in the configuration array. This allows the user to create a DMA enabled fifo for all
the CMPx and CMPxHR registers to generate unconventional PWM waveforms.

m DMAG is set up to update the TBPHSHR, TBPHS, TBPRDHR and TBPRD every period with
the next value in the configuration array.

m Other registers such as AQCTL can be controlled through the DMA as well by following the
same procedure. (Not used in this example)

External Connections
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= GPIO0 EPWM1A
= GPIO1 EPWM1B

Watch Variables

= None.

Frequency Measurement Using eQEP

This example will calculate the frequency of an input signal using the eQEP module. ePWM1A is configured to
generate this input signal with a frequency of 5 kHz. It will interrupt once every period and call the frequency
calculation function. This example uses the IQMath library to simplify high-precision calculations.

In addition to the main example file, the following files must be included in this project:

m egep_ex1_calculation.c - contains frequency calculation function
m eqep_ex1_calculation.h - includes initialization values for frequency structure

The configuration for this example is as follows

m Maximum frequency is configured to 10KHz (baseFreq)
m Minimum frequency is assumed at 50Hz for capture pre-scalar selection

SPEED_FR: High Frequency Measurement is obtained by counting the external input pulses for 10ms (unit

timer set to 100Hz).
Count Delta

SPEED FR=
10ms

SPEED_PR: Low Frequency Measurement is obtained by measuring time period of input edges. Time mea-
surement is averaged over 64 edges for better results and the capture unit performs the time measurement
using pre-scaled SYSCLK.

Note that the pre-scaler for capture unit clock is selected such that the capture timer does not overflow at the
required minimum frequency. This example runs indefinitely until the user stops it.

For more information about the frequency calculation see the comments at the beginning of
egep_ex1_calculation.c and the XLS file provided with the project, eqep_ex1_calculation.xls.

External Connections
m Connect GPIO20/eQEP1A to GPIO0/ePWM1A
Watch Variables

m freq.freqHzFR - Frequency measurement using position counter/unit time out
m freq.freqHzPR - Frequency measurement using capture unit

Position and Speed Measurement Using eQEP

This example provides position and speed measurement using the capture unit and speed measurement using
unit time out of the eQEP module. ePWM1 and a GPIO are configured to generate simulated eQEP signals. The
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ePWM module will interrupt once every period and call the position/speed calculation function. This example
uses the IQMath library to simplify high-precision calculations.

In addition to the main example file, the following files must be included in this project:

m eqep_ex2_calculation.c - contains position/speed calculation function
m eqep_ex2_calculation.h - includes initialization values for position/speed structure

The configuration for this example is as follows

m Maximum speed is configured to 6000rpm (baseRPM)

m Minimum speed is assumed at 10rpm for capture pre-scalar selection

m Pole pair is configured to 2 (polePairs)

m Encoder resolution is configured to 4000 counts/revolution (mechScaler)

m Which means: 4000 / 4 = 1000 line/revolution quadrature encoder (simulated by ePWM1)
|

ePWM1 (simulating QEP encoder signals) is configured for a 5kHz frequency or 300 rpm (= 4
+ 5000 cnts/sec * 60 sec/min) / 4000 cnts/rev)

SPEEDRPM_FR: High Speed Measurement is obtained by counting the QEP input pulses for 10ms (unit timer
set to 100Hz).

SPEEDRPM_FR = (Position Delta / 10ms) x 60 rpm

SPEEDRPM_PR: Low Speed Measurement is obtained by measuring time period of QEP edges. Time mea-
surement is averaged over 64 edges for better results and the capture unit performs the time measurement
using pre-scaled SYSCLK.

Note that the pre-scaler for capture unit clock is selected such that the capture timer does not overflow at the
required minimum frequency. This example runs indefinitely until the user stops it.

For more information about the position/speed calculation see the comments at the beginning of
egep_ex2_calculation.c and the XLS file provided with the project, eqep_ex2_calculation.xls.

External Connections
m Connect GPIO20/eQEP1A to GPIO0/ePWM1A (simulates eQEP Phase A signal)

m Connect GP1021/eQEP1B to GPIO1/ePWM1B (simulates eQEP Phase B signal)
m Connect GP1023/eQEP11 to GPIO2 (simulates eQEP Index Signal)

Watch Variables

m posSpeed.speedRPMFR - Speed meas. in rpm using QEP position counter
m posSpeed.speedRPMPR - Speed meas. in rpm using capture unit

m posSpeed.thetaMech - Motor mechanical angle (Q15)

m posSpeed.thetaElec - Motor electrical angle (Q15)

Frequency Measurement Using eQEP via unit timeout inter-
rupt
This example will calculate the frequency of an input signal using the eQEP module. ePWM1A is configured to

generate this input signal with a frequency of 5 kHz. EQEP unit timeout is set which will generate an interrupt
every UNIT_PERIOD microseconds and frequency calculation occurs continuously
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The configuration for this example is as follows

m PWM frequency is specified as 5000Hz

m UNIT_PERIOD is specified as 10000 us

m Min frequency is (1/(2+10ms)) i.e 50Hz

m Highest frequency can be (232)/ ((2x10ms))
m Resolution of frequency measurement is 50hz

freq : Frequency Measurement is obtained by counting the external input pulses for UNIT_PERIOD (unit timer
setto 10 ms).

External Connections
m Connect GPIO20/eQEP1A to GPIO0/ePWM1A
Watch Variables

m freq - Frequency measurement using position counter/unit time out
m pass - If measured frequency matches with PWM frequency then pass = 1 else 0

Motor speed and direction measurement using eQEP via
unit timeout interrupt

This example can be used to sense the speed and direction of motor using eQEP in quadrature encoder mode.
ePWM1A is configured to simulate motor encoder signals with frequency of 5 kHz on both A and B pins with 90
degree phase shift (so as to run this example without motor). EQEP unit timeout is set which will generate an
interrupt every UNIT_PERIOD microseconds and speed calculation occurs continuously based on the direction
of motor

The configuration for this example is as follows

m PWM frequency is specified as 5000Hz

m UNIT_PERIOD is specified as 10000 us

m Simulated quadrature signal frequency is 20000Hz (4 « 5000)
m Encoder holes assumed as 1000

m Thus Simulated motor speed is 300rpm (5000 = (60 / 1000))

freq : Simulated quadrature signal frequency measured by counting the external input pulses for UNIT_PERIOD
(unit timer set to 10 ms). speed : Measure motor speed in rpm dir : Indicates clockwise (1) or anticlockwise

(-1)

External Connections (if motor encoder signals are simulated by ePWM)

m Connect GPI020/eQEP1A to GPIO0/ePWM1A

m Connect GPIO21/eQEP1B to GP1O1/ePWM1B With motor
m Comment in "MOTOR?" in includes

m Connect GP1020/eQEP1A to encoder A output

m Connect GP1I021/eQEP1B to encoder B output
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Watch Variables

m freq : Simulated motor frequency measurement is obtained by counting the external input
pulses for UNIT_PERIOD (unit timer set to 10 ms).

m speed : Measure motor speed in rpm
m dir : Indicates clockwise (1) or anticlockwise (-1)

m pass - If measured qudrature frequency matches with i.e. input quadrature frequency (4 x
PWM frequency) then pass = 1 else fail = 1 (xx only when "MOTOR" is commented out)

ERAD Profile Function

This example uses BUSCOMP1, BUSCOMP2 and COUNTER1 of the ERAD module to profile a function (delay-
Function). It calculates the CPU cycles taken between the the start address of the function to the end address
of the function

Two dummy variable are written to inside the function - startCount and endCount. BUSCOMP3, BUSCOMP4
and COUNTERZ2 are used to profile the time taken between the access to startCount variable till the access to
endCount variable.

Both the counters are setup to operate in START-STOP mode and count the number of CPU cycles spend
between the respective bus comparator events.

Watch Variables

m cycles_Function - the maximum number of cycles between the start of function to the end of
function

m cycles_Data - the maximum number of cycles taken between accessing startCount variable to
endCount variable
External Connections

None

ERAD Profile Function

This example uses BUSCOMP1, BUSCOMP2 and COUNTER1 of the ERAD module to profile a function (delay-
Function). It calculates the CPU cycles taken between the the start address of the function to the end address
of the function

Two dummy variable are written to inside the function - startCount and endCount. BUSCOMP3, BUSCOMP4
and COUNTERR2 are used to profile the time taken between the access to startCount variable till the access to
endCount variable.

Both the counters are setup to operate in START-STOP mode and count the number of CPU cycles spend
between the respective bus comparator events.

Watch Variables

m cycles_Function - the maximum number of cycles between the start of function to the end of
function
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m cycles_Data - the maximum number of cycles taken between accessing startCount variable to
endCount variable
External Connections

None

ERAD HWBP Monitor Program Counter

In this example, the function delayFunction is called multiple times. The function does read and writes to the
global variables startCount and endCount.

The BUSCOMP1 and COUNTERT is used to count the number of times the function delayFunction was in-
voked. BUSCOMP?2 is used to generate an interrupt when there is read access to the startCount variable and
BUSCOMP3 is used to generate an interrupt when there is a write access to the endCount variable

Watch Variables

m funcCount - number of times the function delayFunction was invoked
m isrCount - number of times the ISR was invoked

External Connections

= None

ERAD HWBP Monitor Program Counter

In this example, the function delayFunction is called multiple times. The function does read and writes to the
global variables startCount and endCount.

The BUSCOMP1 and COUNTERT is used to count the number of times the function delayFunction was in-
voked. BUSCOMP2 is used to generate an interrupt when there is read access to the startCount variable and
BUSCOMP3 is used to generate an interrupt when there is a write access to the endCount variable

Watch Variables

m funcCount - number of times the function delayFunction was invoked
m isrCount - number of times the ISR was invoked

External Connections

= None

ERAD HWBP Stack Overflow Detection

This example uses BUSCOMP1 to monitor the stack. The Bus comparator is set to monitor the data write access
bus and generate an RTOS interrupt CPU when a write is detected to end of the STACK within a threshold.

Watch Variables
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m functionCallCount - the number of times the recursive function overflowing the STACK is called.
m x indicates that the ISR has been entered

External Connections

None

ERAD HWBP Stack Overflow Detection

This example uses BUSCOMP1 to monitor the stack. The Bus comparator is set to monitor the data write access
bus and generate an RTOS interrupt CPU when a write is detected to end of the STACK within a threshold.

Watch Variables

m functionCallCount - the number of times the recursive function overflowing the STACK is called.
m x indicates that the ISR has been entered

External Connections

None

ERAD Profiling Interrupts

This example shows how an ISR can be profiled by ERAD. The CPU timer generates interrupts periodically. We
set up the counters to count the CPU cycles elapsed while executing the ISR, to count the number of interrupts,
the number of ISR executions and the CPU cycles elapsed between the interrupt and the execution of the ISR.

This example uses 2 bus comparators and 4 counters:

m BUSCOMP_1 : PC = start address of cpuTimer1ISR

m BUSCOMP_2 : PC = address of cpuTimer1IntCount variable access. This specifies the end
address of the code of interest.

m COUNTER_1 : Used to count the cpuTimer1ISR execution cycles. Configured in start-stop
mode with start event as BUSCOMP_1 and stop event as BUSCOMP_2

m COUNTER_2 : Used to count the number of times the system event TIMER1_TINT1
has occurred. Configured in rising-edge count mode with counting input as system event
TIMER1_TINTA

m COUNTER_3 : Used to count the number of times cputTimer2ISR executes. Configured in
rising-edge count mode with counting input as BUSCOMP_1

m COUNTER_4 : Used to count the latency from the system event TIMER1_TINT1 to
cpuTimer1ISR entry. Configured in start-stop mode with start event as TIMER1_TINT1 and
stop event as BUSCOMP _1

We configure the COUNTERT1 to generate an interrupt once it reaches a threshold value.

External Connections

® None
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Profiling Output

Current ISR cycle count (COUNTER_1)

Interrupt occurrence count (COUNTER_2)

ISR execution count (COUNTER_3)

ISR entry delay cycle count (maximum value of COUNTER_4)
x - To show that the ISR executed

6.140 ERAD Profiling Interrupts

This example shows how an ISR can be profiled by ERAD. The CPU timer generates interrupts periodically. We
set up the counters to count the CPU cycles elapsed while executing the ISR, to count the number of interrupts,
the number of ISR executions and the CPU cycles elapsed between the interrupt and the execution of the ISR.

This example uses 2 bus comparators and 4 counters:

m BUSCOMP_1 : PC = start address of cpuTimer1ISR

m BUSCOMP_2 : PC = address of cpuTimer1IntCount variable access. This specifies the end
address of the code of interest.

m COUNTER_1 : Used to count the cpuTimer1ISR execution cycles. Configured in start-stop
mode with start event as BUSCOMP_1 and stop event as BUSCOMP_2

m COUNTER_2 : Used to count the number of times the system event TIMER1_TINT1
has occurred. Configured in rising-edge count mode with counting input as system event
TIMER1_TINT1

m COUNTER_3 : Used to count the number of times cputTimer2ISR executes. Configured in
rising-edge count mode with counting input as BUSCOMP_1

m COUNTER_4 : Used to count the latency from the system event TIMER1_TINT1 to
cpuTimer1ISR entry. Configured in start-stop mode with start event as TIMER1_TINT1 and
stop event as BUSCOMP_1

We configure the COUNTERT1 to generate an interrupt once it reaches a threshold value.

External Connections
m None

Profiling Output

m Current ISR cycle count (COUNTER_1)

Interrupt occurrence count (COUNTER_2)

ISR execution count (COUNTER_3)

ISR entry delay cycle count (maximum value of COUNTER_4)
m x - To show that the ISR executed

FILE: erad_ex5_restricted_write_detect.c

TITLE: erad_ex5_restrictedwrite_detect
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ERAD MEMORY ACCESS RESTRICT

This example uses BUSCOMP1 to monitor the Data Write Address Bus. It monitors the bus and generates an
RTOS interrupt if a certain region of memory is accessed by the PC. The user may disable the Bus Comparator
to access that region.

Use the COM port (Baud=9600) to try to write to the restricted area.
Watch Variables

m x : stores the number of times the region of memory is accessed
External Connections
= None

HHHHHEHH A
FILE: erad_ex6_interrupt_order.c
TITLE: ERAD INTERRUPT ORDER

ERAD INTERRUPT ORDER

This example uses a COUNTER to monitor the sequence of ISRs executed. An interrupt is generated if the
ISRs executed are not in the expected order. The expected order is CPUTimer0 ,then CPUTimer1 and then
CPUTimer2

The counter is configured in Start-Stop Mode to count the number of times CPUTimer2 interrupt occurs between
the CPUTimer0 interrupt and CPUTimer1 ISRs. Ideally, this count should be zero if the interrupts are occurring
in the expected order. we configure a threshold value of 1 to generate an RTOS interrupt. This indicates that
the CPUTimer2 interrupt has come out of order.

For demonstration purposes, this example disables CPUTimer1 to simulate this error.
Watch Variables

m cpuTimerOIntCount: Number of executions of ISRO
m cpuTimer1IntCount: Number of executions of ISR1
m cpuTimer2IntCount: Number of executions of ISR2

External Connections

= None

ERAD AND CLB

This example uses 4 BUS COMPARATORS of ERAD along with the CLB. One bus comparator monitors a write
to x, another one monitors a write to y. The other two monitor a write of Ox1 and 0x0. By using the LUTs in the
CLB1 tile, we can monitor a write of 0x1 to x or 0x0 to x. These are used to change the state of FSM2 in the
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CLBf1 tile. If y is accessed before writing a 0x1 to X, an interrupt is generated and y is changed to 0x0 again.
The LED2 indicates when access to y is allowed(it is off at this point) The LED1 indicates if an invalid access is
attempted. A COUNTER in ERAD is used to count the number of access attempts to y.

Watch Variables
my
m X

m a - counts the number of access attempts to y

External Connections

None

6.144 ERAD PWM PROTECTION

This example uses a BUS COMPARATOR and the CLB to detect the event when the delay between the interrupt
and the ISR execution is longer than expected. The PWM output is also tripped in this case.

Watch Variables
m adcAResults stores the results of the conversions from the ADC
External Connections

m Monitor the PWM output (GPI1O0)

6.145 ERAD Profiling Interrupts

This example configures CPU Timer0, 1, and 2 to be profiled using the ERAD module. Included is a JavaScript
file, profile_interrupts.js, which is used with the scripting console to program ERAD registers and view profiling
data.

To properly use the provided ERAD script, the following variables must be set in the scripting environment prior
to launching the ERAD script:

m var PROJ_NAME = "erad_debugger_ex1_profileinterrupts”
m var PROJ_WKSPC_LOC = "<proj_workspace_path>"
m var PROJ_CONFIG = "<name of active configuration [CPU1_FLASH|CPU1_RAM]>"

To run the ERAD script, use the following command in the scripting console:

m loadJSFile("<proj_workspace_path>\\erad_debugger_ex1_profileinterrupts\\erad_ex1_profile_interrupts.j
0);

The included JavaScript file, erad_ex1_profile_interrupts.js, uses Debug Server Script-
ing (DSS) features. For information on wusing the DSS, please visit: http://software-
dl.ti.com/ccs/esd/documents/users_guide/sdio_dss_handbook.html
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Note that the script must be run after loading and running the .out on the C28x core. Only CPU timer 2 ISR is
profiled in this example.

This example uses 2 HW breakpoints and 4 counters:

m HWBP_1 : PC = start address of cpuTimer2ISR
m HWBP_2 : PC = end address of cpuTimer2ISR

m CTM_1 : Used to count the cpuTimer2ISR execution cycles. Configured in start-stop mode
with start event as HWBP_1 and stop event as HWBP_2

m CTM_2 : Used to count the number of times the system event TIMER2_TINT2 has occurred.
Configured in rising-edge count mode with counting input as system event TIMER2_TINT2
(INP_SEL[25])

m CTM_3 : Used to count the number of times cputTimer2ISR executes. Configured in rising-
edge count mode with counting input as HWBP_1 (INP_SELJ0])

m CTM_4 : Used to count the latency from the system event TIMER2_TINT2 to cpuTimer2ISR
entry. Configured in start-stop mode with start event as TIMER2_TINT2 and stop event as
HWBP_1

External Connections
m None
Watch Variables

m cpuTimerOIntCount
m cpuTimer1IntCount
m cpuTimer2IntCount

Profiling Script Output

m Current ISR cycle count (CTM_1)

m Max ISR cycle count (maximum value of CTM_1)

m Interrupt occurrence count (CTM_2)

m ISR execution count (CTM_3)

m |SR entry delay cycle count (maximum value of CTM_4)

Note that the large difference between Interrupt occurrence count (CTM_2) and ISR execution count (CTM_3)
is because the ISR takes more number of cycles than the actual interrupt period. ISR entry delay cycle count
will also be higher due to the same reason.

ERAD Profile Function

This example contains a basic FIR calculation and sorting algorithm to help demonstrate the function profiling
capability of the ERAD peripheral. A number of FIR sums are calculated within a loop and are then sorted using
the insertion sort algorithm. Cycle counts of both the FIR calculations and the sorting algorithm are output to the
screen through the scripting console. In this example, it can be seen that sorting the data takes up a majority of
the CPU cycles executed in this program.

To properly use the provided ERAD script, the following variables must be set in the scripting environment prior
to launching the ERAD script:
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m var PROJ_NAME = "erad_debugger_ex2_profilefunction”
m var PROJ_WKSPC_LOC = "<proj_workspace_path>"
m var PROJ_CONFIG = "<name of active configuration [CPU1_FLASH|CPU1_RAM]>"

To run the ERAD script, use the following command in the scripting console:

m loadJSFile("<proj_workspace_path>\\erad_debugger_ex2_profilefunction\\erad_ex2_profile_function.js",
0);

Note that the script must be run after loading and running the .out on the C28x core.

The included JavaScript file, erad_ex2_profile_function.js, uses Debug Server  Script-
ing (DSS) features. For information on wusing the DSS, please visit: http://software-
dl.ti.com/ccs/esd/documents/users_guide/sdto_dss_handbook.html

This example uses 4 HW breakpoints and 2 counters:

HWBP_1 : PC = start address of performFIR
HWBP_2 : PC = end address of performFIR
HWBP_3 : PC = start address of sortMax
HWBP_4 : PC = end address of sortMax

CTM_1 : Used to count the performFIR execution cycles. Configured in start-stop mode with
start event as HWBP_1 and stop event as HWBP_2

m CTM_2 : Used to count the sortMax execution cycles. Configured in start-stop mode with start
event as HWBP_3 and stop event as HWBP_4

External Connections
= None.
Watch Variables

m FIR_iterationCounter - A counter for the number of times FIR calculation and sorting was
performed

Profiling Script Output

m Current FIR cycle count (CTM_1)

m Max FIR cycle count (maximum value of CTM_1)

m Current sorting function cycle count (CTM_2)

m Max sorting function cycle count (maximum value of CTM_2)

Note that the the counters are reset after the stop event. The counter value remains 0 till the next start event
occurs. The javascript continuously reads the counter value in a while(1) and hence the current counter may
return 0.

6.147 ERAD Stack Overflow

This example shows the basic setup of CAN in order to transmit and receive messages on the CAN bus. The
CAN peripheral is configured to transmit messages with a specific CAN ID. A message is then transmitted once
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per second, using a simple delay loop for timing. The message that is sent is a 2 byte message that contains
an incrementing pattern.

This example sets up the CAN controller in External Loopback test mode. Data transmitted is visible on the
CANTXA pin and is received internally back to the CAN Core.

A buffer is created to store message history up to 50 messages for the duration of the program. A logic error is
intentionally made to allow the buffer to overflow, eventually causing a stack overflow. The included JavaScript
file, stack_overflow.js, programs ERAD registers in order to detect the stack overflow and halt the CPU once the
illegal write is made. The illegal write is made after 507 messages are received.

To properly use the provided ERAD script, the following variables must be set in the scripting environment prior
to launching the ERAD script:

m var PROJ_NAME = "erad_debugger_ex3_stackoverflow"
m var PROJ_WKSPC_LOC = <proj_workspace_path>

To run the ERAD script, use the following command in the scripting console:

m loadJSFile("<proj_workspace_path>\\erad_debugger_ex3_stackoverflow\\erad ex3_stack_ overflow.js",
0);

Note that the script must be run after loading and running the .out on the C28x core.

The included JavaScript file, erad_ex3_stack_overflow.js, uses Debug Server  Script-
ing (DSS) features. For information on wusing the DSS, please visit: http://software-
dl.ti.com/ccs/esd/documents/users_guide/sdto_dss_handbook.html

This example uses 1 HW watchpoint :

m HWBP_1 : Data Write Address Bus = Stack end address + 1
External Connections

= None.
Watch Variables

m msgCount - A counter for the number of successful messages received
m txMsgData - An array with the data being sent

m rxMsgData - An array with the data that was received

m msgHistoryBuff - An array meant to store the last 50 messages received

Profiling Script Output

m "STACK OVERFLOW detected. Halting CPU." will be printed in the scripting console when a
stack overflow occurs (that is, when the watchpoint is hit)

6.148 ERAD Profile Interrupts CLA

This example configures EPWM1A to run at 1 KHz (period = 1 ms) to trigger a start-of-conversion on ADC
channel AO. This channel will, in turn, sample EPWM4A which is set to run at 100Hz. At the end-of-conversion
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the ADC interrupt is fired. The interrupt signal will be used to trigger a CLA task that runs an FIR filter. The
filter is designed to be low pass with a cutoff frequency of 100Hz; it will remove the odd harmonics in the input
signal smoothing the square wave to a sinusoidal shape. The CLA background task will continuously buffer the
filtered output in a circular buffer.

This example also utilizes the ERAD peripheral to profile the Interrupt Service Routine (ISR) cla1ISR1 (on the
C28x core). The ISR contains a loop that simulates storing a random amount of data to a location in order to
introduce variability into the cycle measurements. The ERAD peripheral is also configured to count the number
of times the system event CLA_INTERRUPT1 occurs.

To properly use the provided ERAD script, the following variables must be set in the scripting environment prior
to launching the ERAD script:

m var PROJ_NAME = "erad_debugger_ex4_profileinterrupts_cla"
m var PROJ_WKSPC_LOC = "<proj_workspace_path>"
m var PROJ_CONFIG = "<name of active configuration [CPU1_FLASH|CPU1_RAM]>"

To run the ERAD script, use the following command in the scripting console:

m |oadJSFile("<proj_workspace_path>\\erad_debugger_ex4_profileinterrupts_cla\\erad_ex4_profile_interru
0);
Note that the script must be run after loading and running the .out on the C28x core.

The included JavaScript file, erad_ex4 profile_interrupts_cla.js, uses Debug Server Script-
ing (DSS) features. For information on wusing the DSS, please Vvisit: http://software-
dl.ti.com/ccs/esd/documents/users_guide/sdto_dss_handbook.html

This example uses 4 HW breakpoints and 2 counters:

m HWBP_1 : PC = start address of clatlsr1
m HWBP_2 : PC = end address of clallsr1

m CTM_1 : Used to count the cla1lsr1 execution cycles. Configured in start-stop mode with start
event as HWBP_1 and stop event as HWBP_2

m CTM_2 : Used to count the number of times the system event CLA_INTERRUPT1 event
has occurred. Configured in rising-edge count mode with counting input as system event
CLA_INTERRUPT1 (INP_SEL[26])

External Connections
m connect A0 to EPWM4A
Watch Variables
m ISR_count - A counter that signifies how many times cla1ISR1 executes

Profiling Script Output

m Current ISR cycle count (CTM_1)
m Max ISR cycle count (maximum value of CTM_1)
m Interrupt occurrence count (CTM_2)
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FSI daisy chain topology, lead device example

fsi_ex16_daisy_handshake_lead is for the lead device in the daisy-chain loop, fsi_ex16_daisy_handshake_node
for the other N-1 devices(N>=2).

In the code, there are different settings provided: [define FSI_DMA_ENABLE 0] represents FSI communication
using CPU control. [define FSI_DMA_ENABLE 1] represents FSI communication using DMA control, enabling
FSIRX to trigger a DMA event and move the RX FSI data to the TX FSI buffer

In a real scenario two separate devices may power up in arbitrary order and there is a need to establish a clean
communication link which ensures that receiver side is flushed to properly interpret the start of a new valid
frame.

The node devices in the daisy chain topology respond to the handshake sequence and forwards the information
to the next device in the chain.

After above synchronization steps, FSI Rx can be configured as per use case i.e. nWords, lane width, enabling
events, etc and start the infinite transfers. More details on establishing the communication link can be found in
the device TRM.

User can edit some of configuration parameters as per use case, similar to other examples.

nWords - Number of words per transfer may be from 1 -16 nLanes - Choice to select single or double lane for
frame transfers txUserData - User data to be sent with Data frame txDataFrameTag - Frame tag used for Data
transfers txPingFrameTag - Frame tag used for Ping transfers txPingTimeRefCntr - Tx Ping timer reference
counter rxWdTimeoutRefCntr - Rx Watchdog timeout reference counter

External Connections

For the FSI daisy-chain topology external connections are required to be made between the devices in the
chain. Each devices FSI TX pins need to be connected to the FSI RX pins of the next device in the chain (or
ring). See below for external connections to include and GPIOs used:

External Connections Required:

m FSIRX_CLK to FSITX_CLK
m FSIRX_RXO0 to FSITX_TX0
m FSIRX_RX1 to FSITX_TX1

ControlCard FSI| Header GPIOs:

= GPIO_27 -> FSITX_CLK
= GPIO_26 -> FSITX_TX0
= GPIO_25 -> FSITX_TX1
= GPIO_13 -> FSIRX_CLK
= GPIO_12 -> FSIRX_RX0
= GPIO_11 -> FSIRX_RX1

Watch Variables

m dataFrameCntr Number of Data frames received back
m error Non zero for transmit/receive data mismatch
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6.150 FSI daisy chain topology, hode device example

fsi_ex16_daisy_handshake_lead is for the lead device in the daisy-chain loop, fsi_ex16_daisy_handshake_node
for the other N-1 devices(N>=2).

In the code, there are different settings provided: [define FSI_DMA_ENABLE 0] represents FSI communication
using CPU control. [define FSI_DMA_ENABLE 1] represents FSI communication using DMA control, enabling
FSIRX to trigger a DMA event and move the RX FSI data to the TX FSI buffer

In a real scenario two separate devices may power up in arbitrary order and there is a need to establish a clean
communication link which ensures that receiver side is flushed to properly interpret the start of a new valid
frame.

The node devices in the daisy chain topology respond to the handshake sequence and forwards the information
to the next device in the chain.

After above synchronization steps, FSI Rx can be configured as per use case i.e. nWords, lane width, enabling
events, etc and start the infinite transfers. More details on establishing the communication link can be found in
the device TRM.

User can edit some of configuration parameters as per use case, similar to other examples.

nWords - Number of words per transfer may be from 1 -16 nLanes - Choice to select single or double lane for
frame transfers txUserData - User data to be sent with Data frame txDataFrameTag - Frame tag used for Data
transfers txPingFrameTag - Frame tag used for Ping transfers txPingTimeRefCntr - Tx Ping timer reference
counter rxWdTimeoutRefCntr - Rx Watchdog timeout reference counter

External Connections

For the FSI daisy-chain topology external connections are required to be made between the devices in the
chain. Each devices FSI TX pins need to be connected to the FSI RX pins of the next device in the chain (or
ring). See below for external connections to include and GPIOs used:

External Connections Required:

m FSIRX_CLK to FSITX_CLK
m FSIRX_RXO0 to FSITX_TX0
m FSIRX_RX1 to FSITX_TX1

ControlCard FSI| Header GPIOs:

= GPIO_27 -> FSITX_CLK
= GPIO_26 -> FSITX_TX0
= GPIO_25 -> FSITX_TX1
= GPIO_13 -> FSIRX_CLK
= GPIO_12 -> FSIRX_RX0
= GPIO_11 -> FSIRX_RX1

Watch Variables

m dataFrameCntr Number of Data frames received back
m error Non zero for transmit/receive data mismatch
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FSI Loopback:CPU Control

Example sets up infinite data frame transfers where trigger happens through CPU. Automatic(Hw triggered)
Ping frame transmission is also setup along with data.

User can edit some of configuration parameters as per usecase. These are as below. Default values can be
referred in code where these globals are defined

m hWords - Number of words per transfer may be from 1 -16

m nLanes - Choice to select single or double lane for frame transfers
m fsiClock - FSI Clock used for transfers

m txUserData - User data to be sent with Data frame

m txDataFrameTag - Frame tag used for Data transfers

m txPingFrameTag - Frame tag used for Ping transfers

m txPingTimeRefCntr - Tx Ping timer reference counter

m rxWdTimeoutRefCntr - Rx Watchdog timeout reference counter

For any errors during transfers i.e. error events such as Frame Overrun, Underrun, Watchdog timeout and
CRC/EOF/TYPE errors, execution will stop immediately and status variables can be looked into for more details.
Execution will also stop for any mismatch between received data and sent ones and also if transfers takes
unusually long time(detected through software counters - txTimeOutCntr and rxTimeQutCntr)

External Connections
For FSl internal loopback (EXTERNAL_FSI_ENABLE == 0), no external connections needed

For FSI external loopback (EXTERNAL_FSI_ENABLE == 1), external connections are required. The FSI TX

pins should be connected to the FSI RX pins of the same device. See below for external connections to include
and GPIOs used:

External Connections Required between FSI TX and RX of the same device:

m FSIRX_CLKto FSITX_CLK
m FSIRX_RXO0 to FSITX_TX0
m FSIRX_RX1 to FSITX_TX1

ControlCard FSI| Header GPIOs:

= GPIO_27 -> FSITX_CLK
= GPIO_26 -> FSITX_TX0
= GPIO_25 -> FSITX_TX1
= GPIO_13 -> FSIRX_CLK
= GPIO_12 -> FSIRX_RX0
= GPIO_11 -> FSIRX_RX1

Watch Variables

m dataFrameCntr Number of Data frame transfered
m error Non zero for transmit/receive data mismatch
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6.152 FSI Loopback CLA control

Example sets up infinite data frame transfers where trigger happens through CLA. Automatic(Hw triggered)
Ping frame transmission is also setup along with data. This example is similar to fsi_ex1_loopback_cpucontrol
and only different in in the sense that data frame transfer are trigged from a CLA task. Using CLA will release
some of load from CPU and help it in providing time for other tasks.

User can edit some of configuration parameters as per usecase. These are as below. Default values can be
referred in code where these globals are defined

m hWords - Number of words per transfer may be from 1 -16

m nLanes - Choice to select single or double lane for frame transfers
m fsiClock - FSI Clock used for transfers

m txUserData - User data to be sent with Data frame

m txDataFrameTag - Frame tag used for Data transfers

m txPingFrameTag - Frame tag used for Ping transfers

= txPingTimeRefCntr - Tx Ping timer reference counter

m rxWdTimeoutRefCntr - Rx Watchdog timeout reference counter

For any errors during transfers i.e. error events such as Frame Overrun, Underrun, Watchdog timeout and
CRC/EOF/TYPE errors, execution will stop immediately and status variables can be looked into for more details.
Execution will also stop for any mismatch between received data and sent ones and also if transfers takes
unusually long time(detected through software counters - txTimeOutCntr and rxTimeQOutCntr)

External Connections
For FSl internal loopback (EXTERNAL_FSI_ENABLE == 0), no external connections needed

For FSI external loopback (EXTERNAL_FSI_ENABLE == 1), external connections are required. The FSI TX
pins should be connected to the respective FSI RX pins of the same device. See below for external connections
to include and GPIOs used:

External Connections Required between FSI TX and RX of the same device:

m FSIRX_CLKto FSITX_CLK
m FSIRX_RXO0 to FSITX_TXO0
m FSIRX_RX1 to FSITX_TX1

ControlCard FSI| Header GPIOs:

m GPIO_27 -> FSITX_CLK
m GPIO_26 -> FSITX_TXO0
m GPIO_25 -> FSITX_TX1
m GPIO_13 -> FSIRX_CLK
m GPIO_12 -> FSIRX_RX0
m GPIO_11 -> FSIRX_RX1

Watch Variables

m dataFrameCntr Number of Data frame transfered
m error Non zero for transmit/receive data mismatch
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FSI DMA frame transfers:DMA Control

Example sets up infinite data frame transfers where DMA trigger happens once through CPU and then DMA
takes control to transfer data iteratively. This example demonstrates the FSI feature about triggering DMA
events which in turn can copy data and trigger next transfer.

Two DMA channels are setup for FSI Tx operation and two for Rx. Four areas in GSx memories are also setup
as source and sink for data and tag values of frame under transmission.

Automatic(Hw triggered) Ping frame transmission is also setup along with data.
If there are any comparison failures during transfers or any error event occurs, execution will stop.

User Configurations: If "Software Frame Size" is modified in FSI TX or FSI RX Sysconfig, change: DMA CHO
"Destination Wrap Size" DMA CHO "Burst Size" DMA CH2 "Source Wrap Size" DMA CH2 "Burst Size" FSI
TX/RX "Software Frame Size"

Note:
: This example project has support for migration across our C2000 device families. If you are
wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you're using. At any time you can select another device to migrate this example.
External Connections
For FSl internal loopback (default setting), no external connections needed

For FSI external loopback (disable "Loopback Mode" in FSI RX Sysconfig), external connections are required.
Refer to SysConfig for external connections (GPIO pin numbers) specific to each device.

Watch Variables

m countDMAtransfers Number of Data frame transfered
m error Non zero for transmit/receive data mismatch

FSI data transfer by external trigger

FSI frame transfer can be triggered by external sources. It can connect up to 32 trigger sources but as of now,
only 16 ePWMx-SOCy(x-1:8, y-A:B) are supported. FSI supports external trigger for both PING and DATA frame
transfers and in this example we demonstrate how to setup infinite DATA transfers using selectable ePWM-SOC
as a trigger source. The TB counter for ePWM operation is in up/down count mode for this example.

Automatic(Hw triggered) Ping frame transmission is also setup along with data.

If there are any comparison failures during transfers or any of error event occurs, execution will stop.
External Connections

For FSl internal loopback (EXTERNAL_FSI_ENABLE == 0), no external connections needed

For FSI external loopback (EXTERNAL_FSI_ENABLE == 1), external connections are required. The FSI TX
pins should be connected to the respective FSI RX pins of the same device. See below for external connections
to include and GPIOs used:

External Connections Required between FSI TX and RX of the same device:

m FSIRX_CLKto FSITX_CLK
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m FSIRX_RXO0 to FSITX_TX0
m FSIRX_RX1 to FSITX_TX1

ControlCard FSI Header GPIOs:

= GPIO_27 -> FSITX_CLK
= GPIO_26 -> FSITX_TX0
= GPIO_25 -> FSITX_TX1
= GPIO_13 -> FSIRX_CLK
= GPIO_12 -> FSIRX_RX0
= GPIO_11 -> FSIRX_RX1

Watch Variables

m dataFrameCntr Number of Data frame transfered
m error Non zero for transmit/receive data mismatch

FSI data transfers upon CPU Timer event

Example sets up infinite data frame transfers where trigger comes from ISR handling the periodic CPU Timer
event. Automatic(Hw triggered) Ping frame transmission is also setup along with data.

CPU Timer0 is chosen for setting up periodic timer events. User can choose any other Timer-1/Timer-2 as well.
Automatic(Hw triggered) Ping frame transmission is also setup along with data.

If there are any comparison failures during transfers or any of error event occurs, execution will stop.

External Connections

For FSl internal loopback (EXTERNAL_FSI_ENABLE == 0), no external connections needed

For FSI external loopback (EXTERNAL_FSI_ENABLE == 1), external connections are required. The FSI TX
pins should be connected to the respective FSI RX pins of the same device. See below for external connections
to include and GPIOs used:

External Connections Required between FSI TX and RX of the same device:

m FSIRX_CLKto FSITX_CLK
m FSIRX_RXO0 to FSITX_TX0
m FSIRX_RX1 to FSITX_TX1

ControlCard FSI| Header GPIOs:

m GPIO_27 -> FSITX_CLK
m GPIO_26 -> FSITX_TXO0
m GPIO_25 -> FSITX_TX1
m GPIO_13 -> FSIRX_CLK
m GPIO_12 -> FSIRX_RXO0
m GPIO_11 -> FSIRX_RX1
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Watch Variables

m dataFrameCntr Number of Data frame transfered
m error Non zero for transmit/receive data mismatch

FSI and SPI communication(fsi_ex6_spi_main_tx)

FSI supports SPI compatibility mode to talk to the devices not having FSI but SPI module. Example sets up
infinite data frame transfers where FSI acts like main Tx and SPI as remote Rx. API to decode FSI frame
received at SPI end is implemented and checks are made to ensure received details(frame tag/type, userdata,
data) match with transfered frame.

If there are any comparison failures during transfers or any of error event occurs, execution will stop.
External Connections

For FSI <-> SPI communication, make below connections in GPIO settings

m GPIO_2 -> GPIO_18 :: To connect FSITX_ CLK with SPICLKA
m GPIO_0-> GPIO _16 :: To connect FSITX_TXO0 with SPIPICOA
m GPIO_1 -> GPIO_19 :: To connect FSITX_TX1 with SPIPTEA

Watch Variables

m dataFrameCntr Number of Data frame transfered
m error Non zero for transmit/receive data mismatch

FSI and SPI communication(fsi_ex7_spi_remote_rx)

FSI supports SPI compatibility mode to talk to the devices not having FSI but SPI module. Example sets up
infinite data frame transfers where FSI acts like remote Rx and SPI as main Rx. API to build the FSI frame at
SPI end before transfer is implemented in SW and checks are made to ensure received details(frame tag/type,
userdata, data) on FSI Rx match with transferred data.

If there are any comparison failures during transfers or any of error event occurs, execution will stop.

External Connections

For FSI(Rx) <-> SPI(Tx) communication, make connections in GPIO settings

There is no requirement for a chip select signal to be used when connected to the FSIRX. This is because the
FSIRX will respond to any incoming clock edge.

m GPIO_13 -> GPIO_18 :: To connect FSIRXCLKA with SPICLKA
m GPIO_12 -> GPIO_16 :: To connect FSIRXDOA with SPIPICOA

Watch Variables

m dataFrameCntr Number of Data frame transfered
m error Non zero for transmit/receive data mismatch
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6.158 FSI P2Point Connection:Rx Side

Example sets up FSI receiving device in a point to point connection to the FSI transmitting device. Example
code to set up FSI transmit device is implemented in a separate file.

In a real scenario two separate devices may power up in arbitrary order and there is a need to establish a clean
communication link which ensures that receiver side is flushed to properly interpret the start of a new valid
frame.

There is no true concept of a main or a remote node in the FSI protocol, but to simplify the data flow and
connection we can consider transmitting device as main and receiving side as remote. Transmitting side will be
driver of initialization sequence.

Handshake mechanism which must take place before actual data transmission can be usecase specific; points
described below can be taken as an example on how to implement the handshake from receiving side -

m Setup the receiver interrupts to detect PING type frame reception

m Begin the first PING loop + Wait for receiver interrupt + If the FSI Rx has received a PING
frame with FSI_FRAME_TAGO, come out of loop. Otherwise iterate the loop again.

m Begin the second PING loop + Send the Flush sequence + Send the PING frame with tag +
Wait for receiver interrupt + If the FSI Rx has received a PING frame with FSI_FRAME_TAG1,
come out of loop. Otherwise iterate the loop again.

* Now, the receiver side has received the acknowledged PING frame(tag1), so it is ready
for normal operation further.

After above synchronization steps, FSI Rx can be configured as per usecase i.e. nWords, lane width, enabling
events etc and start the infinite transfers. More details on establishing the communication link can be found in
device TRM.

User can edit some of configuration parameters as per usecase, similar to other examples.

nWords - Number of words per transfer may be from 1 -16 nLanes - Choice to select single or double lane
for frame transfers fsiClock - FSI Clock used for transfers txUserData - User data to be sent with Data frame
txDataFrameTag - Frame tag used for Data transfers txPingFrameTag - Frame tag used for Ping transfers
txPingTimeRefCntr - Tx Ping timer reference counter rxWdTimeoutRefCntr - Rx Watchdog timeout reference
counter

External Connections

For FSI external P2P connection, external connections are required to be made between two devices. Device
1’s FSI TX and RX pins need to be connected to device 2’s FSI RX and TX pins respectively. See below for
external connections to make and GPIOs used:

External connections required between independent RX and TX devices:

m FSIRX_CLKto FSITX_CLK
m FSIRX_RXO0 to FSITX_TX0
m FSIRX_RX1 to FSITX_TX1

ControlCard FS| Header GPIOs:

m GPIO_27 -> FSITX_CLK
m GPIO_26 -> FSITX_TX0
m GPIO_25 -> FSITX_TX1
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= GPIO_13 -> FSIRX_CLK
= GPIO_12 -> FSIRX_RX0
= GPIO_11 -> FSIRX_RX1

Watch Variables

m dataFrameCntr Number of Data frame received
m error Non zero for transmit/receive data mismatch

FSI P2Point Connection:Tx Side

Example sets up FSI transmitting device in a point to point connection to the FSI receiving device. Example
code to set up FSI receiving device is implemented in a separate file.

In a real scenario two separate devices may power up in arbitrary order and there is a need to establish a clean
communication link which ensures that receiver side is flushed to properly interpret the start of a new valid
frame.

There is no true concept of a main or a remote node in the FSI protocol, but to simplify the data flow and
connection we can consider transmitting device as main and receiving side as remote. Transmitting side will be
driver of initialization sequence.

Handshake mechanism which must take place before actual data transmission can be usecase specific; points
described below can be taken as an example on how to implement the handshake from transmitting side -

m Setup the receiver interrupts to detect PING type frame reception

m Begin the PING loop + Send the Flush sequence + Send a PING frame with the frame tag
FSI_FRAME_TAGO + Wait for some time(determined by application) + If the FSI Rx has re-
ceived a PING frame with FSI_FRAME_TAG1, come out of loop. Otherwise iterate the loop
again

» Send a PING frame with the frame tag FSI_FRAME_TAGH1

After above synchronization steps, FSI Tx can be configured as per usecase i.e. nWords, lane width, enabling
events etc and start the infinite transfers. More details on establishing the communication link can be found in
device TRM.

User can edit some of configuration parameters as per usecase, similar to other examples.

nWords - Number of words per transfer may be from 1 -16 nLanes - Choice to select single or double lane
for frame transfers fsiClock - FSI Clock used for transfers txUserData - User data to be sent with Data frame
txDataFrameTag - Frame tag used for Data transfers txPingFrameTag - Frame tag used for Ping transfers
txPingTimeRefCntr - Tx Ping timer reference counter rxWdTimeoutRefCntr - Rx Watchdog timeout reference
counter

External Connections

For FSI external P2P connection, external connections are required to be made between two devices. Device
1’s FSI TX and RX pins need to be connected to device 2's FSI RX and TX pins respectively. See below for
external connections to make and GPIOs used:

External connections required between independent RX and TX devices:

m FSIRX_CLKto FSITX_CLK
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m FSIRX_RXO0 to FSITX_TX0
m FSIRX_RX1 to FSITX_TX1

ControlCard FSI Header GPIOs:

= GPIO_27 -> FSITX_CLK
= GPIO_26 -> FSITX_TX0
= GPIO_25 -> FSITX_TX1
= GPIO_13 -> FSIRX_CLK
= GPIO_12 -> FSIRX_RX0
= GPIO_11 -> FSIRX_RX1

Watch Variables

m dataFrameCntr Number of Data frame transmitted
m error Non zero for transmit/receive data mismatch

6.160 Device GPIO Setup

Configures the device GPIO into two different configurations This code is verbose to illustrate how the GPIO
could be setup. In a real application, lines of code can be combined for improved code size and efficiency.

This example only sets-up the GPIO. Nothing is actually done with the pins after setup.

In general:

All pullup resistors are enabled. For ePWMs this may not be desired.
Input qual for communication ports (CAN, SPI, SCI, 12C) is asynchronous
Input qual for Trip pins (TZ) is asynchronous

Input qual for eCAP and eQEP signals is synch to SYSCLKOUT

Input qual for some I/O’s and __interrupts may have a sampling window

6.161 Device GPIO Toggle

Configures the device GPIO through the sysconfig file. The GPIO pin is toggled in the infinite loop. In order to
migrate the project within syscfg to any device, click the swtich button under the device view and select your
corresponding device to migrate, saving the project will auto-migrate your project settings.

Note:
: This example project has support for migration across our C2000 device families. If you are
wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you'’re using. At any time you can select another device to migrate this example.
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6.162 Device GPIO Interrupt

Configures the device GPIOs through the sysconfig file. One GPIO output pin, and one GPIO input pin is
configured. The example then configures the GPIO input pin to be the source of an external interrupt which
toggles the GPIO output pin.

6.163 External Interrupt (XINT)

In this example AIO pins are configured as digital inputs. Two other GPIO signals (connected externally to
AlO pins) are toggled in software to trigger external interrupt through AlO225 and Al0226 (AlO225 assigned to
XINT1 and AlO226 assigned to XINT2). The user is required to externally connect these signals for the program
to work properly. Each interrupt is fired in sequence: XINT1 first and then XINT2.

GPIO5 will go high outside of the interrupts and low within the interrupts. This signal can be monitored on a
scope. External Connections

m Connect GPIOO0 to Al0225. AlO225 will be assigned to XINT1
m Connect GPIO1 to Al0226. AlO0226 will be assigned to XINT2
m GPIO5 can be monitored on an oscilloscope

Watch Variables

m xint1Count for the number of times through XINT1 interrupt
m xint2Count for the number of times through XINT2 interrupt
m |loopCount for the number of times through the idle loop

6.164 HRCAP Capture and Calibration Example

This example configures an ECAP to use HRCAP functionality to capture time between edges on input GP102.
External Connections

The user must provide a signal to GPIO2. XCLKOUT has been configured to an output GPIO and can be
externally jumped to serve this purpose. See Sysconfig file for XCLKOUT GPIO selected.

Watch Variables

m onTimel, onTime2
m offTime1, offTime2
m period1, period2

6.165 HRPWM Duty Control with SFO

This example modifies the MEP control registers to show edge displacement for high-resolution period with
ePWM in Up count mode due to the HRPWM control extension of the respective ePWM module.
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This example calls the following TI's MEP Scale Factor Optimizer (SFO) software library V8 functions:
int SFO();

m updates MEP_ScaleFactor dynamically when HRPWM is in use

m updates HRMSTEP register (exists only in EPwm1Regs register space) with
MEP_ScaleFactor value

m returns 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion
may not function properly under this condition)

m returns 1 when complete for the specified channel
m returns 0 if not complete for the specified channel

This example only uses 4 EPWMs. If all the EPWMs modules are being used then all the 3 HRPWMCAL
modules should be caliberated. Here only one is being caliberated. For more details you can refer to the
bitfield example C2000Ware. This example is intended to explain the HRPWM capabilities. The code can be
optimized for code efficiency. Refer to TI's Digital power application examples and TI Digital Power Supply
software libraries for details.

External Connections

m Monitor ePWM1/2/3/4 A/B pins on an oscilloscope.

HRPWM Slider

This example modifies the MEP control registers to show edge displacement due to HRPWM. Control blocks of
the respective ePWM module channel A and B will have fine edge movement due to HRPWM logic.

Monitor ePWM1 A/B pins on an oscilloscope.

HRPWM Period Control

This example modifies the MEP control registers to show edge displacement for high-resolution period with
ePWM in Up-Down count mode due to the HRPWM control extension of the respective ePWM module.

This example calls the following TI's MEP Scale Factor Optimizer (SFO) software library V8 functions:
int SFO();

m updates MEP_ScaleFactor dynamically when HRPWM is in use

m updates HRMSTEP register (exists only in EPwm1Regs register space) with
MEP_ScaleFactor value

m returns 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion
may not function properly under this condition)

m returns 1 when complete for the specified channel
m returns 0 if not complete for the specified channel

This example is intended to explain the HRPWM capabilities. The code can be optimized for code efficiency.
Refer to TI's Digital power application examples and TI Digital Power Supply software libraries for details.

External Connections
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m Monitor ePWM1/2/3/4 A/B pins on an oscilloscope.

HRPWM Duty Control with UPDOWN Mode

This example calls the following TI's MEP Scale Factor Optimizer (SFO) software library V8 functions:
int SFO();

m updates MEP_ScaleFactor dynamically when HRPWM is in use

m updates HRMSTEP register (exists only in EPwm1Regs register space) with
MEP_ScaleFactor value

m returns 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion
may not function properly under this condition)

m returns 1 when complete for the specified channel
m returns 0 if not complete for the specified channel

This example is intended to explain the HRPWM capabilities. The code can be optimized for code efficiency.
Refer to TI's Digital power application examples and Tl Digital Power Supply software libraries for details.

External Connections

m Monitor ePWM1/2/3/4 A/B pins on an oscilloscope.

HRPWM Slider Test

This example modifies the MEP control registers to show edge displacement due to HRPWM. Control blocks of
the respective ePWM module channel A and B will have fine edge movement due to HRPWM logic. Load the
hrpwm_slider.gel file. Select the HRPWM_eval from the GEL menu. A FineDuty slider graphics will show up in
CCS. Load the program and run. Use the Slider to and observe the EPWM edge displacement for each slider
step change. This explains the MEP control on the EPwmxA channels.

Monitor ePWM1 & ePWM2 A/B pins on an oscilloscope.

HRPWM Duty Up Count

This example modifies the MEP control registers to show edge displacement for high-resolution period with
ePWM in Up count mode due to the HRPWM control extension of the respective ePWM module.

This example calls the following TI's MEP Scale Factor Optimizer (SFO) software library V8 functions:
int SFO();

m updates MEP_ScaleFactor dynamically when HRPWM is in use

m updates HRMSTEP register (exists only in EPwm1Regs register space) with
MEP_ScaleFactor value

m returns 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion
may not function properly under this condition)
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m returns 1 when complete for the specified channel
m returns 0 if not complete for the specified channel

This example is intended to explain the HRPWM capabilities. The code can be optimized for code efficiency.
Refer to TI's Digital power application examples and Tl Digital Power Supply software libraries for details.

To run this example:

1. Run this example at maximum SYSCLKOUT
2. Activate Real time mode
3. Run the code

External Connections
m Monitor ePWM?1/2 A/B pins on an oscilloscope.
Watch Variables

m status - Example run status

m updateFine - Set to 1 use HRPWM capabilities and observe in fine MEP steps(default) Set to
0 to disable HRPWM capabilities and observe in coarse SYSCLKOUT cycle steps

HRPWM Period Up-Down Count

This example modifies the MEP control registers to show edge displacement for high-resolution period with
ePWM in Up-Down count mode due to the HRPWM control extension of the respective ePWM module.

This example calls the following TI's MEP Scale Factor Optimizer (SFO) software library V8 functions:
int SFO();

m updates MEP_ScaleFactor dynamically when HRPWM is in use

m ypdates HRMSTEP register (exists only in EPwm1Regs register space) with
MEP_ScaleFactor value

m returns 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion
may not function properly under this condition)

m returns 1 when complete for the specified channel
m returns 0 if not complete for the specified channel

This example is intended to explain the HRPWM capabilities. The code can be optimized for code efficiency.
Refer to TI's Digital power application examples and Tl Digital Power Supply software libraries for details.

To run this example:

1. Run this example at maximum SYSCLKOUT
2. Activate Real time mode
3. Run the code

External Connections
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m Monitor ePWM1/2 A/B pins on an oscilloscope.
Watch Variables

m updateFine - Set to 1 use HRPWM capabilities and observe in fine MEP steps(default) Set to
0 to disable HRPWM capabilities and observe in coarse SYSCLKOUT cycle steps

6.172 HRPWM XCMP Mode

This example modifies the MEP control registers to show edge displacement for high-resolution period with
ePWM in Up count mode due to the HRPWM control extension of the respective ePWM module.

This example calls the following TI's MEP Scale Factor Optimizer (SFO) software library V8 functions:
int SFO();

m updates MEP_ScaleFactor dynamically when HRPWM is in use

m updates HRMSTEP register (exists only in EPwm1Regs register space) with
MEP_ScaleFactor value

m returns 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion
may not function properly under this condition)

m returns 1 when complete for the specified channel

m returns 0 if not complete for the specified channel

This example is intended to explain the XCMP MODE with HRPWM capabilities. The code can be optimized for
code efficiency. Refer to TI's Digital power application examples and Tl Digital Power Supply software libraries
for details.

m ePWM1A is allocated for XCMP1-4 and ePWM1B is allocated XCMP5-8 registers.
* No Shadow registers used External Connections
» Monitor ePWM1 A/B pins on an oscilloscope.
» ePWM1A is on GPIO0
« ePWM1B is on GPIO1 ###t##HHH#HHHHHHHEHHHHHHHAHH A

6.173 HRPWM Duty Control with AHC Deadband

This example implements High-Resolution EPWM duty control capability. The example begins with a basic
Active-High Complementary (AHC) output on channels A and B of the EPWM module(s) by using the Dead
Band submodule to apply rising and falling edge delays on channel A and B respectively. High-Resolution
duty control is then applied on both A/B channels of the EPWM module(s). HR duty control is implemented by
applying the CMPAHR (for channel A) and CMPBHR (for channel B) values to control both edges of both EPWM
channel outputs with finer granularity. The duty cycle of the EPWM module(s) are updated with calculations
performed in main(). This example also calls the following TI's MEP Scale Factor Optimizer (SFO) software
library V8 functions:

int SFO();

m Updates MEP_ScaleFactor dynamically when HRPWM is in use
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Updates HRMSTEP register (exists only in EPwm1Regs register space) with
MEP_ScaleFactor value

Returns 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion
may not function properly under this condition)

Returns 1 when complete for the specified channel

Returns 0 if not complete for the specified channel
This example is intended to explain the HRPWM capabilities. The code can be optimized for code efficiency.
Refer to TI's Digital power application examples and Tl Digital Power Supply software libraries for details.

External Connections

m Monitor ePWM1/2/3/4 A/B pins on an oscilloscope.

12C Digital Loopback with FIFO Interrupts

This program uses the internal loopback test mode of the 12C module. Both the TX and RX 12C FIFOs and their
interrupts are used. The pinmux and I2C initialization is done through the sysconfig file.

A stream of data is sent and then compared to the received stream. The sent data looks like this:
0000 0001
0001 0002
0002 0003

OOFE 00FF
00FF 0000
etc..

This pattern is repeated forever.

Note:
This example project has support for migration across our C2000 device families. If you are
wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you'’re using. At any time you can select another device to migrate this example.

External Connections
® None
Watch Variables

m sData - Data to send
m rData - Received data
m rDataPoint - Used to keep track of the last position in the receive stream for error checking
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12C EEPROM

This program will write 1-14 words to EEPROM and read them back. The data written and the EEPROM
address written to are contained in the message structure, i2cMsgOut. The data read back will be contained in
the message structure i2cMsgin.

External Connections

m Connect external 12C EEPROM at address 0x50
m Connect DEVICE_GPIO_PIN_SDAA on to external EEPROM SDA (serial data) pin
m Connect DEVICE_GPIO_PIN_SCLA on to external EEPROM SCL (serial clock) pin

Watch Variables

m i2cMsgOut - Message containing data to write to EEPROM
m i2cMsgln - Message containing data read from EEPROM

I12C Digital External Loopback with FIFO Interrupts

This program uses the 12CA and 12CB modules for achieving external loopback. The I2CA TX FIFO and the
[2CB RX FIFO are used along with their interrupts.

A stream of data is sent on I2CA and then compared to the received stream on 12CB. The sent data looks like
this:

0000 0001
0001 0002
0002 0003

00FE 00FF

00FF 0000

etc..

This pattern is repeated forever.

External Connections
m Connect SCLA(DEVICE_GPIO_PIN_SCLA) to SCLB (DEVICE_GPIO_PIN_SCLB)

m and SDAA(DEVICE_GPIO_PIN_SDAA) to SDAB (DEVICE_GPIO_PIN_SDAB)
m Connect DEVICE_GPIO_PIN_LED1 to an LED used to depict data transfers.

Watch Variables

m sData - Data to send
m rData - Received data
m rDataPoint - Used to keep track of the last position in the receive stream for error checking
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12C EEPROM

This program will shows how to perform different EEPROM write and read commands using 12C polling method
EEPROM used for this example is AT24C256

External Connections

m Connect external 12C EEPROM at address 0x50 Signal | I12CA
| EEPROM SCL | DEVICE_GPIO_PIN_SCLA | SCL SDA | DE-
VICE_GPIO_PIN_SDAA | SDA Make sure to connect GND pins if EEPROM and C2000 device
are in different board.

12C controller target communication using FIFO interrupts

This program shows how to use 12CA and 12CB modules in both controller and target configuration This example
uses 12C FIFO interrupts and doesn’t using polling

Example1: 12CA as controller Transmitter and 12CB working target Receiver Example2: 12CA as controller
Receiver and 12CB working target Transmitter Example3: 12CB as controller Transmitter and I12CA working
target Receiver Example4: I12CB as controller Receiver and I2CA working target Transmitter

External Connections on launchpad should be made as shown below

Signal | I2CA | 12CB SCL | DEVICE_GPIO_PIN_SCLA | DE-
VICE_GPIO_PIN_SCLB SDA | DEVICE_GPIO_PIN_SDAA | DEVICE_GPIO_PIN_SDAB

Watch Variables in memory window

I2CA_TXdata
I12CA_RXdata
12CB_TXdata
12CB_RXdata stream for error checking

HHRHA R R

12C EEPROM

This program will shows how to perform different EEPROM write and read commands using 12C interrupts
EEPROM used for this example is AT24C256

External Connections

m Connect external 12C EEPROM at address 0x50 Signal | I12CA
| EEPROM SCL | DEVICE_GPIO_PIN_SCLA | SCL SDA | DE-
VICE_GPIO_PIN_SDAA | SDA Make sure to connect GND pins if EEPROM and C2000 device
are in different board. Example 1: EEPROM Byte Write Example 2:
EEPROM Byte Read Example 3: EEPROM word (16-bit) write Example 4: EEPROM word
(16-bit) read Example 5: EEPROM Page write Example 6: EEPROM word Paged read
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Watch Variables

m TX_MsgBuffer - Message buffer which stores the data to be transmitted
m RX_MsgBuffer - Message buffer which stores the data to be received

HHBHH R R

External Interrupts (Externalinterrupt)

This program sets up GPIO0 as XINT1 and GPIO1 as XINT2. Two other GPIO signals are used to trigger the
interrupt (GP10O10 triggers XINT1 and GPIO11 triggers XINT2). The user is required to externally connect these
signals for the program to work properly.

XINT1 input is synced to SYSCLKOUT.
XINT2 has a long qualification - 6 samples at 510«SYSCLKOUT each.

GPIO16 will go high outside of the interrupts and low within the interrupts. This signal can be monitored on a
scope.

Each interrupt is fired in sequence - XINT1 first and then XINT2

External Connections

m Connect GPIO10 to GPIO0. GPIOO0 will be assigned to XINT1
m Connect GPIO11 to GPIO1. GPIO1 will be assigned to XINT2

Monitor GPIO16 with an oscilloscope. GPIO16 will be high outside of the ISRs and low within each ISR.
Watch Variables

m xint1Count for the number of times through XINT1 interrupt
m xint2Count for the number of times through XINT2 interrupt
m |oopCount for the number of times through the idle loop

Multiple interrupt handling of 12C, SCI & SPI Digital Loop-
back

This program is used to demonstrate how to handle multiple interrupts when using multiple communication
peripherals like 12C, SCI & SPI Digital Loopback all in a single example. The data transfers would be done with
FIFO Interrupts.

It uses the internal loopback test mode of these modules. Both the TX and RX FIFOs and their interrupts are
used. Other than boot mode pin configuration, no other hardware configuration is required.

A stream of data is sent and then compared to the received stream. The sent data looks like this for 12C and
SCl:

0000 0001
0001 0002
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0002 0003

OOFE O00FF
00FF 0000

etfc..

The sent data looks like this for SPI:

0000 0001
0001 0002
0002 0003

FFFE FFFF
FFFF 0000

etc..

This pattern is repeated forever.

External Connections

Watch Variables

None

sDatai2cA - Data to send through 12C
rDatai2cA - Received 12C data
rDataPoint - Used to keep track of the last position in the receive 12C stream for error checking

sDataspiA - Data to send through SPI
rDataspiA - Received SPI data

rDataPointspiA - Used to keep track of the last position in the receive SPI stream for error
checking

sDatasciA - SCI Data being sent
rDatasciA - SCl Data received

rDataPointA - Keep track of where we are in the SCI data stream. This is used to check the
incoming data

6.182 CPU Timer Interrupt Software Prioritization

This examples demonstrates the software prioritization of interrupts through CPU Timer Interrupts. Software
prioritization of interrupts is achieved by enabling interrupt nesting.

In this device, hardware priorities for CPU Timer 0, 1 and 2 are set as timer 0 being highest priority and timer
2 being lowest priority. This example configures CPU Timer0, 1, and 2 priority in software with timer 2 priority
being highest and timer 0 being lowest in software and prints a trace for the order of execution.
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For most applications, the hardware prioritizing of the interrupts is sufficient. For applications that need cus-
tom prioritizing, this example illustrates how this can be done through software.User specific priorities can be
configured in sw_prioritized_isr_level.h header file.

To enable interrupt nesting, following sequence needs to followed in ISRs. Step 1: Set the global priority:
Modify the IER register to allow CPU interrupts with a higher user priority to be serviced. Note: at this time IER
has already been saved on the stack. Step 2: Set the group priority: (optional) Modify the appropriate PIEIERx
register to allow group interrupts with a higher user set priority to be serviced. Do NOT clear PIEIER register
bits from another group other than that being serviced by this ISR. Doing so can cause erroneous interrupts to
occur. Step 3: Enable interrupts: There are three steps to do this: a. Clear the PIEACK bits b. Wait at least
one cycle c. Clear the INTM bit. Step 4: Run the main part of the ISR Step 5: Set INTM to disable interrupts.
Step 6: Restore PIEIERXx (optional depending on step 2) Step 7: Return from ISR

Refer to below link on more details on Interrupt nesting in C28x devices: <C2000Ware>.html

External Connections
m None
Watch Variables

m tracelSR - shows the order in which ISRs are executed.

EPWM Real-Time Interrupt

This example configures the ePWM1 Timer and increments a counter each time the ISR is executed. ePWM
interrupt can be configured as time critical to demonstrate real-time mode functionality and real-time interrupt
capability.

The example uses 2 LEDs - LED1 is toggled in the main loop and LED2 is toggled in the EPWM Timer Inter-

rupt. FREE_SOFT bits and DBGIER.INT3 bit must be set to enable ePWM1 interrupt to be time critical and
operational in real time mode after halt command

How to run the example?

m Add the watch variables as mentioned below and enable Continuous Refresh.
m Enable real-time mode (Run->Advanced->Enable Silicon Real-time Mode)

m |nitially, the DBGIER register is set to 0 and the EPWM emulation mode is set to
EPWM_EMULATION_STOP_AFTER_NEXT_TB (FREE_SOFT = 0)

m When the application is running, you will find both LEDs toggling and the watch variables
EPwm1TimerIntCount, EPwm1Regs. TBCTR getting updated.

m When the application is halted, both LEDs stop toggling and the watch variables remain con-
stant. EPWM counter is stopped on debugger halt.

m To enable EPWM counter run during debugger halt, set emulation mode as
EPWM_EMULATION_FREE_RUN (FREE_SOFT = 2). You will find EPwm1Regs.TBCTR is
running, but EPwm1TimerIntCount remains constant. This means, the EPWM counter is run-
ning, but the ISRs are not getting serviced.

m To enable real-time interrupts, set DBGIER.INT3 = 1 (EPWM1 interrupt is part of PIE Group
3). You will find that the EPwm1TimerIntCount is incrementing and the LED starts toggling.
The EPWM ISR is getting serviced even during a debugger halt.
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For more details, watch this video : [C2000 Real-Time Features](https://training.ti.com/c2000-real-time-
features)

External Connections
= None
Watch Variables

m EPwm1TimerIntCount - EPWM1 ISR counter

m EPwm1Regs. TBCTR.TBCTR - EPWM1 Time Base counter

m EPwm1Regs. TBCTL.FREE_SOFT - Set this to 2 to enable free run
m DBGIER.INT3 - Set to 1 to enable real time interrupt

F28P65X LaunchPad Out of Box Demo Example

This program is the demo program that comes pre-loaded on the F28P65X LaunchPad development kit. The
program starts by flashing the two user LEDs. After a few seconds the LEDs stop flashing and the device starts
sampling ADCINA4 once a second. If the sample is greater than midscale the red LED on the board is lit, while
if it is lower the green LED is lit. Sample data is also displayed in a serial terminal via the board’s back channel
UART. You may view this data by configuring a serial terminal to the correct COM port at 115200 Baud 8-N-1.

External Connections

m Connect to COM port at 115200 Baud 8-N-1 for serial data
m Connect signal to ADCINA4 to change LED based on value

Watch Variables

= None.

LIN Internal Loopback with Interrupts

This example configures the LIN module in commander mode for internal loopback with interrupts. The module
is setup to perform 8 data transmissions with different transmit IDs and varying transmit data. Upon reception
of an ID header, an interrupt is triggered on line 0 and an interrupt service routine (ISR) is called. The received
data is then checked for accuracy.

Note:
The example can be adjusted to use interrupt line 1 instead of line 0 by un-commenting
"LIN_setInterruptLevel1()"
External Connections

= None.

Watch Variables
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m txData - An array with the data being sent

rxData - An array with the data that was received

result - The example completion status (PASS = 0xABCD, FAIL = OxFFFF)
level0Count - The number of line 0 interrupts

level1Count - The number of line 1 interrupts

LIN SCI Mode Internal Loopback with Interrupts

This example configures the LIN module in SCI mode for internal loopback with interrupts. The LIN module
performs as a SCI with a set character and frame length in a non-multi-buffer mode. The module is setup to
continuously transmit a character, wait to receive that character, and repeat.

External Connections
= None.
Watch Variables

m rxCount - The number of RX interrupts
m transmitChar - The character being transmitted
m receivedChar - The character received

LIN SCI MODE Internal Loopback with DMA

This example configures the LIN module in SCI mode for internal loopback with the use of the DMA. The LIN
module performs as SCI with a set character and frame length in multi-buffer mode. When the transmit buffers
in the LINTDO and LINTD1 registers have enough space, the DMA will transfer data from global variable sData
into those transmit registers. Once the received buffers in the LINRDO and LINRD1 registers contain data,the
DMA will transfer the data into the global variable rdata.

When all data has been placed into rData, a check of the validity of the data will be performed in one of the
DMA channels’ ISRs.

External Connections
m None
Watch Variables

m sData - Data to send
m rData - Received data

LIN Internal Loopback without interrupts(polled mode)

This example configures the LIN module in commander mode for internal loopback without interrupts. The
module is setup to perform 8 data transmissions with different transmit IDs and varying transmit data. Waits for
reception of an ID header. The received data is then checked for accuracy.
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External Connections
= None.
Watch Variables

m txData - An array with the data being sent
m rxData - An array with the data that was received
m result - The example completion status (PASS = 0xABCD, FAIL = OxFFFF)

LIN Internal Loopback with Interrupts using Sysconfig

This example is similar to ex1 but using syscfg tool to configure the LIN Module parameters. The file
lin_ex5_syscfg.syscfg can be updated using the GUI tool to update the configuration parameters. This ex-
ample configures the LIN module in commander mode for internal loopback with interrupts. The module is
setup to perform 8 data transmissions with different transmit IDs and varying transmit data. Upon reception of
an ID header, an interrupt is triggered on line 0 and an interrupt service routine (ISR) is called. The received
data is then checked for accuracy.

Note:
This example project has support for migration across our C2000 device families. If you are
wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you're using. At any time you can select another device to migrate this example.

External Connections
= None.
Watch Variables

m txData - An array with the data being sent

m rxData - An array with the data that was received

m result - The example completion status (PASS = 0xABCD, FAIL = OxFFFF)
m |evel0Count - The number of line 0 interrupts

LIN Incomplete Header Detection

This example demonstrates how an error in the header field of a LIN frame can be detected. It configures the
LIN module in responder mode and waits till new frame is received. It configures an external interrupt to trigger
by a falling edge in the LIN Rx pin confirming start of frame. In the ISR of XINT, a timer is configured to trigger
after max time consumed by reception of a complete LIN frame. If a LIN frame is successfully received the timer
is disabled before getting triggered in the LIN ISR else the timer ISR is called which indicates an error in header
frame.

External Connections

m LINATX/RX to host node via transciever.
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Watch Variables

m linHeaderError - Number of times header error was detected
m rxData - An array with the data that was received if successful reception
m xint1Count - Number of timer XINT triggered

LIN External Loopback without interrupts(polled mode)

This example configures the LINA module in commander mode and LINB module in responder mode. Com-
mander transmits 8 byte data to the responder with a matching ID configured in responder Receive ID. The
received data is then checked for accuracy.

External Connections
m Connect LINA TX/RX with LINB TX/RX via transciever.
Watch Variables

m txData - An array with the data being sent
m rxData - An array with the data that was received
m result - The example completion status (PASS = 0xABCD, FAIL = OxFFFF)

LIN SCI MODE (Single Buffer) Internal Loopback with DMA

This example configures the LIN module in SCI mode for internal loopback with the use of the DMA. The LIN
module performs as SCI with a set character and frame length in single-buffer compatibility mode. When the
transmit buffer i.e. the SCITD register is free, the DMA will transfer data from global variable sData into this
register. Once the received buffer, i.e. the SCIRD register contains data, the DMA will transfer the data into the
global variable rdata.

When all data has been placed into rData, a check of the validity of the data will be performed in one of the
DMA channels’ ISRs.

External Connections
m None
Watch Variables

m sData - Data to send
m rData - Received data

Low Power Modes: Device Idle Mode and Wakeup using
GPIO

This example puts the device into IDLE mode and then wakes up the device from IDLE using XINT1 which
triggers on a falling edge of GPIOO0.
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The GPIOO0 pin must be pulled from high to low by an external agent for wakeup. GPIOO is configured as an
XINT1 pin to trigger an XINT1 interrupt upon detection of a falling edge.

Initially, pull GPIOO0 high externally. To wake device from IDLE mode by triggering an XINT1 interrupt, pull
GPIOO low (falling edge). The wakeup process begins as soon as GPIOO is held low for the time indicated in
the device datasheet.

GPIO1 is pulled high before entering the IDLE mode and is pulled low when in the external interrupt ISR.
External Connections

m GPIOO0 needs to be pulled low to wake up the device.
m On device wakeup, the GPIO1 will be low and LED1 will start blinking

Low Power Modes: Device Idle Mode and Wakeup using
Watchdog

This example puts the device into IDLE mode and then wakes up the device from IDLE using watchdog timer.

The device wakes up from the IDLE mode when the watchdog timer overflows, triggering an interrupt. A pre
scalar is set for the watchdog timer to change the counter overflow time.

GPIO1 is pulled high before entering the IDLE mode and is pulled low when in the wakeup ISR.

External Connections

m On device wakeup, the GPIO1 will be low and LED1 will start blinking

Low Power Modes: Device Standby Mode and Wakeup using
GPIO

This example puts the device into STANDBY mode. If the lowest possible current consumption in STANDBY
mode is desired, the JTAG connector must be removed from the device board while the device is in STANDBY
mode.

This example puts the device into STANDBY mode and then wakes up the device from STANDBY using an LPM
wakeup pin.

The pin GPIOO is configured as the LPM wakeup pin to trigger a WAKEINT interrupt upon detection of a low
pulse. Initially, pull GPIOO0 high externally. To wake device from STANDBY mode, pull GPIOO0 low for at least
(2+QUALSTDBY), OSCLKS, then pull it high again.

The example then wakes up the device from STANDBY using GP100. GPIO0 wakes the device from STANDBY
mode when a low pulse (signal goes high->low->high)is detected on the pin. This pin must be pulsed by an
external agent for wakeup.

GPIO1 is pulled high before entering the STANDBY mode and is pulled low when in the wakeup ISR.
External Connections

m GPIOO0 needs to be pulled low to wake up the device.
m On device wakeup, the GPIO1 will be low and LED1 will start blinking
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Low Power Modes: Device Standby Mode and Wakeup using
Watchdog

This example puts the device into STANDBY mode. If the lowest possible current consumption in STANDBY
mode is desired, the JTAG connector must be removed from the device board while the device is in STANDBY
mode.

This example puts the device into STANDBY mode then wakes up the device from STANDBY using watchdog
timer.

The device wakes up from the STANDBY mode when the watchdog timer overflows triggering an interrupt. In
the ISR, the GPIO1 is pulled low. the GPIO1 is toggled to indicate the device is out of STANDBY mode. A pre
scalar is set for the watchdog timer to change the counter overflow time.

GPIO1 is pulled high before entering the STANDBY mode and is pulled low when in the wakeup ISR.

External Connections

m On device wakeup, the GPIO1 will be low and LED1 will start blinking

Low Power Modes: Halt Mode and Wakeup using GPIO

This example puts the device into HALT mode. If the lowest possible current consumption in HALT mode is
desired, the JTAG connector must be removed from the device board while the device is in HALT mode.

For applications that require minimal power consumption during HALT mode, application software should power
off the XTAL prior to entering HALT by setting the XTALCR.OSCOFF bit or by using the driverlib function
SysCitl_turnOffOsc(SYSCTL_OSCSRC_XTAL);. If the OSCCLK source is configured to be XTAL, the appli-
cation should first switch the OSSCLK source to INTOSC1 or INTOSC2 prior to setting XTALCR.OSCOFF.

This example puts the device into HALT mode and then wakes up the device from HALT using an LPM wakeup
pin.

The pin GPIOO is configured as the LPM wakeup pin to trigger a WAKEINT interrupt upon detection of a low
pulse.The GPIOO0 pin must be pulled from high to low by an external agent for wakeup.

GPIO1 is pulled high before entering the STANDBY mode and is pulled low when in the wakeup ISR.

External Connections

m On device wakeup, the GPIO1 will be low and LED1 will start blinking

Low Power Modes: Halt Mode and Wakeup

This example puts the device into HALT mode. If the lowest possible current consumption in HALT mode is
desired, the JTAG connector must be removed from the device board while the device is in HALT mode.

For applications that require minimal power consumption during HALT mode, application software should power
off the XTAL prior to entering HALT by setting the XTALCR.OSCOFF bit or by using the driverlib function
SysCitl_turnOffOsc(SYSCTL_OSCSRC_XTAL);. If the OSCCLK source is configured to be XTAL, the appli-
cation should first switch the OSSCLK source to INTOSC1 or INTOSC2 prior to setting XTALCR.OSCOFF.
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This example puts the device into HALT mode and then wakes up the device from HALT using an LPM wakeup
pin.

The pin GPIOO is configured as the LPM wakeup pin to trigger a WAKEINT interrupt upon detection of a low
pulse.The GPIOO0 pin must be pulled from high to low by an external agent for wakeup.

In this example, the watchdog timer is clocked, and is configured to produce watchdog reset as a timeout
mechanism.

GPIO1 is pulled high before entering the STANDBY mode and is pulled low when in the wakeup ISR.

External Connections

m On device wakeup, the GPIO1 will be low and LED1 will start blinking

MCAN Loopback with Interrupts Example Using SYSCON-
FIG Tool

This example illustrates the MCAN Loopback functionality. The internal loopback mode is entered. The mes-
sage transmitted would be received by the node. The last address of memory is used for the Rx buffer. Periph-
eral configuration is done through SYSCONFIG

External Connections
= None.
Watch Variables

m error - Checks if there is an error that occurred when the data was sent using internal loopback.

Correctable & Uncorrectable Memory Error Handling

This example demonstrates error handling in case of various erroneous memory read/write operations. Error
handling in case of CPU read/write violations, correctable & uncorrectable memory errors has been demon-
strated. Correctable memory errors & violations can generate SYS_INT interrupt to CPU while uncorrectable
errors lead to NMI generation.

External Connections
m None

Watch Variables

m testStatusGlobal - Equivalent to TEST_PASS if test finished correctly, else the value is set to
TEST_FAIL

= errCountGlobal - Error counter
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Empty SysCfg & Driverlib Example

This example is an empty project setup for SysConfig and Driverlib development.

Tune Baud Rate via UART Example

This example demonstrates the process of tuning the UART/SCI baud rate of a C2000 device based on the
UART input from another device. As UART does not have a clock signal, reliable communication requires baud
rates to be reasonably matched. This example addresses cases where a clock mismatch between devices
is greater than is acceptable for communications, requiring baud compensation between boards. As reliable
communication only requires matching the EFFECTIVE baud rate, it does not matter which of the two boards
executes the tuning (the board with the less-accurate clock source does not need to be the one to tune; as long
as one of the two devices tunes to the other, then proper communication can be established).

To tune the baud rate of this device, SCI data (of the desired baud rate) must be sent to this device. The in-
put SCI baud rate must be within the +/- MARGINPERCENT of the TARGETBAUD chosen below. These two
variables are defined below, and should be chosen based on the application requirements. Higher MARGIN-
PERCENT will allow more data to be considered "correct” in noisy conditions, and may decrease accuracy. The
TARGETBAUD is what was expected to be the baud rate, but due to clock differences, needs to be tuned for
better communication robustness with the other device.

NOTE: Lower baud rates have more granularity in register options, and therefore tuning is more affective at
these speeds.

Note:
This example project has support for migration across our C2000 device families. If you are
wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you're using. At any time you can select another device to migrate this example.

External Connections for Control Card

m SCIA_RX/eCAP1 is on GPIO9, connect to incoming SCI communications
m SCIA_TXis on GPIOS8, for observation externally

Watch Variables

m avgBaud - Baud rate that was detected and set after tuning

SCI FIFO Digital Loop Back

This program uses the internal loop back test mode of the peripheral. Other then boot mode pin configuration,
no other hardware configuration is required. The pinmux and SCI modules are configured through the sysconfig
file.

This test uses the loopback test mode of the SCI module to send characters starting with 0x00 through OxFF.
The test will send a character and then check the receive buffer for a correct match.
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Note:
This example project has support for migration across our C2000 device families. If you are
wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you'’re using. At any time you can select another device to migrate this example.

Watch Variables

m loopCount - Number of characters sent
m errorCount - Number of errors detected
m sendChar - Character sent

m receivedChar - Character received

SCI Digital Loop Back with Interrupts

This test uses the internal loop back test mode of the peripheral. Other then boot mode pin configuration, no
other hardware configuration is required. Both interrupts and the SCI FIFOs are used.

A stream of data is sent and then compared to the received stream. The SCI-A sent data looks like this:
00 01
0102
02 03

FE FF

FF 00

etc..

The pattern is repeated forever.
Watch Variables

m sDataA - Data being sent
m rDataA - Data received

m rDataPointA - Keep track of where we are in the data stream. This is used to check the
incoming data

SCI Echoback

This test receives and echo-backs data through the SCI-A port.

A terminal such as ’putty’ can be used to view the data from the SCI and to send information to the SCI.
Characters received by the SCI port are sent back to the host.

Running the Application Open a COM port with the following settings using a terminal:

m Find correct COM port
m Bits per second = 9600
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m Data Bits =8

m Parity = None

m Stop Bits = 1

m Hardware Control = None

The program will print out a greeting and then ask you to enter a character which it will echo back to the terminal.
Watch Variables

m |loopCounter - the number of characters sent

External Connections
Connect the USB cable from Control card J1:A to PC

stdout redirect example

This test transmits data through the SCI-A port to a terminal

A terminal such as 'putty’ can be used to view the data from the SCI. Characters received by the SCI port are
sent back to the host.

Running the Application Open a COM port with the following settings using a terminal:

m Find correct COM port
Bits per second = 9600
Data Bits = 8

Parity = None

Stop Bits = 1

Hardware Control = None

The program will print out three sentences: one to the SCIA, one to CCS, and a final one to SCIA.
External Connections
Connect the SCI-A port to a PC via a transceiver and cable.

m DEVICE_GPIO_PIN_SCIRXDA is SCI_A-RXD (Connect to Pin3, PC-TX, of serial DB9 cable)
m DEVICE_GPIO_PIN_SCITXDA is SCI_A-TXD (Connect to Pin2, PC-RX, of serial DB9 cable)

SDFM Filter Sync CPU

In this example, SDFM filter data is read by CPU in SDFM ISR routine. The SDFM configuration is shown
below:

m SDFM used in this example - SDFM1

m Input control mode selected - MODEQ

m Comparator settings
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 Sinc3 filter selected
+ OSR =32
* HLT = 0x7FFF (Higher threshold setting)
* LLT = 0x0000(Lower threshold setting)
m Data filter settings

« All the 4 filter modules enabled

Sinc3 filter selected

OSR =128

All the 4 filters are synchronized by using MFE (Master Filter enable bit)

Filter output represented in 16 bit format

In order to convert 25 bit Data filter into 16 bit format user needs to right shift by 7 bits for
Sinc3 filter with OSR = 128

m Interrupt module settings for SDFM filter

« All the 4 higher threshold comparator interrupts disabled

 All the 4 lower threshold comparator interrupts disabled

* All the 4 modulator failure interrupts disabled

« All the 4 filter will generate interrupt when a new filter data is available.

External Connections

m SDFM_PIN_MUX_OPTION1 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPIO16-GPIO31

m SDFM_PIN_MUX_OPTION2 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GP1048-GPI063

m SDFM_PIN_MUX_OPTION3 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPI0122-GPIO137

Watch Variables

m filter1Result - Output of filter 1
m filter2Result - Output of filter 2
m filter3Result - Output of filter 3
m filter4Result - Output of filter 4

6.208 SDFM Filter Sync CLA

In this example, SDFM filter data is read by CLA in Cla1Task1. The SDFM configuration is shown below:

m SDFM1 used in this example.For using SDFM2, few modifications would be needed in the
example.

m MODEQ Input control mode selected
m Comparator settings

« Sinc3 filter selected
« OSR =32
* hit = Ox7FFF (Higher threshold setting)
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* [It = 0x0000(Lower threshold setting)
m Data filter settings
* All the 4 filter modules enabled
Sinc3 filter selected
OSR =256
All the 4 filters are synchronized by using MFE (Master Filter enable bit)
Filter output represented in 16 bit format

In order to convert 25 bit Data filter into 16 bit format user needs to right shift by 10 bits
for Sinc3 filter with OSR = 256

m |nterrupt module settings for SDFM filter
« All the 4 higher threshold comparator interrupts disabled
 All the 4 lower threshold comparator interrupts disabled
* All the 4 modulator failure interrupts disabled
« All the 4 filter will generate interrupt when a new filter data is available

External Connections

m SDFM_PIN_MUX_OPTION1 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPIO16-GPIO31

m SDFM_PIN_MUX_OPTION2 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GP1048-GP1063

m SDFM_PIN_MUX_OPTION3 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPI0122-GPIO137

Watch Variables

m filter1Result - Output of filter 1
m filter2Result - Output of filter 2
m filter3Result - Output of filter 3
m filter4Result - Output of filter 4

6.209 SDFM Filter Sync DMA

In this example, SDFM filter data is read by DMA. The SDFM configuration is shown below:

m SDFM1 used in this example. For using SDFM2, few modifications would be needed in the
example.

= MODEQO Input control mode selected
m Comparator settings

« Sinc3 filter selected
+ OSR =32
* hit = Ox7FFF (Higher threshold setting)
* lIt = 0x0000(Lower threshold setting)
m Data filter settings

¢ All the 4 filter modules enabled
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Sinc3 filter selected

OSR =256

All the 4 filters are synchronized by using MFE (Master Filter enable bit)
Filter output represented in 16 bit format

In order to convert 25 bit Data filter into 16 bit format user needs to right shift by 10 bits
for Sinc3 filter with OSR = 256

m Interrupt module settings for SDFM filter
 All the 4 higher threshold comparator interrupts disabled
 All the 4 lower threshold comparator interrupts disabled
« All the 4 modulator failure interrupts disabled
« All the 4 filter will generate interrupt when a new filter data is available

External Connections

m SDFM_PIN_MUX_OPTION1 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPIO16-GPIO31

m SDFM_PIN_MUX_OPTION2 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GP1048-GPI063

m SDFM_PIN_MUX_OPTION3 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPI0122-GPI0137

Watch Variables

m filter1Result - Output of filter 1
m filter2Result - Output of filter 2
m filter3Result - Output of filter 3
m filter4Result - Output of filter 4

6.210 SDFM PWM Sync

In this example, SDFM filter data is read by CPU in SDFM ISR routine. The SDFM configuration is shown
below:

m SDFM1 is used in this example. For using SDFM2, few modifications would be needed in the
example.

= MODEQO Input control mode selected
m Comparator settings

« Sinc3 filter selected

+ OSR =32

* hlt = 0x7FFF (Higher threshold setting)
* [It = 0x0000(Lower threshold setting)

Data filter settings

m All the 4 filter modules enabled
m Sinc3 filter selected
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m OSR = 256
m All the 4 filters are synchronized by using PWM (Master Filter enable bit)
m Filter output represented in 16 bit format
m In order to convert 25 bit Data filter into 16 bit format user needs to right shift by 10 bits for
Sinc3 filter with OSR = 256
Interrupt module settings for SDFM filter

m All the 4 higher threshold comparator interrupts disabled

m All the 4 lower threshold comparator interrupts disabled

m All the 4 modulator failure interrupts disabled

m All the 4 filter will generate interrupt when a new filter data is available

External Connections

m SDFM_PIN_MUX_OPTION1 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPIO16-GPIO31

m SDFM_PIN_MUX_OPTION2 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GP1048-GP1063

m SDFM_PIN_MUX_OPTION3 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPI0122-GPI0137

Watch Variables

m filter1Result - Output of filter 1
m filter2Result - Output of filter 2
m filter3Result - Output of filter 3
m filter4Result - Output of filter 4

SDFM Type 1 Filter FIFO

This example configures SDFM1 filter in type 1 to demonstrate data read through CPU in FIFO & non-FIFO
mode. Data filter is configured in mode 0 to select SINCS3 filter with OSR of 256. Filter output is configured for
16-bit format and data shift of 10 is used.

This example demonstrates the FIFO usage if enabled. FIFO length is set at 16 and data ready interrupt is

configured to be triggered when FIFO is full. In this example, SDFM filter data is read by CPU in SDFM Data
Ready ISR routine.

External Connections
m SDFM_PIN_MUX_OPTION1 Connect Sigma-Delta streams(SD1-D1, SD1-C1) to (GPIO16,
GPIO17)

m SDFM_PIN_MUX_OPTION2 Connect Sigma-Delta streams(SD1-D1, SD1-C1) to (GPIO48,
GP1049)

m SDFM_PIN_MUX_OPTION3 Connect Sigma-Delta streams(SD1-D1, SD1-C1) to (GPIO122,
GP10123)
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Watch Variables

m filter1Result - Output of filter 1

SDFM Filter Sync CLA

In this example, SDFM FIFO will not be filled until a SDSYNC event. On a SDSYNC event, SDFM data filter
output will start filling FIFO and stop filling after programmable number ‘N’ of FIFO is filled.

SDy-C1 (Filter1 channel clock) is internally configured to connected SDy-C2 / SDy-C3 / SDy-C4 SDFM config-
uration is shown below:

m SDFM1 used in this example.For using SDFM2, few modifications would be needed in the
example.

m MODEQO Input control mode selected
m Comparator settings
« Sinc3 filter selected
+ OSR =32
* hit = Ox7FFF (Higher threshold setting)
* lIt = 0x0000(Lower threshold setting)
m Data filter settings
« All the 4 filter modules enabled
» Sincg3 filter selected
OSR = 256
All the 4 filters are synchronized by using MFE (Master Filter enable bit)
Filter output represented in 16 bit format
* In order to convert 25 bit Data filter into 16 bit format user needs to right shift by 10 bits
for Sinc3 filter with OSR = 256
m Interrupt module settings for SDFM filter
« All the 4 higher threshold comparator interrupts disabled
« All the 4 lower threshold comparator interrupts disabled
« All the 4 modulator failure interrupts disabled
« All the 4 filter will generate interrupt when a new filter data is available

External Connections

m SDFM_PIN_MUX_OPTION1 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPIO16-GPIO31

m SDFM_PIN_MUX_OPTION2 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPI048-GPI063

m SDFM_PIN_MUX_OPTION3 Connect Sigma-Delta streams to (SDx-D1, SDx-C1 to SDx-
D4,SDx-C4) on GPI0122-GPI10137

Watch Variables

m filter1Result - Output of filter 1
m filter2Result - Output of filter 2
m filter3Result - Output of filter 3
m filter4Result - Output of filter 4
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SD FATFS Library Example

This example demonstrates how to use the FATFS library.

External Connections
m Connect the SPI signals identifed in the SysConfig to an SD CARD.
Watch Variables

= None.

SD FATFS Library Example with exFAT Support

This example demonstrates how to use the FATFS library with exFAT support.

External Connections
m Connect the SPI signals identifed in the SysConfig to an SD CARD.
Watch Variables

= None.

SPI Digital Loopback

This program uses the internal loopback test mode of the SPI module. This is a very basic loopback that does
not use the FIFOs or interrupts. A stream of data is sent and then compared to the received stream. The pinmux
and SPI modules are configure through the sysconfig file.

The sent data looks like this:
0000 0001 0002 0003 0004 0005 0006 0007 .... FFFE FFFF 0000

This pattern is repeated forever.
Note:
This example project has support for migration across our C2000 device families. If you are

wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you'’re using. At any time you can select another device to migrate this example.

External Connections
m None
Watch Variables

m sData - Data to send
m rData - Received data
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SPI Digital Loopback with FIFO Interrupts

This program uses the internal loopback test mode of the SPI module. Both the SPI FIFOs and their interrupts
are used.

A stream of data is sent and then compared to the received stream. The sent data looks like this:
0000 0001
0001 0002
0002 0003

FFFE FFFF
FFFF 0000
etc..

This pattern is repeated forever.
Note:
This example project has support for migration across our C2000 device families. If you are

wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you'’re using. At any time you can select another device to migrate this example.

External Connections
= None
Watch Variables

m sData - Data to send
m rData - Received data
m rDataPoint - Used to keep track of the last position in the receive stream for error checking

SPI Digital External Loopback without FIFO Interrupts

This program uses the external loopback between two SPI modules. Both the SPI FIFOs and interrupts are
not used in this example. SPIA is configured as a peripheral and SPI B is configured as controller. This
example demonstrates full duplex communication where both controller and peripheral transmits and receives
data simultaneously.

Note:
This example project has support for migration across our C2000 device families. If you are
wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you'’re using. At any time you can select another device to migrate this example.
External Connections
Refer to SysConfig for external connections (GPIO pin numbers) specific to each device

Watch Variables
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m TxData_SPIA - Data send from SPIA (peripheral)
m TxData_SPIB - Data send from SPIB (controller)
m RxData_SPIA - Data received by SPIA (peripheral)
m RxData_SPIB - Data received by SPIB (controller)

6.218 SPI Digital External Loopback with FIFO Interrupts

6.219

This program uses the external loopback between two SPI modules. Both the SPI FIFOs and their interrupts
are used. SPIA is configured as a peripheral and receives data from SPI B which is configured as a controller.

A stream of data is sent and then compared to the received stream. The sent data looks like this:
0000 0001
0001 0002
0002 0003

FFFE FFFF
FFFF 0000
etc..

This pattern is repeated forever.

Note:
This example project has support for migration across our C2000 device families. If you are
wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you're using. At any time you can select another device to migrate this example.

External Connections

Refer to SysConfig for external connections (GPIO pin numbers) specific to each device
Watch Variables

m sData - Data to send
m rData - Received data
m rDataPoint - Used to keep track of the last position in the receive stream for error checking

SPI Digital Loopback with DMA

This program uses the internal loopback test mode of the SPI module. Both DMA interrupts and the SPI FIFOs
are used. When the SPI transmit FIFO has enough space (as indicated by its FIFO level interrupt signal), the
DMA will transfer data from global variable sData into the FIFO. This will be transmitted to the receive FIFO via
the internal loopback.

When enough data has been placed in the receive FIFO (as indicated by its FIFO level interrupt signal), the
DMA will transfer the data from the FIFO into global variable rData.
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When all data has been placed into rData, a check of the validity of the data will be performed in one of the
DMA channels’ ISRs.

Note:
This example project has support for migration across our C2000 device families. If you are
wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you'’re using. At any time you can select another device to migrate this example.

External Connections
m None
Watch Variables

m sData - Data to send
m rData - Received data

SPI EEPROM

This program will write 8 bytes to EEPROM and read them back. The device communicates with the EEPROM
via SPI and specific opcodes. This example is written to work with the SPI Serial EEPROM AT25128/256.
Note: SPI character length is configured to 8 bits in SysConfig, and not changed throughout the execution of
the program. Runtime updation of character length when CS pin is not controlled by the SPI module can lead
to unpredictable behaviour

External Connections

External Connections

m Connect external SPI EEPROM

m Connect GPIO16 (PICO) to external EEPROM S pin
m Connect GPIO17 (POCI) to external EEPROM SO pin
m Connect GP1O18 (CLK) to external EEPROM SCK pin
m Connect GPIO11 (CS) to external EEPROM CS pin

m Connect the external EEPROM VCC and GND pins

Watch Variables

m writeBuffer - Data that is written to external EEPROM
m readBuffer - Data that is read back from EEPROM
m error - Error count

SPI DMA EEPROM

This program will write 8 bytes to EEPROM and read them back. The device communicates with the EEP-
ROM via SPI using DMA and specific opcodes. This example is written to work with the SPI Serial EEPROM
AT25128/256. Note: SPI character length is configured to 8 bits in SysConfig, and not changed throughout
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the execution of the program. Runtime updation of character length when CS pin is not controlled by the SPI
module can lead to unpredictable behaviour

External Connections

External Connections

m Connect external SPI EEPROM

m Connect GPIO16 (PICO) to external EEPROM Sl pin
m Connect GPIO17 (POCI) to external EEPROM SO pin
m Connect GP1O18 (CLK) to external EEPROM SCK pin
m Connect GPIO11 (CS) to external EEPROM CS pin

m Connect the external EEPROM VCC and GND pins

Watch Variables

m writeBuffer - Data that is written to external EEPROM

m SPI_DMA Handle.RXdata - Data that is read back from EEPROM when number of received
bytes is less than 4

m SPI_DMA_Handle.pSPIRXDMA->pbuffer - Start address of received data from EEPROM
m error - Error count

6.222 Missing clock detection (MCD)

This example demonstrates the missing clock detection functionality and the way to handle it. Once the MCD is
simulated by disconnecting the OSCCLK to the MCD module an NMI would be generated. This NMI determines
that an MCD was generated due to a clock failure which is handled in the ISR.

Before an MCD the clock frequency would be as per device initialization (200Mhz). Post MCD the frequency
would move to 10Mhz or INTOSCH1.

The example also shows how we can lock the PLL after missing clock, detection, by first explicitly switching the
clock source to INTOSC1, resetting the missing clock detect circuit and then re-locking the PLL. Post a re-lock
the clock frequency would be 200Mhz but using the INTOSC1 as clock source.

External Connections
= None.
Watch Variables

m fail - Indicates that a missing clock was either not detected or was not handled correctly.

m mcd_clkfail_isr - Indicates that the missing clock failure caused an NMI to be triggered and
called an the ISR to handle it.

m mcd_detect - Indicates that a missing clock was detected.
m result - Status of a successful handling of missing clock detection
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XCLKOUT (External Clock Output) Configuration

This example demonstrates how to configure the XCLKOUT pin for observing internal clocks through an external
pin, for debugging and testing purposes.

In this example, we are using INTOSC1 as the XCLKOUT clock source and configuring the divider as 8. Ex-
pected frequency of XCLKOUT = (INTOSC1 freq)/8 = 10/8 = 1.25MHz

View the XCLKOUT on GPIO73 using an oscilloscope.

CPU Timers

This example configures CPU Timer0, 1, and 2 and increments a counter each time the timer asserts an
interrupt. In order to migrate the project within syscfg to any device, click the swtich button under the device
view and select your corresponding device to migrate, saving the project will auto-migrate your project settings.

External Connections
m None
Watch Variables

m cpuTimerOIntCount
m cpuTimer1IntCount
m cpuTimer2IntCount

CPU Timers

This example configures CPU Timer0, 1, and 2 and increments a counter each time the timer asserts an
interrupt.

Note:
This example project has support for migration across our C2000 device families. If you are
wanting to build this project from launchpad or controlCARD, please specify in the .syscfg file
the board you'’re using. At any time you can select another device to migrate this example.

External Connections
m None
Watch Variables

m cpuTimerOIntCount
m cpuTimer1intCount
m cpuTimer2intCount
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Solution for data logging to bridge device

This example can be loaded for a bridge device that is taking in FSI and outputting SCI. For this example, you
can use the already built-in XDS UART or SCI to USB on a launchpad or controlCARD to view the output. This
example works in conjunction with the transfer_customlog_export_fsi example. Flash the bridge device with this
application code, and run the transfer_customlog_export_fsi example from another device.

In this example, we are using SCI to export data out of the device while receiving FSI as the input. If you're using
a launchpad, you can enable board components to select the correct SCI base to visualize the data through
the COM port. Open a serial terminal with the correct port selected to view the data coming out of the bridge
device.

Solution for interpreting communication peripheral mes-
sages

This example can be loaded for a bridge device that is taking in FSI and outputting SCI. For this example, you
can use the already built-in XDS UART or SCI to USB on a launchpad or control CARD to view the output. This
example works in conjunction with the transfer_raw_fsi_tx example. Flash the bridge device with this application
code, and run the transfer_raw_fsi_tx example from another device.

If you're using a launchpad, you can enable board components to select the correct FSI header. Please en-
sure the project variable GUI_SUPPORT is set to 1. | View -> GUI Composer -> Applications -> trans-
fer_comslogger_export_sci

GUI based solution for data logging (one direction)

This example demonstrates how to use SysConfig to enable datalogging on our C28x devices.

This example works in conjunction with transfer_rtlog and receives incoming FSI packets. The FSI pack-
ets then go through SCI to the PC. Please make sure to input the correct path in the "Message De-
code realtime_log.json" SysConfig parameter. This file is an output from the transfer_rtlog project under
{path_to_ccsproject}build_configuration}.json This .json file will provide the GUI what variables are coming to
the communcation logger device to then output on the GUI. Please ensure GUI_SUPPORT is setto 1. | View
-> GUI Composer -> Applications -> comslogger_rtlog_export_sci

GUI based solution for data logging (one direction)

This example demonstrates how to use SysConfig to enable datalogging on our C28x devices.

In this example, we are using FSI to export data out of the device in JSON format. If you're using a launchpad,
you can enable board components to select the correct FSI base to visualize the data through the COM port.
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GUI based solution for data logging (one direction)

This example demonstrates how to use SysConfig to enable datalogging on our C28x devices. To enable this
example, make sure to go to Build -> Variables and set GUI_SUPPORT to value of 1. This will create the GUI
in CCS which can be opened under View -> GUI Composer -> Applications -> transfer_customlog_export_sci

In this example, we are using SCI to export data out of the device. If you're using a launchpad, you can enable
board components to select the correct SCI base to visualize the data through the COM port.

GUI based solution for data logging (one direction)

This example demonstrates how to use SysConfig to enable datalogging on our C28x devices. To en-
able this example, make sure to go to Build -> Variables and set GUI_SUPPORT to value of 1. This
will create the GUI in CCS which can be opened under View -> GUI Composer -> Applications -> trans-
fer_customlog_export_sci_buffer In this example, we are using SCI to export data out of the device. Before
exporting, we write to an internal buffer before exporting out of device. If you're using a launchpad, you can
enable board components to select the correct SCI base to visualize the data through the COM port.

GUI based solution for data logging (one direction)

This example demonstrates how to use SysConfig to enable datalogging on our C28x devices. To en-
able this example, make sure to go to Build -> Variables and set GUI_SUPPORT to value of 1. This
will create the GUI in CCS which can be opened under View -> GUI Composer -> Applications -> trans-
fer_customlog_export_sci_logArrays

In this example, we are using SCI to export data out of the device. We export a few arrays to show case this
example. If you're using a launchpad, you can enable board components to select the correct SCI base to
visualize the data through the COM port.

GUI based solution for data logging (one direction)

This example demonstrates how to use SysConfig to enable datalogging on our C28x devices. To enable this
example, make sure to go to Build -> Variables and set GUI_SUPPORT to value of 1. This will create the GUI
in CCS which can be opened under View -> GUI Composer -> Applications -> transfer_customlog_export_usb
This example will work on the controlCARD and requires the application to be ran first, then you can open the
correct COM port for the USB to view the logs.

In this example, we are using USB to export data out of the device. Before exporting. If you're using a launchpad,
you can enable board components to select the correct USB base to visualize the data through the COM port.

GUI based solution for data logging (one direction)

This example demonstrates how to use SysConfig to enable datalogging on our C28x devices.
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In this example, we are using FSI to export data out of the device. This will export raw FSI frames in no
packaged format. This example can be used with transfer_comslogger_rtlog_export_sci example to view the
FSI frames via SCI. If you're using a launchpad, you can enable board components to select the correct FSI
base to visualize the data through the COM port.

GUI based solution for data logging (one direction)

This example demonstrates how to use SysConfig to enable datalogging on our C28x devices.

In this example, we are using FSI to export data out of the device. If youre using a launch-
pad, you can enable board components to select the correct FSI base then refer to trans-
fer_comslogger_rtlog_export_sci to visualize the data through a COM port. This project works in conjunction
with transfer_comslogger_rtlog_export_sci. This project generates a file named loggger/realtime_log.json that
is used for the transfer_comslogger_rtlog_export_sci project. This file provides the metadata to know how to
display the incoming data coming from the FSI frame to the GUI. The GUI tab named RT Logger will show the
data in a table format.

UART Echoback

This test receives and echo-backs data through the UARTA port.

A terminal such as ’'putty’ can be used to view the data from the UART and to send information to the UART.
Characters received by the UART port are sent back to the host.

Running the Application Open a COM port with the following settings using a terminal:

m Find correct COM port

m Bits per second = 115200
m Data Bits = 8

m Parity = None

m Stop Bits = 1

m Hardware Control = None

The program will print out a greeting and then ask you to enter a character which it will echo back to the terminal.
Watch Variables

® None

External Connections

Connect the UARTA port to a PC via a transceiver and cable.

m GPIO85 is UARTARX (Connect to Pin3, PC-TX, of serial DB9 cable)
m GPIO84 is UARTATX (Connect to Pin2, PC-RX, of serial DB9 cable)

Note:
The pin muxing for the UARTA port needs to be done by the master CPU1. The common
configuration example provided in the C28x folder can be used for making GPIO85 as the
UART Rx pin and GPIO84 as the UART Tx pin.
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UART Loopback with interrupt

This test receives and loop-backs data through the UARTA port.
Watch Variables

m loopCount - Number of characters sent
m errorCount - Number of errors detected
m sendChar - Character sent

m receivedChar - Character received

Note: Avoid keeping the memory browser open while the execution is in progress.
External Connections

Connect the UARTA Rx port to Tx port for external loopback.
m GPIO2 is UARTARX to be connected to GPIO3 is UARTATX

UART Loopback with interrupt

This test uses the internal loop back test mode of the peripheral. Receive interrupt with FIFO is used in the
example.

A stream of data is sent and then compared to the received stream. The UART-A sent data looks like this:
00 01
01 02
0203

FE FF

FF 00

etc..

The pattern is repeated forever.
Watch Variables

m sData - Data being sent

m rData - Data received

m loopCount - Number of times ISR is executed
m errorCount - Number of errors detected

Note: Avoid keeping the memory browser open while the execution is in progress.
External Connections

Connect the UARTA Rx port to Tx port for external loopback.
m GPIO2 is UARTARX to be connected to GPIO3 is UARTATX
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UART Digital Loopback with DMA

This program uses the internal loopback test mode of the UART module. Two DMA interrupts and both of the
UART FIFOs are used. Both DMA channels are configured to transfer BUFFER_SIZE words with each burst
being UART_BUFFER_SIZE words. The configurations for the UART module and both DMA modules are done
in the Sysconfig file.

Note: Only the lower 8 bits of each word will be transmitted and received by the UART since the UART data
register only has an 8 bit data field.

When the UART transmit FIFO has enough space (UART_BUFFER_SIZE bytes empty), the TX DMA will trans-
fer data from the txData buffer in GSRAM memory into the transmit FIFO by writing to the UART data register.
The data in the transmit FIFO will then be transmitted to the receive FIFO via the internal loopback.

When enough data has been placed in the receive FIFO (UART_BUFFER_SIZE data bytes full), the RX DMA
will transfer the data from the receive FIFO into the rxData buffer in GSRAM memory by reading the UART data
register.

When BUFFER_SIZE words have been placed into rxData, a check of the validity of the data will be performed
and the errCount variable will indicate the amount of data mismatches between txData and rxData.

Running the Application

Set BUFFER_SIZE to desired words of data to transfer. This value must be even numbered. Set
UART_BUFFER_SIZE to 2, 4, 8, 12 or 14. This value must divide evenly into the chosen BUFFER_SIZE.
Change "Burst Size" and "Transfer Size" settings in Sysconfig (for both myDMAO and myDMA1) to reflect these
values. Burst Size = UART_BUFFER_SIZE Transfer Size = BUFFER_SIZE / UART_BUFFER_SIZE

To use 32-bit words instead of 16-bit words, change:

m txData and rxData data types to uint32_t.

m "Databus Width" setting in Sysconfig (for both myDMAO and myDMA1) to "DMA transfers 32
bits at a time."

m DMAO "Source Address Burst Step" and "Source Address Transfer Step" in Sysconfig to 2.

m DMAT1 "Destination Address Burst Step" and "Destination Address Transfer Step" in Sysconfig
to 2.

External Connections (Optional)

m Connect UARTA_TX and UARTA_RX for external loopback. Uncheck "Enable Loopback
Mode" in Sysconfig myUARTO instance

m UARTA_TX is on GPIO84
m UARTA_RX is on GPIO85

Watch Variables

m txData - Data transmitted
m rxData - Data received
m errCount - Error count
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USB HUB Host example

This example application demonstrates how to support a USB keyboard and USB Mouse with a USB Hub. The
display will show the connected devices on the USB hub.

To run the example you should connect a USB Hub to the microUSB port on the top of the control CARD and
open up a serial terminal with the above settings to view the characters typed on the keyboard. Allow the
example to run with the hub connected and then connect the USB Host Mouse or Keyboard.

When a USB Mouse is connected on the Hub the position of the mouse pointer and the state of the mouse
buttons are output to the display. Similarly when a USB Keyboard is connected, any key press on the keyboard
will cause them to be sent out the SCI at 115200 baud with no parity, 8 bits and 1 stop bit.

This example is for depicting the usage of Hub.

There are some limitations in this example : 1. The Example fails to recognize the USB Hub and the device if
the Mouse/Keyboard is already connected to the USB Hub and the Hub is connected to the Micro USB of the
Control Card. 2. The same port should not be used to connect a Keyboard and mouse.

USB CDC serial example

This example application turns the evaluation kit into a virtual serial port when connected to the USB host
system. The application supports the USB Communication Device Class, Abstract Control Model to redirect
SCIA traffic to and from the USB host system.

Connect USB cables from your PC to both the mini and microUSB connectors on the control CARD.Figure out
what COM ports your controlCARD is enumerating (typically done using Device Manager in Windows) and open
a serial terminal to each of with the settings 115200 Baud 8-N-1. Characters typed in one terminal should be
echoed in the other and vice versa.

A driver information (INF) file for use with Windows XP, Windows 7 and Windows 10 can be found in the
windows_drivers directory.

USB HID Mouse Device

This example application turns the evaluation board into a USB mouse supporting the Human Interface Device
class. After loading and running the example simply connect the PC to the control CARDs microUSB port using
a USB cable, and the mouse pointer will move in a square pattern for the duration of the time it is plugged in.

SCIA, connected to the FTDI virtual COM port and running at 115200, 8-N-1, is used to display messages from
this application.

USB Device Keyboard

This example application turns the evaluation board into a USB keyboard supporting the Human Interface
Device class. The global variable ui32Button should be modified to wake up the USB. Care should be taken to
ensure that the active window can safely receive the text; enter is not pressed at any point so no actions are
attempted by the host if a terminal window is used.

Tue Oct 29 00:46:52 IST 2024 167



6.244

6.245

6.246

C28x Driver Library Example Applications

The device implemented by this application also supports USB remote wake up allowing it to request the host
to reactivate a suspended bus. If the bus is suspended (as indicated on the application display), updating
ui32Button will request a remote wakeup assuming the host has not specifically disabled such requests.

To run the example compile the project, load to the target, and run the example. After the example is run-
ning, connect a USB cable from the PC to the microUSB port on the control CARD.Modify ui32Button value in
the expressions window and then focus should be on the window so that we can receive keyboard input (i.e.
NotePad).

USB Generic Bulk Device

This example provides a generic USB device offering simple bulk data transfer to and from the host. The
device uses a vendor-specific class ID and supports a single bulk IN endpoint and a single bulk OUT endpoint.
Data received from the host is assumed to be ASCII text and it is echoed back with the case of all alphabetic
characters swapped.

SCIA, connected to the FTDI virtual COM port and running at 115200, 8-N-1, is used to display messages from
this application.

A Windows INF file for the device is provided under the windows drivers directory. This INF contains information
required to install the WinUSB subsystem on WindowsXP, Windows 7 and Windows 10. WinUSB is a Windows
subsystem allowing user mode applications to access the USB device without the need for a vendor-specific
kernel mode driver.

A sample Windows command-line application, usb_bulk_example, illustrating how to connect to and com-
municate with the bulk device is also provided. Project files are included to allow the examples
to be built using Microsoft VisualStudio. Source code for this application can be found in directory
~/C2000Ware/utilities/tools/{Device}/usb_bulk_example/Release

USB HID Mouse Host

This application demonstrates the handling of a USB mouse attached to the evaluation kit. Once attached, the
position of the mouse pointer and the state of the mouse buttons are output to the display.

SCIA, which is connected to the FTDI virtual serial port on the controlCARD board, is configured for 115200
bits per second, and 8-N-1 mode. When a HID compliant mouse is connected to the microUSB port on the top
of the controlCARD, position and button information will be displayed to the console.

USB HID Keyboard Host

This example application demonstrates how to support a USB keyboard attached to the evaluation kit board.
The display will show if a keyboard is currently connected and the current state of the Caps Lock key on the
keyboard that is connected on the bottom status area of the screen. Pressing any keys on the keyboard will
cause them to be sent out the SCI at 115200 baud with no parity, 8 bits and 1 stop bit. Any keyboard that
supports the USB HID BIOS protocol should work with this demo application.

To run the example you should connect a HID compliant keyboard to the microUSB port on the top of the
controlCARD and open up a serial terminal with the above settings to view the characters typed on the keyboard.
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USB Mass Storage Class Host

This example application demonstrates reading a file system from a USB mass storage class device. It makes
use of FatFs, a FAT file system driver. It provides a simple command console via the SCI for issuing commands
to view and navigate the file system on the mass storage device.

The first SCI, which is connected to the FTDI virtual serial port on the controlCARD board, is configured for
115200 bits per second, and 8-N-1 mode. When the program is started a message will be printed to the
terminal. Type “help” for command help.

After loading and running the example, open a serial terminal with the above settings to open the command
prompt. Then connect a USB MSC device to the microUSB port on the top of the control CARD.

For additional details about FatFs, see the following site: [FatFs - Generic FAT Filesystem Module](http://elm-
chan.org/fsw/ff/00index_e.html)

USB Dual Detect

This program uses a GPIO to do ID detection. If a host is connected to the device’s USB port, the stack will
switch to device mode and enumerate as mouse. If a mouse device is connected to the device’'s USB port,
the stack will switch to host mode and display the mouses movement and button press information in a serial
terminal.

USB Throughput Bulk Device Example
(usb_ex9_throughput_dev_bulk)

This example provides a throughput numbers of bulk data transfer to and from the host. The device uses a
vendor-specific class ID and supports a single bulk IN Endpoint and a single bulk OUT Endpoint.

SCIA, connected to the FTDI virtual COM port and running at 115200, 8-N-1, is used to display messages from
this application.

A Windows INF file for the device is provided under the windows drivers directory. This INF contains information
required to install the WinUSB subsystem on WindowsXP, Windows 7 and Windows 10. This is present in
utilities/windows_ drivers.

A sample Windows command-line application, usb_throughput_bulk_example, illustrating how to connect to
and communicate with the bulk device is also provided. Project files are included to allow the exam-
ples to be built using Microsoft VisualStudio. Source code for this application can be found in directory
~/utilities/tools/usb_throughput_bulk_example/Release.

After running the example in CCS Connect the USB Micro to the PC. Then the example will wait to receive data
from the application. Run the usb_throughput_bulk example, the throughput and Data Packets Transferred.
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Watchdog

This example shows how to service the watchdog or generate a wakeup interrupt using the watchdog. By
default the example will generate a Wake interrupt. To service the watchdog and not generate the interrupt,
uncomment the SysCitl_serviceWatchdog() line in the main for loop.

External Connections
= None.
Watch Variables

m wakeCount - The number of times entered into the watchdog ISR
m loopCount - The number of loops performed while not in ISR

CAN External Loopback

This example sets up the CAN controller in External Loopback test mode using CPU2. The CAN peripheral is
configured to transmit messages with a specific CAN ID. A message is then transmitted once per second, using
a simple delay loop for timing. The message that is sent is a 4 byte message that contains an incrementing
pattern. A CAN interrupt handler is used to confirm message transmission and count the number of messages
that have been sent.

This example sets up the CAN controller in External Loopback test mode. Data transmitted is visible on the
CANTXA pin and is received internally back to the CAN Core. Please refer to details of the External Loopback
Test Mode in the CAN Chapter in the Technical Reference Manual. Refer to [Programming Examples and Debug
Strategies for the DCAN Module](www.ti.com/lit/'SPRACEDS) for useful information about this example

External Connections
= None.
Watch Variables

m msgCount - A counter for the number of messages received
m txMsgData - An array with the data being sent
m rxMsgData - An array with the data that was received

CAN External Loopback with Interrupts

This example sets up the CAN controller in External Loopback test mode using CPU2. The CAN peripheral is
configured to transmit messages with a specific CAN ID. A message is then transmitted once per second, using
a simple delay loop for timing. The message that is sent is a 4 byte message that contains an incrementing
pattern. A CAN interrupt handler is used to confirm message transmission and count the number of messages
that have been sent.

This example sets up the CAN controller in External Loopback test mode. Data transmitted is visible on the
CANTXA pin and is received internally back to the CAN Core. Please refer to details of the External Loopback
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Test Mode in the CAN Chapter in the Technical Reference Manual. Refer to [Programming Examples and Debug
Strategies for the DCAN Module](www.ti.com/lit/'SPRACEDS) for useful information about this example

External Connections
= None.
Watch Variables

m txMsgCount - A counter for the number of messages sent

m rxMsgCount - A counter for the number of messages received
m txMsgData - An array with the data being sent

m rxMsgData - An array with the data that was received

m errorFlag - A flag that indicates an error has occurred

Flash Programming with AutoECC, DataAndECC, DataOnly
and EccOnly

This example demonstrates how to program Flash using API’s following options 1. AutoEcc generation 2.
DataOnly and EccOnly 3. DataAndECC

Note:
CPU1 example must be loaded and executed before CPU2 example. Only CPU1 is able to set
the BankMuxSel and GSxMSel registers for CPU2. For both CPU1 and CPU2 load, make sure
to set the correct Erase settings for bank selection.
External Connections
m None.

Watch Variables

= None.

Flash Programming with AutoECC, DataAndECC, DataOnly
and EccOnly

This example demonstrates how to program Flash using API’s following options 1. AutoEcc generation 2.
DataOnly and EccOnly 3. DataAndECC

Note:
CPU1 example must be loaded and executed before CPU2 example. Only CPU1 is able to set
the BankMuxSel and GSxMSel registers for CPU2. For both CPU1 and CPU2 load, make sure
to set the correct Erase settings for bank selection.

External Connections
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= None.
Watch Variables

= None.

Flash Programming with 512-bit AutoECC, DataAndECC,
DataOnly and EccOnly

This example demonstrates how to program Flash banks using API’s following options 1. AutoEcc generation
2. DataOnly and EccOnly 3. DataAndECC

Note:
CPU1 example must be loaded and executed before CPU2 example. Only CPU1 is able to set
the BankMuxSel and GSxMSel registers for CPU2. For both CPU1 and CPU2 load, make sure
to set the correct Erase settings for bank selection.
External Connections
= None.

Watch Variables

= None.

Flash Programming with 512-bit AutoECC, DataAndECC,
DataOnly and EccOnly

This example demonstrates how to program Flash banks using API’s following options 1. AutoEcc generation
2. DataOnly and EccOnly 3. DataAndECC

Note:
CPU1 example must be loaded and executed before CPU2 example. Only CPU1 is able to set
the BankMuxSel and GSxMSel registers for CPU2. For both CPU1 and CPU2 load, make sure
to set the correct Erase settings for bank selection.
External Connections
= None.

Watch Variables

= None.
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6.257 Flash Programming Solution using SCI

In this example, we set up a UART connection with a host using SCI, receive commands for CPU1 to perform
which then sends ACK, NAK, and status packets back to the host after receiving and completing the tasks. This
kernel has the ability to program, verify, unlock, reset, and run an application. Each command either expects no
data from the command packet or specific data relative to the command.

In this example, we set up a UART connection with a host using SCI, receive an application for CPUO1 in -sci8
ascii format to run on the device and program it into Flash.
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These example applications show how to make use of F28P65x device functions which span both the CPU 1
and CPU 2. All of these examples contain two example projects: one for CPU 1 and one for CPU 2.

Like the CPU1 only projects, these projects also contain different build configurations for RAM and Flash builds.
All of the CPU1 projects contain RAM and Flash build configurations with debugger support, as well as a
standalone flash build configuration which sends an IPC command to boot the second core and begin executing
the application in its flash. The CPU2 projects all only contain a flash and RAM build configuration as there are
no dependencies in the code regarding whether the application is running with or without a debugger.

All these examples are setup using the Code Composer Studio (CCS) "projectspec” format. For these dual core
example applications, the "projectspec” allows for two projects to be defined in one file. Upon importing the
"projectspec”, the two example projects will be generated in the CCS workspace with copies of the source and
header files included for each project. All these examples contain two build configurations which allow you to
build each project to run from either RAM or Flash. To change how the project is built simply right click on the
project and select "Build Configurations". Then, move over to set the active build configuration, either RAM or
Flash.

The examples provided are built for controlCARD compatibility.

To run one of these examples after compiling it, load the appropriate programs on each of the two cores. Then,
for more example specific instructions please refer to the documentation regarding the example you wish to run
on the following pages or in the comments of the example sources.

All of these examples can be found in the

driverlib/f28p65x/examples/c28x_dual subdirectory of the C2000Ware package.

CAN Dual Core Example

This example demonstrates how to allocate DCAN peripheral using CPU1 so that it can be operated using
CPU2.

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANKS3 and FLASH_BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2. Please note that CPU2 .out file can be loaded only after CPU1 completes
this configuration

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks

only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.0out file (This is applicable only for FLASH configuration)

External Connections
= None.
Watch Variables

= None.
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DMA Transfer Shared Peripheral

This example shows how to initiate a DMA transfer on CPU1 from a shared peripheral which is owned by CPU2.
In this specific example, a timer ISR is used on CPU2 to initiate a SPI transfer which will trigger the CPU1 DMA.
CPU1’s DMA will then in turn update the ePWM1 CMPA value for the PWM which it owns. The PWM output
can be observed on the GPIO pins. It is recommended to run the c28x1 core first, followed by the C28x2 core.

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANKS3 and FLASH_BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2. Please note that CPU2 .out file can be loaded only after CPU1 completes
this configuration

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks
only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.out file (This is applicable only for FLASH configuration)

Watch Pins

m GPIO0 and GPIO1 - ePWM output can be viewed with oscilloscope

IPC basic message passing example with interrupt

This example demonstrates how to configure IPC and pass information from C28x1 to C28x2 core without
message queues. It is recommended to run the C28x1 core first, followed by the C28x2 core.

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANKS3 and FLASH_BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2. Please note that CPU2 .out file can be loaded only after CPU1 completes
this configuration

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks

only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.out file (This is applicable only for FLASH configuration)

External Connections
= None.
Watch Variables

® pass

IPC basic message passing example with interrupt

This example demonstrates how to configure IPC and pass information from C28x1 to C28x2 core without
message queues It is recommended to run the C28x1 core first, followed by the C28x2 core.

External Connections

176 Tue Oct 29 00:46:52 IST 2024



7.5

7.6

Dual Core Driver Library Example Applications

= None.
Watch Variables

= None.

IPC message passing example with interrupt and message
queue

This example demonstrates how to configure IPC and pass information from C28x1 to C28x2 core with message
queues. It is recommended to run the C28x1 core first, followed by the C28x2 core.

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANKS3 and FLASH_BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2. Please note that CPU2 .out file can be loaded only after CPU1 completes
this configuration

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks

only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.out file (This is applicable only for FLASH configuration)

External Connections
= None.
Watch Variables

m pass

IPC message passing example with interrupt and message
queue

This example demonstrates how to configure IPC and pass information from C28x1 to C28x2 core with message
queues. It is recommended to run the C28x1 core first, followed by the C28x2 core.

External Connections
= None.
Watch Variables

= None.
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IPC basic message passing example with interrupt

This example demonstrates how to configure IPC and pass information from C28x1 to C28x2 core without
message queues. It is recommended to run the C28x1 core first, followed by the C28x2 core.

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANK3 and FLASH_BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2 by using SysConfig. Please note that CPU2 .out file can be loaded only
after CPU1 completes this configuration.

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks
only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.out file (This is applicable only for FLASH configuration)

External Connections
= None.
Watch Variables

® pass

IPC basic message passing example with interrupt

This example demonstrates how to configure IPC and pass information from C28x1 to C28x2 core without
message queues. It is recommended to run the C28x1 core first, followed by the C28x2 core.

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANK3 and FLASH_BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2 by using SysConfig. Please note that CPU2 .out file can be loaded only
after CPU1 completes this configuration.

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks

only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.out file (This is applicable only for FLASH configuration)

External Connections
= None.
Watch Variables

= None.
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IPC message passing example with interrupt and message
queue

This example demonstrates how to configure IPC and pass information from C28x1 to C28x2 core with message
queues. It is recommended to run the C28x1 core first, followed by the C28x2 core.

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANKS3 and FLASH _BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2 by using SysConfig. Please note that CPU2 .out file can be loaded only
after CPU1 completes this configuration.

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks
only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.out file (This is applicable only for FLASH configuration)

External Connections
= None.
Watch Variables

m pass

IPC message passing example with interrupt and message
queue

This example demonstrates how to configure IPC and pass information from C28x1 to C28x2 core with message
queues. It is recommended to run the C28x1 core first, followed by the C28x2 core.

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANK3 and FLASH_BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2 by using SysConfig. Please note that CPU2 .out file can be loaded only
after CPU1 completes this configuration.

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks

only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.out file (This is applicable only for FLASH configuration)

External Connections
= None.
Watch Variables

= None.
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LED Blinky Example

This example demonstrates how to blink a LED using CPU1 and blink another LED using CPU2
(led_ex1_blinky_cpu2.c).

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANKS3 and FLASH_BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2. Please note that CPUZ2 .out file can be loaded only after CPU1 completes
this configuration

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks
only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.0out file (This is applicable only for FLASH configuration)

External Connections
= None.
Watch Variables

= None.

LED Blinky Example

This example demonstrates how to blink a LED using CPU1 and blink another LED using CPU2
(led_ex1_blinky_cpu2.c).

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANK3 and FLASH_BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2 by using SysConfig. Please note that CPU2 .out file can be loaded only
after CPU1 completes this configuration.

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks

only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.out file (This is applicable only for FLASH configuration)

Please switch to LAUNCHPAD build configurations if using launchpad.

External Connections
= None.
Watch Variables

= None.
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MCAN Dual Core Example

This example demonstrates how to allocate MCAN peripheral using CPU1 so that it can be operated using
CPU2.

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANK3 and FLASH_BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2. Please note that CPU2 .out file can be loaded only after CPU1 completes
this configuration

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks
only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.out file (This is applicable only for FLASH configuration)

External Connections
= None.
Watch Variables

= None.

MCAN Internal Loopback with Interrupt for CPU2

This example shows the MCAN Loopback functionality. The internal loopback mode is entered. The sent
message should be received by the node.

External Connections
= None.
Watch Variables

m error - Checks if there is an error that occurred when the data was sent using internal loopback.

Shared RAM Management (CPU1)

This example shows how to assign shared RAM for use by both the CPU2 and CPU1 core. Shared RAM regions
are defined in both the CPU2 and CPU1 linker files. In this example GS0 and GS4 are assigned to/owned by
CPU2. The remaining shared RAM regions are owned by CPU1.

In this example, a pattern is written to cpu1RWArray and then an IPC flag is sent to notify CPU2 that data is
ready to be read. CPU2 then reads the data from cpu2RArray and writes a modified pattern to cpu2RWArray.
Once CPU2 acknowledges the IPC flag, CPU1 reads the data from cpu1RArray and compares with expected
result.

A timer ISR is also serviced in both CPUs. The ISRs are copied into the shared RAM region owned by the
respective CPUs. Each ISR toggles a GPIO. Watch the GPIOs on an oscilloscope, or if using the control CARD,
watch LED1 and LED2 blink at different rates.
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Following are the memory allocation details of CPU Timer interrupt ISRs & read(R)/read write(RW) arrays in
CPU1 & CPU2 as configured in the example.

m cpu1RWArray[] is mapped to shared RAM GS1

cpu1RArray[] is mapped to shared RAM GSO0

cpu2RArray[] is mapped to shared RAM GS1

cpu2RWArray[] is mapped to shared RAM GS0

cpuTimerOISR in CPU2 is copied to shared RAM GS4, toggles LED1
cpuTimerOISR in CPU1 is copied to shared RAM GS83, toggles LED2

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANK3 and FLASH_BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2. Please note that CPU2 .out file can be loaded only after CPU1 completes
this configuration

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks
only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.out file (This is applicable only for FLASH configuration)

Watch Variables

m error Indicates that the data written is not correctly received by the other CPU.

Shared RAM Management (CPU2)

This example shows how to assign shared RAM for use by both the CPU2 and CPU1 core. Shared RAM regions
are defined in both the CPU2 and CPU1 linker files. In this example GS0 and GS4 are assigned to/owned by
CPU2. The remaining shared RAM regions are owned by CPU1.

In this example, a pattern is written to cpu1RWArray and then an IPC flag is sent to notify CPU2 that data is
ready to be read. CPU2 then reads the data from cpu2RArray and writes a modified pattern to cpu2RWArray.
Once CPU2 acknowledges the IPC flag, CPU1 reads the data from cpu1RArray and compares with expected
result.

A timer ISR is also serviced in both CPUs. The ISRs are copied into the shared RAM region owned by the
respective CPUs. Each ISR toggles a GPIO. Watch the GPIOs on an oscilloscope, or if using the controlCARD,
watch LED1 and LED2 blink at different rates.

Following are the memory allocation details of CPU Timer interrupt ISRs & read(R)/read write(RW) arrays in
CPU1 & CPU2 as configured in the example.

m cpulRWArray[] is mapped to shared RAM GS1

cpu1RArray[] is mapped to shared RAM GS0

cpu2RArray[] is mapped to shared RAM GS1

cpu2RWArray[] is mapped to shared RAM GS0

cpuTimerOISR in CPU2 is copied to shared RAM GS4, toggles LED1
cpuTimerOISR in CPU1 is copied to shared RAM GS83, toggles LED2
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NMI handling

This example demonstrates how to handle an NMI.

The watchdog of CPU2 is configured to reset the core once the watchdog overflows and in the CPU1 the NMI
is triggered. The NMI status is read and is verified to be due to CPU2 Watchdog reset. The NMI ISR reboots
the CPU2 core and the process is repeated.

Note:
In the default CPU2 linker cmd file, GS4, FLASH_BANK3 and FLASH_BANK4 are used for
allocating various CPU2 sections. The CPU1 application assigns the ownership of these mem-
ory regions to CPU2. Please note that CPU2 .out file can be loaded only after CPU1 completes
this configuration

The erase setting (CPU1/CPU2 On-Chip Flash -> erase setting) needs to be configured as selected banks
only (Choose the corresponding BANKS allocated for CPUs) or necessary sectors only before loading
CPU1/CPU2.out file (This is applicable only for FLASH configuration)

Watch Variables

m nmi_isr_count Indicates the number of times the NMI ISR was hit because of CPU2 watchdog
reset.

Watchdog Reset

This example shows how to configure the watchdog to reset CPU2 which will trigger an NMI in CPU1. LED1 is
toggled at the start of main indicating CPU reset.

External Connections
= None.
Watch Variables

m loopCount - The number of loops performed while not in ISR
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8.2.1.1

8.2.1.2

Device APIs for examples

Device APIs for examples

Introduction

This chapter provides information on the APIs included in device.c file

API Functions

Functions

void __error__ (const char «filename, uint32_t line)
void Device_bootCPU2 (uint32_t bootmode)

void Device_enableAllPeripherals (void)

void Device_init (void)

void Device_initGPIO (void)

bool Device_verifyXTAL (float freq)

Function Documentation

__efrror__

Error handling function to be called when an ASSERT is violated.

Prototype:
void
__error__ (const char xfilename,
uint32_t line)
Parameters:

«filename File name in which the error has occurred
line Line number within the file

Returns:
None

void Device_bootCPU2 (uint32_t bootmode)

Function to boot CPU2.

Parameters:
bootmode is the mode in which CPU2 should boot.

Description:
Available bootmodes :
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BOOTMODE_BOOT TO_FLASH_BANKO_SECTORO
BOOTMODE_BOOT TO_FLASH_BANKO_SECTOR127_END
BOOTMODE_BOOT TO_FLASH BANK1_SECTORO
BOOTMODE_BOOT _TO_FLASH_BANK2_SECTORO
BOOTMODE_BOOT TO_FLASH _BANK3_SECTORO
BOOTMODE_BOOT _TO_FLASH_BANK4_SECTORO
BOOTMODE_BOOT TO_FLASH BANK4 SECTOR127_END
BOOTMODE_BOOT _TO_SECURE_FLASH_BANKO_SECTORO
BOOTMODE_BOOT TO_SECURE_FLASH_BANK1_SECTORO
BOOTMODE_BOOT _TO_SECURE_FLASH_BANK2_SECTORO
BOOTMODE_BOOT_TO_SECURE_FLASH_BANK3_SECTORO
BOOTMODE_BOOT _TO_SECURE_FLASH_BANK4_SECTORO
BOOTMODE_IPC_MSGRAM_COPY_BOOT_TO_M1RAM
BOOTMODE_BOOT_TO_MORAM
BOOTMODE_BOOT_TO_FWU_FLASH

BOOTMODE_BOOT _TO_FWU_FLASH_ALT1
BOOTMODE_BOOT_TO_FWU_FLASH_ALT2
BOOTMODE_BOOT_TO_FWU_FLASH_ALT3

Note that while using BOOTMODE_IPC_MSGRAM_COPY_BOOT_TO_M1RAM, BOOT-
MODE_IPC_MSGRAM_COPY_LENGTH_xxxW must be ORed with the bootmode parameter

This function must be called after Device_init function

Returns:
None.

8.2.1.3 void Device_enableAllPeripherals (void)

Function to turn on all peripherals, enabling reads and writes to the peripherals’ registers.

Note that to reduce power, unused peripherals should be disabled.

Parameters:
None

Returns:
None

Device_init

Function to initialize the device. Primarily initializes system control to aknown state by disabling the watchdog,

setting up the SYSCLKOUT frequency, and enabling the clocks to the peripherals.

Prototype:
void
Device_init (void)

Parameters:
None.
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Returns:
None.

8.2.1.5 void Device_initGPIO (void)

Function to disable pin locks on GPIOs.

Parameters:
None

Returns:
None

8.2.1.6  bool Device_verifyXTAL (float freq)

Function to verify the XTAL frequency.

Parameters:
freq is the XTAL frequency in MHz

Returns:
The function return true if the the actual XTAL frequency matches with the input value
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